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1 Ruskin software

Ruskin is the only tool you need to manage all your RBR instruments and measurement data. It is available for Mac and
Windows PC (Ruskin Desktop), as well as for iOS® and Android™ (Ruskin Mobile).

Use the Ruskin software to do the following:

« Configure, schedule, and enable multiple instruments
« Estimate your deployment times

« Download your data after logging

« View your datasets graphically

» Export your data in various formats

« Analyse your data

» Change the calibration coefficients for your instrument
+ Perform user calibration

« Contact RBR

RSK files generated by Ruskin contain contain raw measurement data, firmware and software versions, dates and
times, sampling settings, power settings, measured and derived parameters, errors and events, other diagnostic
information. They can be read directly in Matlab, or exported to Excel, OceanDataView®, or text files.

Find Ruskin software for Mac and PC on the USB stick included with your instrument, or visit the RBR website to
download the latest version.

Go to the Apple App store or Google Play for Quick start - Ruskin Mobile.

The most recent software updates, release notes, Ruskin user guides, instrument guides, and quick start guides are
available from the Help menu in Ruskin.

@ Ruskin File Instruments Factory Developer Diagnostic Help

[ 2N | Ruskin v2.17.2.202203042007
Eo3 Navigata; B =0 ‘ 1 Release notes
@ Instruments I~ Sensors >
1 Compact Instruments >
i MLM Comment on Ruskin... & R X
& Datasets Se >  Quick Start Guide
‘_._‘ Ca.li!aratiun frclity Check for updates.... RBRquartz® b Ruskin User Guide
ég‘:;ow Enter Feature Code... RBRIlegato® glider/AUV CTD > Command reference
RSK processor... Legacy Instruments > RBRconcerto® C.T.Djuv QSG
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2 Ruskin interface

Ruskin software has a user-friendly interface which consists of a Toolbar and three main windows: Navigator,
Properties, and Plot.
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In the Navigator window, you will find the list of instruments connected to Ruskin, as well as MLM (if applicable) and
datasets.

When an instrument on the list is selected, the Properties window displays four tabs with information related to this
instrument: Configuration, Information, Calibration, and Parameters. Use these tabs to configure your deployment,
check the calibration certificates, and verify your parameters.

The data plot will appear in the Plot window below if the realtime option is available and selected for this instrument, or
if you click the Fetch button ¥ on the far right of the toolbar.

Click-and-drag window tabs to rearrange the windows within Ruskin, or move a window outside of Ruskin. Hover over a
side of a window, and when the cursor becomes a two-way arrow , move it to adjust the window size.

RBR#0006105revL 7
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Click the Close button in the top right corner to close a window. For example, you can close the Navigator

window to have a better view of the Properties. The closed window icon will appear on the sidebar (in this case,

&
Navigator ). Click the Multiple windows button above the closed window icon to re-open it.

= |
= I rorconceno? 200881 5
informetion
scheduto samging Opiens
Ststus: Stopped, user requast Mode: Continuous Realime:  Setisl @ Fomat Standard resolution a
Soee 2z (
Clock 2022-07-07 08:51:38-04:00 utc Local i B e e Seid; 115200 @ Made RS2 e
“ee e St 20220617 v FIPM D New Sioape:  Deskop @ wis o

5 row

Battery:  Lithium thionyl chionde Frash
Extemnat  Other [ unknown a
aatng
Extended battery endcap
» Sample cower details Mode:  None (-]
[Memory used: <1% Download...
Enabla Rovert sattings Uss auto-daploy sattings

=
il RBRcOncerts® 209681

== s J G 1 Capturing to sersixhapman/209681_2022070
20
<y sam o Sample®: - (17 captured)
1 Time =
ane

" vake Lest it
1 -5.0004000 mSfem

2 220836000 *C
3 e 10.0B00000 dbar
4 0.2100000 dbar

= LimE

P E i

3

Sea pressure (dbas)

ez Y sai0 [T

Double-click a window tab to maximise that window, and double-click the tab again to return it to the original size.

i &
Alternatively, use the Single window and Multiple windows buttons.
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() When you restart Ruskin, it returns to its original layout.

The Toolbar at the top left above the Navigator window has four dropdown menus. If you are using a Mac computer, it
appears as follows:

@ Ruskin File Instruments Help

On a Windows PC, the Toolbar looks slightly differently:

File Instruments Options Help

The rest of the interface is the same between the two systems.

2.1 Ruskin /Options

On your Mac, go to the Ruskin dropdown menu to access information on current software version, set up your
preferences, or quit Ruskin. Note that the rest of the options on this dropdown menu depend on your operating system
and are external to Ruskin.

@ Ruskin File Instruments Help

° « IS

% Na preferences...

a

Services »

o 1
g Hide Ruskin

Hide Others

Show All

Quit Ruskin

On your Windows PC, use the Options dropdown menu to set up your preferences.

File Instruments Options  Help

-{'g'} Mavigator Preferences... = 7

RBR#0006105revL



2.2 File

Go to the File dropdown menu to open or close a dataset, export your data, and see the list of available datasets. The
Datasets menu in the Navigator windows duplicates some of these options for convenience.

2.3 Instruments

Go to the Instruments dropdown menu to simulate an instrument, update your firmware, set up automatic tasks, or

® Ruskin File Instruments Help

oo

I-ﬁ-Navigatar\w Close dataset = O

bod i Instrumen Export >

CRBRconcel
i MLM 1: 209681_20220414_1600.rsk

3 Datasets

take advantage of the utilities.

& The Utilities option is a support tool. Contact RBR before using it.

The Instruments menu in the Navigator windows duplicates some of these options for convenience.

2.4 Help

@ Ruskin File Instruments Help

°oe

45 Mavigator k. e R
———  Update instrument firmware... =

v i Instruments

CRBRconcerto? Automatic tasks >
g MLM
~ g Datasets Utilities >

s 209681...1600

Go to the Help dropdown menu to access the latest release notes and technical documentation, provide your feedback,
check for updates, or to add a beta feature. On Mac, you can also use the Search option.

RBR#0006105revL

@ Ruskin File Instruments HelF

ece I
Fr—
; Documentation >

> i Instruments

ORBReconcerto? 209681 ;
Comment on Ruskin...

i MLM

£ Datasets Check for updates....

Enter Feature Code...
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3 Installation

Ruskin is the only piece of software you need to operate your RBR instruments. RBR releases Ruskin software versions
compatible with Mac and PC (Ruskin Desktop), as well as with iOS® and Android™ (Ruskin Mobile).

Install the Ruskin Mobile app on your mobile device by going to the Apple App store or Google Play.

Follow the steps below to install Ruskin Desktop on your computer.

3.1 Install Ruskin on a PC

You can install Ruskin on a PC that runs the Windows 7, 8, 8.1, or 10 operating system.

The minimum requirements for Ruskin are:

+ 0S=Windows 7

+ Processor speed = 1.4GHz

+ RAM required = 2GB

« Display resolution = 1024x768 recommended
« HDD space for installation = 500MB

The instruments use a USB interface to communicate with Ruskin.

Steps
1. Connect the USB stick included with your instrument to a port on your computer.
Navigate to the "Ruskin Installation" folder and doubleclick on the file RuskinSetup. exe.
Follow the installation wizard. By default, Ruskin will be installed to C: \RBR.
At the end of the installation, you will see a prompt asking, "Would you like to install the logger driver at this
time?"
5. Click Yes to install the drivers.

s

A You may need to run the setup application as an administrator to install the driver correctly.

A shortcut to Ruskin will appear on the desktop and in a Start menu folder.

() The most recent version of Ruskin software can be found at https://rbr-global.com/products/software.

RBR#0006105revL
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3.2 Install Ruskin on a Mac

You can install Ruskin on a Mac running OS X 10.12 (Sierra) or later.

Steps

1. Connect the USB stick included with your instrument to a port on your adaptor.

2. Navigate to the "OSX" folder and double-click on the file Ruskin.dmg.

3. When the disk image window opens, drag the Ruskin icon into the Applications directory and wait for the copy
to complete. An application named "Ruskin" will appear in the Applications folder.

A Always use the default Applications folder as the working directory.

4. Right-click on the icon, and select Open.
5. The dialogue box shown below will prompt you to authorise the opening of Ruskin.

“Ruskin” is from an unidentified developer.
- p Are you sure you want to open it?

Cpening “Ruskin® will always allow it to run on this
Mac.

b

Goegle Chrome downloaded this file today at 3143 P
from updates.rbr-global.com

& You may need to navigate to System Preferences > Security & privacy to allow the apps downloaded
from “Anywhere” to complete the installation.

6. Dragthe Ruskin.app application to the Dock.

RBR#0006105revL 12



3.3 Update Ruskin

To take advantage of new features and bug fixes, ensure that you are using the most recent version of Ruskin.

« Find the most recent version of Ruskin at https://rbr-global.com/products/software.

+ Receive an automatic notification about a new release when you start the application.

+ Check from within Ruskin by navigating to Help > Check for updates.

+ Send an email to support@rbr-global.com, subject: "Ruskin update request", and ask us to add you to the
mailing list. You will receive an email as soon as the new version is released.

If you have a broadband connection, simply follow the installation instructions on your computer. Otherwise, request a

USB stick from RBR.

& tisnot necessary to uninstall the older version of Ruskin before installing the newer version. The installation
program deletes the older files before installing the newer ones. It does not delete any Ruskin data files or log
files.

3.4 Uninstall Ruskin

Uninstall Ruskin only if you no longer need to manage RBR instruments from your computer.

It is not necessary to uninstall the older version of Ruskin before installing the newer version. The installation program
deletes the older files before installing the newer ones. For more information, see Update Ruskin.

& Removing Ruskin will not delete your data files or your diagnostic logs.

Uninstall Ruskin on a PC, Windows 7, 8, 8.1, or 10

1. Goto Start > Control Panel > Programs.

Under Programs and Features, click Uninstall a program.
Find Ruskin on the list.

Click Ruskin to highlight it.

Click Uninstall.

aprwN

Uninstall Ruskin on a Mac, OS X 10.12 or later

Move the Ruskin application from Applications to the Trash.

RBR#0006105revL
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4 Support

You can get in touch with RBR in several different ways:

« Send us an email. For technical questions, use support@rbr-global.com, and for general inquiries, info@rbr-
global.com.

« Contact us via the website at https://rbr-global.com/about-rbr/contact-rbr.
« Callusat+1(613) 599-8900.

« Send us a bug report from within Ruskin itself.

& When experiencing an issue, look for a solution under the Help menu before contacting RBR.

The Help menu on Ruskin offers access to technical documentation, feedback forms, and software updates. On Mac,
you can also search for Ruskin menu options.

@ Ruskin File Instruments Help

eoe® |
4 Novigstor Coessenoes |
v # fnatrimaats. Documentation > b
OsimRBRsolo® 904963 Comment on Ruskin =
#RBRconcerto® 208681
s MLM Check for updates.... I
5 Datasets

Feature codes...

‘ ‘ wwer  evee-ug-wo |

Start: 2022-05-17 ~

RBR#0006105revL
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4.1 Search on Mac

If using a Mac computer, you can take advantage of the Search option.
In the Search field under Help, type in a word, part of the word, or even a single letter to open a list of matching items.

The top half of the list pertains to Ruskin, while the bottom part comes from the Mac environment.

@ Ruskin File Instruments Help

@0e a (<]
4 Navigator
4 rnstrument:; —  [=] About Ruskin I
s MLM [=l Show All 4
& Datasets [=] Export > Annotations I

[=l 1: AUTO_209681_20220613_1311.rsk
[=| Simulate an instrument...

[=] Automatic tasks

[=| Automatic tasks > Auto-download

[=| Automatic tasks > Auto-stop

[= Automatic tasks > Auto-deploy

[=l Automatic tasks = View auto-deploy settings...

2

Add a network service on Mac

9 ¢

Save a document in PostScript format on Mac

Add a password hint on Mac

O «

_‘
e

Save a document as a PDF on Mac

P
s

)

Share a document as a POF file on Mac

9 ¢

If your Mac restarts and a message appears

g

\
)
!

Use DHCP or a manual IP address on Mac

(&

_‘
e

Use a Bluetooth headset with your Mac

P
s

=)

(2) Leave a Family Sharing group on Mac

(@) Create a burn folder to hold files to burn to a CD...

(@ Show All Help Topics

Scroll down the Ruskin list and select an item to locate. Ruskin will open the toolbar menu and point to the option in
the dropdown menu.

@ Ruskin File Instruments Help

Open dataset ann [ ]

[ 5 = Export > Annotations

Annotations 2
Comment regions
Profiles >

et Ei Full Profiles

.%1 Text Downcasts

e e )
\\—,—--—c your Mac speak announcements

Raw binary (*bin)
. — — | @ Mark up files on Mac

=l Annotations > Comment regions
=l Annotations > Profiles

I=| Profiles = Full Profiles

I= Profiles = Downcasts

= Profiles > Upcasts

You can execute the located option right away.

RBR#0006105revL
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4.2 Release notes

Click on Help > Release notes to open the Welcome window. It will outline new features, improvements, and bug fixes

associated with each release version.

[ Release notes 23

Release Notes
2.19.1

Release date: October 21 2022

Bug fixes

* RSK-9274 - Unable to enable instrument in local time when the clock has a positive UTC ofiset

2.19.0

Release date: October 04 2022

New Features
RBRtridente

RBR's new RBRiridente multi-channel optical sensor is now fully integrated inte Ruskin. Connect your sensor to change its
sampling speed and record data in real-time.

Did you know?

You can simulate a sensor even if you don't yet have one. Ruskin lets you simulate the RBRtridente as a standalone sensor
or as part of a larger integration. We've updated Ruskin's autonomy engine to let you easily plan deployments using this
tool too.

Other notable additions

Added RBR Instrument Guide (RIG) for RBunan‘z" APT and Standard instruments

Added Quick Start Guide (QSG) for RBRquartz® APT

Updated Quick Start Guide (QSG) for RBRfermata

Updated Ruskin User Guide (RUG) for RBRcada®, Compact instruments, and Standard instruments

.
.
.
.

Improvements

RSK-6356 - Added link to release notes to get full history

RSK-7886 - Added copy/paste functionality to RBRquartz® calibration coefficient tables
RSK-8672 - Added channel indices to RSK analysis data table

RSK-8703 - Removed column auto-sizing on Excel exports

RSK-B756 - Release notes window was renamed from 'Welcome' to 'Release notes'
RSK-8762 - Added dialog to view all user activated feature codes

s e e

Click here to see all Release Notes

Did you know...

Ruskin Updates

Ruskin can automatically notify you that a newer version is available.

If you do not have a breadband cennection and/or are unable to install the Ruskin
updates, update notifications are available via email. To receive these notifications,
send an email fo: supporid@rbr-global com subject: "Ruskin update request”.

Let us know!

If you have problems or praise, please let us know. Either use the "Help/Comment
on Ruskin" menu item or write to support@rbr-global.com.

Previous Next

Calibration in three weeks or less.
Guaranteed.

Click the calibration tab and select
“request a calibration quote® to get started.

Click the link at the bottom left to see the full history of the release notes. The link will take you to the RBR support

page.

Alternatively, scroll down to see brief recaps of the release notes from all previous versions.

Click the x to close the Release notes window and return to the Navigator mode.
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4.3 Documentation

Click on Help > Documentation to open the menu tree. Browse through a variety of guides available for instruments
and accessories.

Help

Ruskin v2.18.0.202204261717

Release notes
Sensors
Compact Instruments

Comment on Ruskin...
Standard Instruments

VW W W W v v

Check for updates.... RBRquartz® Q >
Enter Feature Code... RERlegato® glider/AUV CTD > RBRhmun'l nt Guit
|| Legacy Instruments RBRguartz® BPR » | Quick Start Guide
Cables RBRquartz® BPR|zero >
RBRfermata

m
[~ N

Please note that you can always access the most current revisions of RBR documents on the RBR website.

B Rihrochal comish

PRODUCTS ¥ SALES SUPPORT ABOUT RBR ¥ RESOURCES ¥ CONTACT US

User Manuals

Ruskin User Guide: Standard Instruments®
o RBRvirtuoso’

RBRduo’

RBRbrevio®

RBRconcerto®

°

o

o

°

RBRmaestro’

o

RBRquartz®

Ruskin User Guide: Compact Instruments®
o RBRsolo?
o RBRduet’

Ruskin User Guide: RBRcoda®

Logger® Command Reference

RBR Instrument Guide: Standard Instruments?
RBRvirtuoso®

RBRduo?

RBRbrevio®

°

o

°

RBRconcerto®

o RBRmgestro?

o

4.4 Commenton Ruskin

There is an advantage to sending a bug report from within Ruskin because this allows you to include the diagnostic
logs, RSK datasets, screenshots, and any other files that could help us reproduce the problem and find the solution as
quickly as possible. Follow the steps below.

RBR#0006105revL
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Steps

1. Click on Help > Comment on Ruskin... . The Feedback to RBR form will appear.
Enter your identification information.

Enter a brief summary of the problem.
Provide a detailed description (serial number for the instrument, overview of the problem, deployment details,

initial tests, and, for software bugs, steps to reproduce the issue)
Include any attachments, if required.

6. Verify all the information entered and click Submit.

Mo

@

e @ Feedback to RBR

Report bug or enhancement

O General user Name: | customer Email address: Customer@email.com

RER employee
Summary:
Instrument type - problem statement

Description:

1. Serial number

2. Overview of the problem

3. Deployment detalls

4, Initial tests

For RSK / Ruskin issues

5. Steps to reproduce the issue

Attachments: Include any datafiles (RSK or HEX) and or photos of the issue

Attachments:

Attach...

Cancel | Submit |

4.5 Check for updates

Click on Help > Check for updates to search for the latest software version.

Progress Information

1 Checking for Ruskin updates...

37% completed

If your software is up-to-date, no further action will be required.

If an update is found, Ruskin will offer to install it. Follow the prompts. Restart Ruskin for the updates to take effect.
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4.6 Feature codes

Sometimes, RBR may release new features to certain users only, as a beta trial. This includes:

« Featuresin early development

« Features supporting a new product, in preparation for the product launch
+ Features requested by a specific customer

Usually, the goal is to get feedback and improve the feature before its official release. Contact your sales representative
or RBR support team at support@rbr-global.com if you have questions about your feature code.

Steps

1. Click on Help > Feature codes...
The Feature codes window will appear.

) [ Feature codes

Feature codes

Enter a provided feature code

Enter feature code ADD

Code Description

*All changes require a restart to take effect

Dismiss

2. Enter the feature code provided by RBR.
3. Click ADD.

If the code is correct, Ruskin will save the feature in the local database and enable it. In most cases, you will have access
to the new feature immediately, without restarting Ruskin. Otherwise, you will receive any additional instructions at the
time when you receive the feature code.

Errors

1. The feature code is not valid.

This error may indicate the code was entered incorrectly or it is not compatible with the current version of
Ruskin.

2. Thefeature code is already enabled.
This error may occur when another user has already activated this code.
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5 Quick start - Ruskin Desktop

Ruskin Desktop version is designed for computers and laptops. It generates dataset files which include raw
measurement data, firmware and software versions, dates and times, sampling settings, power settings, measured and
derived parameters, errors and events, calibration coefficients, and diagnostic information, offering the fullest Ruskin
experience.

5.1 Select Desktop on Ruskin

By default, new deployments started from a laptop or desktop computer are set to the Desktop storage format and
nothing needs to be adjusted. However, if the instrument has Wi-Fi, it will have Mobile selected by default from the
factory, facilitating faster downloads. When you start a deployment from your mobile device, the storage format
defaults to Mobile.

© Theraw datais not stored when operating an instrument with data storage format set to Mobile. The RSK file
will only contain the calibrated data.

You may prefer your datasets to contain raw data with the ability to change calibration coefficients. In this case, go to
the Configuration tab and open the Storage dropdown menu under Options. Select Desktop.

| = RBReoncerto? 209681 52

Configuration . Information Calibration | Parameters

Schedule Sampling Options

Status: Stopped, user request Mode: Continuous Realtime: None
speed: @ Rate 2Hz @ o

Clock: 2022-05-05 14:04:58Z uTc Local p W Serial: 115200 @

Start:  2022-04-14 v 758 PM 2 [ Now storage: (G

Mobile
End: 2023-02-14

Power

Battery:  Lithium thionyl chloride (2] Erash
External:  Other [ unknown
Gating
Extended battery endcap
Mode: None

b Sample power details

Ruskin Desktop can download datasets created in either Mobile or Desktop format. However, when Mobile is selected,
you will not be able to edit calibration coefficients and recalculate the data.

& You cannot change between Desktop and Mobile storage formats during the same deployment. Stop your
deployment, change the setting, then start a new deployment.
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5.2 Simulate an instrument

Ruskin can simulate most instruments and sensors that RBR produces. We recommend that you experiment with
different simulated options before enabling a schedule for your actual deployment. This practice will also help you
become more familiar with how an RBR instrument interacts with Ruskin and how to configure its settings and
features. Work with simulated instruments the same way as you work with a real RBR instrument, configuring,
calibrating, and fetching data.

& Currently, simulated instruments cannot be enabled or downloaded. For more information, see Deploy your
instrument.

Steps
1. From the Instruments menu, click Simulate an instrument.

& Ruskin File Instruments Help
ece®
B Navigatuf

) —  Update instrument firmware...
b i Instruments

©simRBRsolo? Automatic tasks >
O simRBRcoda®
e MLM Utilities >

d 5 Datasets Il
|m 209681...1600

The Configure simulated instrument dialog box will appear.

& Depending on the instrument selected, the Options dropdown menu may contain | fast sampling rates,
| tide and | wave variants, tilt, or no options at all (in that case, the menu will be greyed out).

2. Click your instrument family and make your selections.
Within the Standard instruments family, Ruskin will identify the type of instrument to simulate based on the

number and type of channels you include. If you select only one channel, Ruskin will simulate the RBRvirtuoso®.

If you select more than five channels, it will become the RBRmaestro®. The name of the instrument and its

generation will be displayed in the top section of the dialog box, for example, "Late 2017 - RBRconcerto® C.T.D".
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[ ] @ Configure simulated instrument

Simulate an instrument
Late 2017 - RBRconcerto® C.T.D

Compact instruments  Standard instruments RBRquartz Sensors

Standard configurations Channels
RBRduc® T.D Conductivity
Temperature
RBRduc® C.T
Pressure

RBRconcerto® C.T.D

RBRbrevio® C.T.D

Options Housing

S | Standard
|fast8
|fast16
|fast32
[tide16
[wave16

Cancel

Legacy

(Ol <R <)

3. Click OK to proceed.

4. Your instrument will appear under Instruments in the Navigator view. Simulated instruments will have a prefix

"sim" in the front of their name.

45 Navigator

o i Instruments
OsimRBRsolo? 905925
DsimRBRcoda® 909036 =
CsimRBRconcerto® 905833
g MLM
gDatasets
|y 209681...1600

e |

8

The instrument properties will be displayed on the right, under four tabs.
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=1 simRBRconcerto® 905739 23

Configuration . _Information | Calibration | Parameters

Schedule Sampling Options

Status: Not enabled Mode:  Continuous (2] Realtime:  None B rormat:  Standard resolution (2]
Clock: 2022-04-28 15:48:08-04:00 uTe Local speed: @ Rate 2z @ Serial: 115200 @ Mode:  RS232

Start:  2022-04-28 v 2:00PM O Now Storage: Desktop B wi-Fi: on 8

End:  2022-07-11 [l 74.0days B +231 days

Power

Battery Lithium thionyl chloride 2]

External: None (2]

Gating
Extended battery endcap

None
» Sample power details Mode: e

Memory used: 0%

Revert settings Use auto-deploy settings

> The Configuration tab displays status, clock, sampling mode and speed, serial connection details, power
options, and deployment estimates based on these parameters

> The Information tab includes general details, such as the instrument model, generation, serial number,
firmware version, power source, battery status, and the channels

> The Calibration tab allows access to the current calibrations for each channel in the instrument

> The Parameters tab outlines default values used by the sensor when performing computations and
derivations

5. Familiarise yourself with the instrument by changing configuration options and comparing deployment
estimates. Select the desired configuration using the dropdown options or entering the values manually in the
fields provided. For simulated instruments, the Plot window will remain empty unless you click the Fetch

button 1B

6. Manage multiple instruments by switching between them in the Navigator window.

@ Toremove asimulated instrument from Ruskin, right-click it in the Navigator window, and select Disconnect
from instrument. You can also use the Instruments menu.
Alternatively, simply close its Plot tab by clicking the X. The instrument will disappear from the list.

5.3 Deploy yourinstrument

Before using your RBR instruments, you may want to experiment with different options by simulating your instrument
on Ruskin. When you are ready to use your physical RBR instrument, follow the steps below to ensure that you measure
exactly what you want on the first attempt.

Steps

1. Remove the battery end-cap. See "Opening and closing the instrument" section in the corresponding RBR
Instrument Guides for more details. The Guides are available on Ruskin under Help > Documentation.

2. Locate the USB-C port. For most standard instruments, it is inside the housing, next to the battery cover. For the
RBRquartz® BPR | zero and RBRquartz® Q | plus, it is inside the end-cap.

3. Plugone end of the the USB cable (USB-C to USB-C, provided with your instrument) into this port and the other,
in the USB port on your computer.
The instrument will appear in the Navigator view after a few seconds. The properties for the instrument will be
displayed in the Properties window, grouped under four tabs: Configuration, Information, Calibration, and
Parameters.
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4. Ifyou are using the instrument for the first time, you can use either the default preferences or specify your own.
For more information, see Preferences > General. You can change them at any time.

5. Click the instrument you want to use. Verify that it contains the expected sensors under the Information tab.

Click the Calibration tab to view or modify calibration coefficients.

7. Click the Configuration tab and go to the Sampling section to select the mode and speed of measurements.

o

@ Ruskin will allow a deployment to run until the instrument can no longer sample. This could be due to a
full memory or due to power supplies being exhausted. It will display the estimated battery usage and
storage capacity based on the parameters you enter. The green widget next to End will indicate the
number of days your instrument would be sampling, along with the icon representing the limiting

factor, battery or memory.
Carefully consider this information before you enable a deployment schedule. For more information,

see Schedule.

8. Click the Enable button at the bottom of the Configuration tab to take samples according to the schedule that
you specified.
Your deployment will continue until the battery runs out, the memory is full, or you stop your schedule
manually.

@ Ifyou want your data streamed or fetched, specify these preferences before you enable the schedule:

° Click the Configuration tab and select the streaming option from the Realtime dropdown menu
(Serial or USB).

° To see live data sampled every few seconds, click the Fetch button UE on the far right of the
toolbar above the Plot view, without enabling the schedule.

o To start streaming, click Enable. The data will immediately appear in the Plot window below.
The instrument does not store streamed or fetched samples, but Ruskin will record them in the
realtime RSK file.

9. When your deployment stops, click the Download... button at the bottom of the Configuration tab to transfer
all the sampled data from the instrument to your computer. For more information, see Download.
As soon as you download a new dataset, it will appear in the Navigator window. Refer to Datasets for details on

managing and analysing your data.

@ Torestore a closed connection to an instrument on Ruskin, click Instruments in the Navigator
window. A list of all instruments physically connected to your computer will appear in the Properties

window.
Find your instrument and deselect its checkbox, and then select it again.
Your instrument will re-appear in the Navigator window.

5.4 Recover your instrument and download data

When deployment is complete, recover your instrument and follow these steps to download your data.

© Flooded instruments may be under pressure and opening them may be dangerous. Take precautions when
opening an instrument after deployment.
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Steps
1. Start Ruskin.

2. Carefully remove the battery end-cap. See "Opening and closing the instrument" section in the corresponding
RBR Instrument Guides for more details. The Guides are available on Ruskin under Help > Documentation.

3. Locate a USB-C port inside of the instrument.

4. Plugone end of the USB cable (USB-C to USB-C, provided with your instrument) into this port and the other, in

the USB port on your computer.
5. Theinstrument will appear in the Navigator view after a few seconds.
6. Under the Configuration tab, click Download... . See Download for details.

7. Save the file to your local drive. See Preferences > General on steps to set up your default location.

Memory used: <1%

Enable

Revert settings

Download...

Use auto-deploy settings

8. Evaluate your data. See Analysis for details.

Disconnect from your instrument

To disconnect an instrument from Ruskin, right-click it in the Navigator window, and select Disconnect

from instrument. You can also use the Instruments menu.

Alternatively, simply close its Plot tab by clicking the X. The instrument will disappear from the list. Please note that
you will be able to reconnect to it at any time because Ruskin remembers the port of a plugged instrument.

Reconnect to your instrument

To restore a closed connection to an instrument on Ruskin, click Instruments in the Navigator window. A list of all

instruments physically connected to your computer will appear in the Properties window, under the Connections tab.

Find your instrument and deselect its checkbox, then reselect it again. Your instrument will re-appear in the Navigator

window.

& Navigator

# Instruments

i MLM

gDatasels
o 203672...1240
o 208718...time
o 209718...1210

=a

= Connections &2

Port
v [dev/tty.usbmodem1412101

Status
Connected to RBRconcerto® 209681

RF latency (s)
0

Device
Logger

Remove your instrument

To completely remove your instrument from Ruskin, unplug it from your computer.

Alternatively, deselect the checkbox next to your instrument, and Ruskin will disable transport to its port.

=+ Navigator

i Instruments
i MLM
v B Datasets
o 203672...1240
o 209718...time
o 209718...1210

=

O

I Connections 2%

Port
Jdevftty.usbmodem1412101

Status
Transport disabled

RF latency (s)
Q

Device
Logger
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6 Quick start - Ruskin Mobile

8:05 PM 7 % 99% =

Downcast 3/29 Details

4:50PM T3Ems
6:38 AM

concertd 060286 CoTCE -
RBR« >;10L‘(:;‘; Ors,z\_\\z f RBR concertss151s
3772 , S

Deployment stopped

> /om)
onductivity (S 37.7858
ure ( C)

@c

Tempera
Sure (doar)

@ TAG

1224064 | 5,

37.785 z
858, =122 4064, (5m)
Depth W)
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%)) (ms/cm)

@)
« R

t [
Jnstrume’ nStrument

Ruskin Mobile is a light version of Ruskin, with all the essential functions needed to manage deployments, and with the
added advantages of a smart phone such as augmenting data with GPS tracking, displaying live data and uploading to
the cloud. Ruskin Mobile connects to Wi-Fi enabled RBR instruments and works on iPhone®, iPad®, Android™ phone,

and Android™ tablet.
Install the Ruskin app on your mobile device by going to the Apple App store or Google Play.
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6.1 Select Mobile on Ruskin

By default, new deployments started from a mobile device are set to the Mobile data storage format, and nothing
needs to be adjusted.

However, when you start a deployment from your laptop or desktop computer, it defaults to the Desktop format which
will limit your abilities to view the dataset on the mobile device.

On some occasions, you may set up your instrument from the laptop with the intention to view the dataset on your
mobile device afterwards. In this case, go to the Configuration tab and open the Storage dropdown menu under
Options. Select Mobile.

=] RBReoncerto® 209681 23

Configuration . Information . Calibration | Parameters

Schedule Sampling Options
Status: Stopped, user request Mode: Continuous [ Realtime: MNone @
Speed: [ Rate  2Hz a8 f AACAAA Y
Clock: 2022-05-0514:07:112 uTcC Local B g Serial:
Desktop

Start;  2022-04-14 ¥ 758 PM 2 [ Now storage: (VS

End:  2022-09-14 ]

Power

Battery:  Lithium thionyl chloride & Frach
External:  Other [ unknown &
Gating
Extended battery endcap
Mode: None (%]

b Sample power details

With the Mobile data storage format selected, you will be able to track your instrument by adding the GPS location of
your phone or tablet to the dataset. The RSK file will store data already calibrated, facilitating faster downloads over the
Wi-Fi.

© Theraw data are not stored when operating an instrument with the storage format set to Mobile. The RSK file
will only contain the calibrated data, which prevents re-processing the dataset with new calibration
coefficients.

Ruskin Mobile can download datasets created in the Desktop format. However, features such as charting will not be
available.

& You cannot change between Desktop and Mobile storage formats for the same deployment.
If started in Desktop mode, there are two options:
1. Stop the current deployment, change the setting, then start a new deployment.
2. Continue the same deployment in Desktop mode, without the ability to view charts.
You can still download your dataset, archive it to Dropbox or another sharing destination, and then use
Ruskin Desktop to display it on your computer.
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6.2 Connect to your instrument

RBR instruments with a built-in Wi-Fi module have the WI-FI READY icon on the end-cap and can connect to mobile
devices.

The Wi-Fi module needs to be enabled at the time of purchase. Contact RBR if you have any question about this feature.

& Any given instrument may be connected to only one device at a time.
Connect to your instrument and set up all deployment parameters before submerging it.

Steps

& Twisting the end-cap to the RUN or PAUSE position will activate the Wi-Fi.
However, twisting to the PAUSE position will also pause the instrument.

1. Android
a. Twist the instrument end-cap any direction to activate the Wi-Fi. The Wi-Fi will stay on for 60 seconds,
waiting for you to connect.

b. Open Ruskin . and tap Search for instruments.
If only one instrument is detected, Android will automatically connect and begin downloading the latest
dataset.

2. ios
a. Twist the instrument end-cap any direction to activate the Wi-Fi. The Wi-Fi will stay on for 60 seconds,
waiting for you to connect.

b. Open Ruskin . and tap the convenience button on the landing page. The app will take you to the
Settings page, from where you will navigate to Wi-Fi.
The instrument will create its own SSID and appear under available Wi-Fi networks. Its name will be the
RBR serial number, for example, RBR 060286.
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Ruskin = 12:27 PM

Instrument

{ Settings Wi-Fi

Wi-Fi

o

v |RBR2 a

9)
©

CHOOSE A NETWORK...

Flex a

9)

Please connect to your

%b logger's Wi-Fi linksys a8

9)

RBR & 3

RBR 060286

9)

)
B © B

RBR Guest

.))

=3

Other...

Ask to Join Networks -

Known networks will be joined automatically. If no known
networks are available, you will have to manually select a
network.

Searching for instrument

R = © b

Instrument Datasets Locations Settings

R = © b

Instrument Datasets Locations Settings

c. Tap theinstrument SSID name to connect and wait for a blue checkmark to appear on the left of the Wi-Fi
network.
A message "No Internet Connection" will appear below. It has no effect on using Ruskin Mobile to
manage deployments and refers only to the inability to browse websites while connected to the

instrument.
Wi-Fi »
RBR 202471 _

No Internet Connection

d. Return to Settings, then to the Home screen.

e. From the Home screen, tap the Ruskin app icon . . Ruskin Mobile will automatically connect to the
instrument.

A The Wi-Fiis disabled after 60 seconds of inactivity. Twist the end-cap to RUN or PAUSE to re-activate the Wi-Fi.
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There are four views on Ruskin Mobile: Instrument, Datasets, Locations, and Settings, accessible via the toolbar at
the bottom of the screen.

P S ©

Instrument Datasets Locations Settings

(t®)
When first connected, Ruskin Mobile will open the Instrument view of the app. Use this tab to set up and manage
your deployment.

12:33 9 12:33 9

RBR concert&:s51515
732 \ ON \ 6Hz

RBR concerté:s1515
732 \ ON \ 6Hz

1%

LAST TAGGED L
1

37.7874 -122.4082‘ 5m

_ATITUDE LON:

37.7874 ‘ -122.408 ‘ 5m

ATITUDE

CURRENT LOCATION
37.7874, -122.4082, (5m)

@ cConductivity (mS/cm)
Temperature (°C)
. Pressure (dbar)

‘ Conductivity (mS/cm)
Temperature (°C)
@ Pressure (dbar) STop

NERN/EN MHANINIEI Q

R e o

Instrument atasets Settings

NERN/EN MHANINIED Q-

P = O 0

Instrument Datasets Locations Settings
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=)
Tap Datasets to access local datasets and charts, upload datasets to your Dropbox account or another sharing
destination, and (optionally) delete archived datasets.

Tap Locations @ to track your instrument during deployment.

Tap Settings [‘] to manage your deployment preferences and share feedback or contact the support team.

6.3 Deploy yourinstrument

The Ruskin Mobile screen is divided into several areas where current parameters are displayed, and includes three
operating buttons. There is a toolbar at the bottom of the screen, with four views: Instrument, Datasets, Locations,
and Settings.

((®)
When connected to an instrument, the Instrument B&M view contains information about your instrument and its
deployment.

Instrument name Serial number
Number of _
samples \ Sampling
R B F{ conceriar s 5 "/ rate
732 ON 6Hz
Sparkline _
chart Logging
is ON
Last ta-lgged View
coordinates = RS

e

Tag current
coordinates

37.7874 | -122.4082 5m

Channels il Stop or start
deployment
I','Stmmettn.ﬂ 4 )/~ Settings
view - i
view
/‘/ »
Datasets Locations
view view
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Status
The top of screen shows the name and serial number of the instrument, followed by its status:

« Number of samples taken
+ Logging state (ON or OFF)
« Sampling rate

When the logging state is shown as ON, the instrument is
logging data.

2 @m)

12:339

RBRconcerté’s151s

732 | ON | 6Hz

When the logging state is shown as OFF, the deployment

is paused but stillin progress.
12:339 >

RBR concerté’s1515
732 = OFF  6Hz

A deployment can have only one sampling rate, thus you cannot change it when logging is just paused.

To adjust the sampling rate, you have to stop the deployment using the red STOP button. A message "Deployment
stopped" will be displayed, and the sampling rate field will become editable. However, you cannot resume the same

deployment after stopping it. After changing the sampling rate, you will have to start a new deployment.

& Once adeployment has been stopped, it cannot be resumed.
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Realtime data

A sparkline chart shows the last 50 readings for each of
the measured channels (or the last 150 readings when
using a tablet). These are typically out-of-water samples
and serve to provide realtime feedback from the
instrument.

To view charts of the full deployment, tap the light blue
VIEW button.

Geotagging

Your instrument does not have a GPS, but its location
information may be available depending your phone/
tablet tracking capabilities.

Whenever the Ruskin App connects to an instrument, it
automatically logs its location at that moment. Even if the
boat moves away from the starting point during
download, the initial location will be captured in the
dataset. Should a more accurate location fix be attained
within the first minute after connection, those
coordinates will be used instead.

LAST TAGGED LOCATION:

LAST TAGGED LOCA
g ically at 12:31
37.7874 ‘ -122.4082 | 5m

UDE LONG DE

CURRENT LOCATION:
37.7874, -122.4082, (5m)

The LAST TAGGED LOCATION data indicate when the last GPS coordinates were added to the dataset.

As the app uses GPS, a clear view of the sky will allow a more accurate waypoint, rather than downloading inside a ship
cabin, for example. To conserve the battery life of your phone, GPS tracking only occurs when the Ruskin App is open or

when you are recording a track of your location.

It can take a few moments after opening the app to get an accurate location fix. When GPS is working well, an accuracy

of around 5 metres can be expected.

Tap the purple TAG button to log the CURRENT LOCATION data manually. The last tagged location will be updated to

indicate the coordinates and accuracy of the manual GPS waypoint fix.

Both types of waypoints described (manual tags and those taken automatically on download) can be seen plotted on a

map in the Locations @ tab.
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Channels

Scroll to the bottom of the Instrument tab to view
measured and derived channels, along with their units of

measurement. ‘ Conductivity (mS/cm)

The coloured circle to the left 91‘ each channel in(.jicates Temperature (°C)
the sparkline colour representing the latest readings from
that channel. . Pressure (dbar)

\ RED CHANNELS:

Voltage (V)

DERIVED CHANNELS:
Pressure (dbar)
) Depth (m)
@ saiinity (PSV)

Deployment

The red button in the bottom right corner reads either VIEASURED CHANNE
START or STOP, depending on whether a deployment is

in progress. ‘ Conductivity (mS/cm)

Tap the START button to begin a new deployment. When Temperature (°C)
a new deployment is started, the data on the instrument . Pressure (dbar) el
will be erased. ) 7

NERN/EMN MHANINIFI Q-
Tap the STOP button to end the cu rrenF deployment. ((A» S \3) Q
Once a deployment has been stopped, it can not be Instrument Datasets Locations Settings
resumed.

& Usethe twist activation feature to pause deployment if you intend to continue with it later.

One dataset is created for each deployment. Deployments are typically long-running and consist of many sampling
periods (activated by twisting the end-cap to RUN) and paused periods (activated by twisting the end-cap to PAUSE).
Each deployment can only have one sampling rate, and it cannot be changed while logging is just paused. To change
the sampling rate, stop the deployment.

& When the deployment is stopped, twisting the end-cap to either RUN or PAUSE will activate the Wi-Fi, but the
instrument will not vibrate as it is not sampling.
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6.4 Access datasets and charts

=)
When connected to an instrument, the Datasets view allows access to local and archived datasets.

Datasets Bulk upload
stored locally to the Cloud

Datasets

Local Datasets

GPS Track

B:50am on 2 Jun "19

RBRconcerto 060286

] B:489pm on 24 May "19

RBRconcerto 060286

11:06am on 14 May *19 1
Dataset
menu
RBRconcerto 060286
8:00pm on 18 Oct "1
Sample Dataset 1
ple Dataset 2
Asal Irde Hurmdana b \
Sample
/ GPS Track o datasets
B:400pm on 24 May “19
Datasets
uploaded
to Dropbox

The Local Datasets list includes the datasets stored on your mobile device after they were downloaded from connected
instruments. You can view charts for these datasets on your device.

To save space, you may choose to upload your datasets to Dropbox. These datasets will be on the Archived Datasets
list. If you have not set up your Dropbox and are using other ways to upload datasets from your device, the second list
will not appear.
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& By default, the datasets will be automatically removed from your device once they are uploaded to Dropbox.

Thus, you cannot view charts for archived datasets. To change this preference, go to the Settings tab.

Sample datasets, captured from real deployments, are Sample Dataset 1

available to demonstrate the features of the Ruskin app. An example dataset with profiles
showing conductivity and
temperature.

()

Sample Dataset 2

A dataset from Hurricane Florence
showing conductivity, temperature
and salinity.

((J

344kB

If a dataset is in Desktop format instead of Mobile, its
icon will include an exclamation mark. You will not be
able to view charts for this dataset.

5 RBRconcerto 060286
Y@ s42amons Sep 17

B:59arm on 2 Jun 19

Tap GPS Track to display raw GPS tracking data. “I  OPSTrack I"
an 1kE

Every time the instrument comes out of the water, Wi-Fi automatically turns on and your mobile device records that
location. The Ruskin mapping feature uses these GPS coordinates to plot the route of your instrument on the map.

Uploading and sharing datasets

Op i0S, swiping to the lef.t on an item in the Datasets list « RBRconcerto 060286 .
will reveal several operations that can be performed on = 11.08am on 14 May '19 s
that dataset: Info, Share, Delete. On Android, long-

pressing the item reveals the equivalent context menu. D56KE Share  Delete

RBR#0006105revL
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The Share option shows a context menu of the available for that dataset. What these are, depends on the apps you
have installed on your phone, but a number of options come without additional apps. On iOS these include sharing by
email, AirDrop, and saving to Files (as of iOS 11). To see your cloud drive (Google Drive, Baidu, Box, Microsoft OneDrive,
iCloud, Dropbox, etc.) as a sharing destination, you need to install that app.

& Sharing options are only available for local datasets.

Dropbox

There are additional features available for Dropbox
sharing which, incidentally, do not require the Dropbox
app to beinstalled.

RBRconcerto 060286
9:1%am on 22 Jun '17

((J

RBRconcerto 060286
9:29am on 22 Jun 17

t(J

To enable Dropbox integration, you must sign in to

Dropbox. The option for this is at the top of the Settings
RBRconcerto 060286
9:37am on 22 Jun '17

()

tab.

RBRconcerto 060286
9:38am on 22 Jun "17

()

Press the Cloud button in the top right corner of the Datasets tab to bulk upload all your local datasets. As the datasets
upload, the icon will transition from an upwards arrow to a checkmark.

By default, the datasets will be automatically deleted from your device once they are uploaded to Dropbox. To change

this preference, go to the Settings E] tab.

Charting

Tap on a dataset on the Local Datasets list to view its charts.
A Toview charts for the currently connected instrument, go to the Instrument view.

The charts are separated into casts (one cast per page). Each time the instrument descends and ascends again is
considered to be one cast, and a new chart is created for each. Swipe left and right to view the chart for each cast. In the
example shown, the dataset includes 10 casts.

The instrument determines the start and end of a downcast by depth (pressure) readings, and thus only a single chart
will be created when testing the out-of-water samples.
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In portrait orientation, channel data is plotted by depth,
and only downcast data. The upcast data is omitted.

T .

Downcast 4/10 &) Details

When the instrument sensors face downwards, the
downcast provides the most accurate data, while the
upcast data can be subtly impacted by the turbulence
from the leading instrument housing on the ascent.

Tap on the multi-coloured caption under the plot to open
the legend with units of measurement. Use the toggle
buttons to select which channels to display on the chart.

& When viewing out-of-water samples, the
downcast chart will appear like a random plot
because there is no change in depth.

CHART SERIES

@ Conductivity (mS/cm)
o Temperature (°C) A0

Pressure (dbar)

In landscape orientation, the channel data is plotted by time. Depth is inverted, so the bottom reading on the chart
intuitively represents the bottom of the cast.

Profile 4/10 & Details

ty @) Temperature (@) Depth

Use pinch-to-zoom to zoom in and out on your data. The chart axes adjust relative to each other on zooming and
panning around the chart. As a result, all chart series occupy the full height or width of the chart and can be easily
compared side-by-side.
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Tap on Details in the top-right corner to reveal information about the displayed cast and deployment parameters. The
deployment data is also available in the Info context menu of the Datasets list.

The same deployment data is also available in the Info

12:44 9

Back

Downcast 3/29 v &) Details

<

Downcast 3/29 v &) Details

DOWNCAST 4/29
Start date: 2018-03-08 18:41
End date: 2018-03-08 18:45

DEPLOYMENT

Start date: 2018-03-08 16:00
End date: 2018-03-2114:41
Sampling: 6Hz

INSTRUMENT

Model: RBRconcerto
Serial: 065544
Firmware: 10.754

11.9 12.0
@ Temperature

context menu of the Datasets list.
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38.3 384 38.5 38.6

1.7 11.8 11.9 12.0 121
@ Conductivity @ Temperature

- RBRconcerto 060286

= 11.08am on 14 May '19
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6.5 Track your instrument

When connected to an instrument, the Locations @ view allows you to display its GPS coordinates and plot profiles
as data points on a map during deployment. This feature relies on location capabilities available on your mobile device.

Your
Dropdown
e current
\ Sas — location
| My Location (Mot Tracking) (7)) <& Information
Show your — |
Y — drawer
location — (@
on the map ) GPSTrack
Sample Dataset 1
Recorded - | isitiadiit
raw GPS data Sample Dataset 2
Datasets
Return the
map to your
/ location
Stop or start
tracking

Tracking

& The Ruskin tracking feature relies on location capabilities of your mobile device. When the boat is towing the
instrument, the phone and the instrument are at the same location at the any given time. The app knows

where the instrument was for each sample and adds this information to the dataset, thus ensuring continuous
tracking.

The red button in the bottom right corner reads either START or STOP, depending on whether tracking is in progress.
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Tap the red START button to start tracking. A red tracking
banner will appear at the Locations icon in the toolbar.

Locations

. . . . . 45.2195 -75.6848 10m 0.0km/h
The first time you use this feature on iOS, you will see a

prompt, "Allow Ruskin to also access your location even Active Track
when you are not using the app". Select Always allow;
otherwise, when you leave the app, tracking will cease.

Follow your deployment on the map, or view a broader
context by using pinch-to-zoom or panning away from
your track. Tap the purple RECENTER button to return to
your location.

Point Bonita L\ghlhoysg

LN

Tap the red STOP button to stop tracking.

Unless you tap STOP, tracking will continue for up to 24
hours, even with the app in the background. On iOS, you
can also interrupt GPS tracking by force-closing the app:
double-tap the home button and swipe upwards (or, on
iOS devices with facelD: swipe upwards and pause in the
centre of the screen, then swipe up on the app to be
closed).

@ Tosave battery power, stop GPS tracking when you stop deployments.

GPS track files

A waypoint is automatically added to the RSK geodata table whenever the instrument connects and also whenever you
tap the purple TAG button in the Instrument view. Raw GPS data is saved as a GPS track file in the GPX format.

When a deployment is in progress, its track will be displayed on the dropdown menu as Active track. All previously
recorded tracks are displayed as a GPS Track with time and date listed below.

When you open a previously recorded track in the Locations view, the current location details disappear from the
header along with the red STOP button and blue RECENTER buttons. This does not affect the recording of the current
track. To view current location stats or stop tracking, open the dropdown menu and tap Current Track.

can also access and manage them from the Datasets

Tap GPS Track in the dropdown to open a track file. You H‘I
view,

One track creates one tracking file. When you open it, there will be no profiles, tags, or download pins. Track files use
the GPX format, augmented with a couple of minor extensions. A track file is independent of any RSK, but Ruskin uses it
to inject location data into the RSK whenever the RSK is downloaded. The RSK geodata table will contain one row for
every GPS entry captured during the deployment.
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In most cases, you do not need to access the GPX file as RSK contains all the needed data. However, you have an option
to upload the GPX files from the Ruskin app independently of RSKs. You may wish to use a track to illustrate your course
on a map using various online tools, or convert it to other formats such as GeoJSON or KML.

Profiles

Open the dropdown menu and tap on a dataset.

o 2y atasa
= f:an.'n,.lc Dfn.te? | :

e

A map will open, showing the tracked route recorded during deployment. Tap on the Information drawer button at the
top right to view the details related to deployment, waypoints, instrument, and map type.

Locations Locations
Sample Dataset 1 Sample Dataset 1 @

DEPLOYMENT

e ls o LAY Start date: 2018-03-08 09:06
b { End date: 2018-03-21 07:47

7 Sampling: 6Hz
rail, S ——

Head-Alamere Falls s 2

A WAYPOINTS
O profiles:
Profile 4 of 10 @ Tags:

8 March 2018
©® Downloads:
DOWNCAST ____9 : .

- Start time: 11:47:54
- End time: 11:51:39 INSTRUMENT

HPeAsT e Model: RBRconcerto
- Start time: 11:51:39 :
-Endtime:  11:52:59 Serial: 065544

Firmware: 10.754

VIEW CHART

MAP TYPE

Normal .m Satellite

7 % o

Instrument Datasets Locations Settings Instrument Datasets Locations Settings
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There are three colours used to draw the track:

1. Ared line for the downcast segments

2. Agreen line for the upcast segments

3. Alight grey line for segments not associated with
the profile (e.g. out-of-water periods)

There are three types of tag pins used to mark locations:

+ Red profiles tag pins with numbers
« Purple manual tag pins with a letter "T"
+ Blue download tag pins with a letter "D"

Download tags are automatically added whenever the
instrument downloads to your mobile device. Typically, it
occurs when the instrument ascends and reaches the
surface, or at the end of a deployment. They are hidden
by default. Use the toggle switch on the information
drawer to display them. You will see them appear
whenever the line colour changes from green to red, and
at the very end of the track.

Tap on a tag pin to open an information window. For the
red profile tag pins, it includes a link to view the chart for
that profile.

If no raw tracks coincide with a deployment, only download and manual tag pins will be displayed. Download pins are
hidden by default, so if there are no manual tag pins, the map may appear empty.

Locations
Sample Dataset 1 ®

2018-03-08 09:06
5 2018-03-2107:47
6Hz

® Downloads:

INSTRUMENT

Model: RBRconcerto
065544

Fi e: 10.754

MAP TYPE

Normal Terrain Satellite

In the absence of track data, Ruskin Mobile searches for any automatic waypoints from instrument downloads and will
sometimes be able to position some profiles from these and thus display some profile pins.

If track data is not available for the full deployment, some profile pins may be missing from the map. Refer to the
information drawer to see how many profile locations could be determined.
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6.6 Adjust your settings

When connected to an instrument, the Settings m view allows you to manage your deployment preferences.

Setti
il Dropbox
Dropbo: — :

settings
Slgn in | = Connect to Dropbox
to Dropbox
Instrument
setti ngs Instrument

Charting

settings
Location
settings

Dropbox

Sign in to Dropbox to enable Dropbox integration. Click
on Connect to Dropbox and follow the prompts.

Settings

Dro pbox .

] Connect to Dropbox
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By default, the datasets will be automatically deleted | _
the toggle switch to change this preference.

from your device once they are uploaded to Dropbox. Use }

Clock Sync

When you start a deployment, you can automatically set
the instrument time from your phone or tablet.

Local uTc off

As the instrument has a clock but no concept of time zones, you can select UTC or Local time, or you may choose to set
no time at all by selecting Off.

When you remove batteries from your instrument for more than a few seconds, the clock will reset (back to the epoch).
Starting a new deployment with the Clock sync option enabled provides a convenient way to correct the clock.

Units of measurement

By default, your charts will plot temperature in Celsius
and depth in metres.

Change your viewing preferences to Fahrenheit for - i
temperature and feet or fathoms by making your _
selections under Charting. Plot depthr m h fm

() Alternative units of measurement will allow you to view the charts in preferred format, but will not affect the
units in which the data were originally captured in the datasets.

By default, your maps will use kilometres per hour for

Location
velocity and kilometres for distance.

Change your viewing preferences to metres per second or
knots for velocity units and nautical miles for distance by
making your selections under Location.

Setlings
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7 Connections

Use the Connections tab to view and manage devices connected to your computer via physical ports or Ethernet.

In the Navigator window, click Instruments. The Connections tab will open on the right. The table will include ports,
statuses, RF latency selections, and the device type for each connected device.

] Connections &3
Port Status RF latency (s) Device
v jdevftty.usbmodem141101 Connected to RBRconcerto® 209681 2 v R5-485
192.1684.063:23 Connected to Ms-310 0 Logger
Jdevftty.usbserial-AIDSTREB Connected to RBRduet® 2061989 |1 Logger
192.168.5.023:12 Connected to NMEA GPS 2 | GPS
127.0.0.1:2 Unable to connect to host 3 Logger
a
B
3]
7
8
9
10
1
12
13
14
15
16
17
18

Column Information

Port If your instrument is plugged in to your computer, this column will identify the physical port by
name, such as "COMS5" (if using Windows) or by its address, such as "/dev/
tty.usbmodem141101" (if using MAC OS).

Status The column will display a success message, such as "Connected to RBRconcerto® 209681", or
an error message, such as "Unable to connect to host".

RF latency (s) From the dropdown menu, select a value up to 29 seconds. The selected value will extend the
allowable time for an instrument to respond to a command. Use this option when on a long
cable or slow Wi-Fi connections.

Device The column will display the device type for each connected device:

« Logger: Instruments connected via USB, serial (RS-232), or TCP connections
« RS-485: Instruments connected via serial (RS-485) connections
+ GPS: NMEA streaming devices
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See Deploy your instrument on how to locate the USB-C port on your instrument and connect it to your computer.

As soon as you plug in an instrument, Ruskin will detect it and add it to the list.

'iﬁ-Navigatcr. \ = 8 ||EI Connections E’S-
v instruments _[IS
ORBRconcerto? 209681 §
ORBRduet? 206199 Port Status RF latency (s) Device
[ EmMLM [devjtty.usbmodem14123101 Connected to RERduet® 206199 0 Logger
[ v & Datasets [devitty.usbmodem141101 Connected to RBRconcerto® 209681 0 Logger
los 095719..1121
Click on one of the instruments to switch to its Configuration tab.
4+ Navigator ~ B || £ RBReoncerto? 209681 &
i iinstruments Configuration _Information /. Calibration | Parameters
ORBRconcerto® 209681 . .
ORBRduet® 206199 Firmware Update
s MLM - )
~ 2 Datasets Update firmware A newer firmware version Is available. Please update to ensure fu
s 095719..1121
Schedule Sampling Opti
Status: Stopped, user request Mode: Continuous Real
Speed: [ Rat 2Hz
Clock: 2023-02-16 13:19:47-05:00 uTc Local L D e Ser
Start: Not available with twist activat Sto
Power
Battery:  Lithium thionyl chloride Fresh
- Other | unknown e
External: ju W Gating
Extended battery end-cap - —
b Sample power details Mode: Twnst acivation s

If you unplug an instrument, the port will remain enabled as long as the port checkbox remains selected. Ruskin will
automatically reconnect to the instrument when it is plugged back in.

Deselect the checkbox next to your instrument to disable transport to its port. After this, Ruskin will not detect any
instrument plugged into this port.

| 4 Navigator . = o | =l Connections 83
v @ Instruments [ .

CRBRduet* 206199 ’

i MLM Port Status RF latency (s) Device
| ~ £ Datasets ¥ [devftty.usbmodem14123101 Connected to RERduet® 206199 0 Logger
[ |9 095719..1121 [devjtty.usbmodem141101 Transport disabled 0 Logger

To restore transport, reselect the checkbox. Your instrument will re-appear in the Navigator window.
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8 Configuration

Use the Configuration tab to set up your deployment parameters.

Configuration Information | [, Calibration | Parameters

Firmware Update

Update firmware

Schedule Sampling Options

Status: Stopped, user request Mode: Continuous (@ Realtime:  None Format: ~ Standard resolution (2]
speed: @ Rate 2Hz @ .

Clock: 2023-02-16 13:58:32-05:00 uTtc Local P V] Serial: 115200 B Mode: R5232 B

AL, : . Storage:  Mobile B wiF: o

End:  Gated | 152days o NA

Power

Battery:  Lithium thionyl chloride 8 Eresh

External:  Other [ unknown (<]

Gating
Extended battery end-cap

Twist activation
} Sample power details Moge: e
Memory used: <1% Download...

Enable Revert settings Use auto-deploy settings

After setting up a desired schedule, verify that it meets your requirements. To return to previous settings, click Revert
settings.

To save the settings for the new schedule, click Enable. New values will replace all previously stored schedule
parameters.

& You cannot use Revert settings after clicking Enable. To change a schedule already enabled, stop the
instrument, restore old values manually, and click Enable again.

To apply the same schedule to multiple instruments with the same sampling capabilities, set up the first instrument
and click Enable. Connect all other instruments to Ruskin and click Use auto-deploy settings. Now all instruments will
run on the same schedule, including logging times, power options, sampling parameters, and gating conditions. See
Automatic tasks for details. To return to previous settings, click Revert settings.

Enable Revert settings Use auto-deploy settings

@ Enabling a new schedule will remove all the existing data on the instrument. Make sure to download the data
from the instrument before starting a new deployment.

8.1 Update firmware

Ruskin automatically checks if your instrument firmware is up-to-date. Updates may be critical, routine, or customised.

If a newer version is available and this update is critical, the Update firmware button and a warning message will
appear at the top of the Configuration tab.
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Configuration

Firrmware Update

Information | Calibration | Parameters

Update firmware

See Critical firmware updates for details.

8.2 Schedule

The Schedule section includes four fields: Status, Clock, Start, and End.

Clock:

Start:

End:

Schedule

Status: Stopped, user request
2022-05-10 15:09:00-04:00 uTeC
2022-04-14 +

2023-02-14 | I 306 days

Local
7:58 PM o Now

Status

The Status field displays the current state of your instrument.

Status

Not enabled
Configuring instrument
Schedule enabled
Paused

Logging in progress
Logging, memory full
Stopped, schedule complete
Stopped, memory full

Stopped, user request
Failed

Battery failed

RBR#0006105revL

Description

A deployment has not been enabled.

Ruskin is writing the deployment configuration to the instrument.

A deployment has been enabled, but the start time has not yet been reached.
A deployment has been enabled, but a gating condition has not been met.

A deployment has been enabled and the instrument is currently obtaining
samples and recording them to memory.

A deployment has been enabled and the instrument is currently obtaining
samples, but they are not being recorded to memory as there is no available
space. Data continues to be transmitted over the chosen realtime link.

A deployment has reached the end time and so has been stopped.

The memory has been completely filled with samples and so logging has been
stopped.

An enabled deployment has been stoped by user intervention.
An internal error has occurred during a deployment.

An internal error with regarding the batteries has occurred.
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Clock

The instrument clock may drift up to 60s per year. Hover your mouse over the time value to display the offset.

Configuration \"\\Information | Calibration Parameters

Schedule Samp

Status: Not enabled Mod
Spesg

Clock: 2023-01-23 14:22:26-04:00 uTC Local R

Startt  2022-04-18 v , Logger time lags computer time by 7.860s

End: 2022-06-01

Synchronise the instrument clock before each deployment. Select UTC or Local time, depending on your preferences.

Start

A The Start date and time are only editable If the Gating condition is set to None. Otherwise, it is the Gating
condition selection that will control the start of logging. See Gating for details.

Specify the Start date using the dropdown calendar, and the Start time using the up and down arrows. Alternatively,
check Now to start logging as soon as the Enable button is clicked.

@ Tomanually edit the originally set date and time values, select and then clear the Now checkbox.

End

The End date is calculated by Ruskin autonomy engine and indicates when your deployment is likely to stop. This is
based on sampling schedule, mode, and power selections . Ruskin autonomy engine provides feedback on which
parameter (power or memory) will be exhausted first.

End:  2019-09-23 [

The parameter in the green bar is the true deployment estimate. In the example shown, your deployment will last 115
days, until the battery is exhausted.

& Deployment estimates on Ruskin assume new batteries. Your real deployment times may be shorter if the
batteries are not fully charged.

The parameter in the orange bar indicates how much longer the deployment could last if the preceding parameter
were not a factor. In the example shown, if your instrument were still powered after 115 days, it could continue logging
for 496 days more, until the memory becomes full.
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@ fthe End logging date is power dependent and you know that the instrument will be operating under very
cold conditions, you may want to lower the demands on the battery by lengthening your sampling period or
opting for different battery chemistry.

Ruskin autonomy engine

Ruskin autonomy engine relies on several parameters to estimate the deployment end date: sampling rate, power
options, and memory. One of the key factors is battery life.

Battery life prediction is a complicated issue. In RBR instruments, it is a strong function of the type of instrument, type
and number of sensors attached, sampling mode (sampling rate, gating conditions, realtime data collection), and water
temperature during the deployment. Manufacturer's data for the batteries may not reflect the way batteries are used in
RBR instruments, and thus, are not always informative.

Autonomy figures depend on the power draw of the instrument, as well as the derated capacity of the battery pack.
Batteries are derated to 4°C. These values differ for different battery chemistries. For the most accurate deployment
estimates, select the same batteries from the dropdown menu as installed in your instrument.

Ruskin calculates the expected battery usage for the instrument during setup . The nominal capacity of each type of
battery is described in the Power section and is given in mAh at room temperature. Battery voltage does not decrease
linearly and is therefore not an accurate indicator of battery capacity.

RBR tested batteries of various brands at 6°C; all of them were able to provide the threshold capacity defined in the
Power section. View these predictions and further de-rate the batteries if the expected deployment is in cold water.

The software will warn you if the expected battery usage for a particular deployment scenario is approaching the
theoretical potential mAh.

@ Warning

There is insufficient power for the deployment.

Would you like to proceed?

The software will not prevent your instrument from being started even if a warning is given. However, adjusting
deployment parameters or replacing the batteries may help extend deployment times.

8.3 Power

The Power section includes internal and external power options, as well as information on sampling power. Ruskin
autonomy engine uses these parameters to estimate deployment life.

Power
Battery:  Lithium thionyl chloride & Eresh
External:  Other { unknown a

Extended battery end-cap
b Sample power details
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Battery

The Battery dropdown menu shows available chemistry options for internal batteries. The list depends on your
instrument.

RBR ships all new instruments with batteries of the highest capacity for the instrument type already installed.

© Mixing batteries of different chemistries, brands, and age will reduce performance and potentially damage the
instrument. Improperly matched batteries may become overheated, leak, or even explode.

AA-type batteries

Most RBR instruments use AA-type batteries, the only exception being the RBquartz® Q | plus, which uses D.

& Lithium thionyl chloride batteries are only recommended for T, D, T.D, C.T, C.T.D, and RBunartz3 instruments.
Any additional sensors will not work correctly on this type of battery.

Typically, RBR instruments are shipped with EVE ER14505 lithium thionyl chloride or Energizer L91AA lithium iron.
Select your battery chemistry from the dropdown list.

Power
Battery:
Externals Lithium iron |
Alkaline
Li-ion
b Sampl i
MNitMH
Name Chemistry Voltage (V) mAh*
Lithium thionyl chloride Li-SOCl, 3.6 2700
Lithium iron Li-FeS, 1.5 3500
Alkaline Zn-MnO, 1.5 2500
Li-ion Li-NiMnCo 3.6 750
Nickel metal hydride Ni-MH 1.2 2400

*The nominal capacity of each type of battery is given at room temperature.
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D-type batteries

The RBquartz® Q | plus uses D-type batteries and is typically shipped with Tadiran TL-4930 lithium thionyl chloride.
Select your battery chemistry from the dropdown list.

Power
None
Battery: ¥4 Lﬁh_luﬂ thionyl chloride I
External; Alkaline |
NinH
Name Chemistry Voltage (V) mAh*
Lithium thionyl chloride Li-SOCL , 3.6 18400
Alkaline Zn-MnO, 1.5 16000
Nickel metal hydride Ni-MH 1.2 10000

*The nominal capacity of each type of battery is given at room temperature.

Deployment estimates

Ruskin estimates autonomy figures based on the power draw of the instrument, as well as the derated capacity of the
batteries. Batteries are derated to 4°C . These values differ for different chemistries (see above). For the most accurate
deployment estimates, select the same batteries from the dropdown menu as installed in your instrument.
Alternatively, use Ruskin to simulate your instrument with different batteries and find which chemistry works best for
your deployment.

& Battery cells of the same chemistry but from different manufacturers may have different performance. If the
nominal capacity of the battery model you are using is lower than outlined above, your actual deployment
may be shorter than the estimate.

@ Replace batteries before each deployment to maximise the operational time and prevent data loss.

Select the Fresh checkbox when installing fresh batteries in your instrument for the next deployment. When checked,
Ruskin autonomy engine will reset usage statistics and adjust deployment estimates accordingly.

External

The External dropdown menu shows external power supply options. These include RBRfermata and RBRfermette’
underwater battery canisters with various battery chemistries available. RBRfermata uses D-type batteries, and

RBRfermette® uses AA cells. See above for battery chemistries available. Ruskin autonomy engine will estimate
deployment life based on your selections.
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Power

None |
Aotteon Other [ unknown
SRCE ./ Fermata - Lithium thionyl chloride

Fermata - Alkaline

b Sampl Fermata - NiMH
Fermette® - Lithium thionyl chloride

| Memoryu  Fermette® - Lithium iron

Fermette® - Alkaline

Fermette® - Li-ion facttings

Fermette® - NiMH

Select the Fresh checkbox when using a new battery canister or after replacing batteries in your RBRfermata and

RBRfermette® before the next deployment. When checked, Ruskin autonomy engine will reset usage statistics and
adjust deployment estimates accordingly.

Select the Extended battery end-cap checkbox only if your instrument has a connectorised end-cap. In this case,
Ruskin autonomy engine will account for the power supplied via the end-cap when estimating deployment
life. Otherwise, leave the box unchecked.

Sample power details

Click on the arrow to open the information drawer with sample power details, such as energy per sample, sample
duration (if applicable), and sleep power.

* Sample power details

Energy per sample: 10 mJ
Sample duration: 260 ms
Sleep power: 86 pw

8.4 Sampling

The Sampling section includes three fields: Mode, Speed, and Rate, as well as several optional fields available with
certain sampling modes.

Sampling

Mode:  Continuous e
Speed: Rate  2Hz
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Mode

Depending on your instrument, different dropdown options may be available. See Average, Burst, Directional, Tide,
and Wave for information on how to configure these modes.

® The RBRquartz’ BPR | zero can only operate in Continuous sampling mode.

RBRconcerto® C.T.D: RBRquartz> Q: RBRquartz’ BPR | zero:
Sampling Sampling Sampling
s IR e ]
Speed  Average & Speed  Average Speed: v Rate  8Hz °
Burst
Tide
Wave

Speed and Rate
These are the only two parameters you need to configure Continuous sampling mode.

Check Speed to select the sampling Rate in Hz from the dropdown menu. The default option is always the highest
instrument rating; for example, | fast16 will default to 16Hz.

THz
il 2Hz b
4Hz
Mode: Continw 8Hz

Speed: Rate | B¥al: aFd |

Sampling

All profiling instruments (known as | fast) can sample faster than 2Hz and support Average and Burst modes.
All | tide and | wave instruments can average at rates of 2, 4, 8, or 16Hz.

Uncheck Speed to enter the sampling Rate manually in hours, minutes, and seconds (HH:mm:ss format). The fastest
rate to enter manually is 1s. Type the numbers in, or use the up and down arrows.

Sampling

Mode: Continuous &
Speed: Rate | 00:00:02 |2
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8.4.1 Average

When set to Average, the instrument will collect data at a certain rate, and then average those samples to produce a
single value to store on the instrument. This sampling mode allows you to save memory during long deployments.

In addition to Speed and Rate, there are two more parameters required for Average mode: Duration and Interval.

Duration specifies the time range over which to average. It must always be longer than Speed.

Interval is the repetition period for performing the averaging. It must always be longer than Duration.

There are two versions of sampling controls for Average sampling mode: simple and advanced. Make your selections in

Preferences > General.

Simple sampling controls

When using the simple version, select Speed, Duration, and Interval from
pre-defined options in three dropdown menus.

In the example shown, the sampling rate selected is 2Hz (two samples per
second). The instrument will be logging for a duration of five seconds, then
pause and average the ten samples collected. After an interval of five
minutes, it will start logging again, repeating the same cycle.

Advanced sampling controls

When using the advanced version, select two or all three parameters
manually.

In the example shown, the sampling rate selected is 2Hz (two samples per
second). The instrument will be logging for a duration of one minute, then
pause and average the 120 samples collected. After an interval of five
minutes, it will start logging again, repeating the same cycle.

In the second example, the sampling rate selected is 1s (1Hz, or one sample
per second). Duration and Interval are the same in both examples.

Sampling
Mode:  Average (=]
Speed: 2Hz [

Duration: 00:00:05 (@

Interval: | §
00:10:00

00:20:00

00:30:00

01:00:00

02:00:00
Latiig 06:00:00
Koda® 24:00:00 [
Sampling
Mode: Average Q
Speed: @) Rate 2Hz &)
Duration: | 00:01:00 | o
Interval:  00:05:00 o
Sampling
Mode: Average &
Speed: Rate 00:00:01 o

Duration: 00:01:00

<> 4D

Interval:  00:05:00

() Atevery Interval, the instrument records only one sample, averaged over all samples collected during the
period of Duration. The rest of the samples are discarded after averaging is performed.
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8.4.2 Burst

When set to Burst, the instrument will collect a specified number of samples at a specified rate, and repeat this

operation at a specified interval.

(@ Onlyinstruments with the | fast sampling feature (| fast8, | fast16, or | fast32) support Burst sampling mode.

In addition to Speed and Rate, there are two more parameters required for Burst mode: Duration and Interval.

Duration specifies the number of samples to record.

Interval is the repetition period for performing the burst. The countdown begins at the same moment the burst starts
and, therefore, Interval must always be longer than the time it takes to obtain the number of samples indicated in

Duration.

There are two versions of sampling controls for Burst sampling mode: simple and advanced. Make your selections in

Preferences > General.

Simple sampling controls

When using the simple version, select Speed, Duration, and Interval from
pre-defined options in three dropdown menus.

In the example shown, the sampling rate selected is 2Hz (two samples per
second). The instrument will be logging for a duration of 512 samples (256
seconds), then pause for 44 seconds (that is, until the countdown reaches
300s or five minutes). After an interval of five minutes, a new burst of 512
samples will occur, the instrument repeating the same cycle.

Advanced sampling controls

When using the advanced version, select two or all three parameters
manually.

In the example shown, the sampling rate selected is 32Hz (32 samples per
second). The instrument will be logging for a duration of 512 samples (16
seconds), then pause. After an interval of ten minutes (minus 16 seconds), a

new burst of 512 samples will occur, the instrument repeating the same cycle.

In the second example, the sampling rate selected is 1s (1Hz, or one sample
per second). Duration is 60 samples, and Interval s five min, which means
the instrument will be logging for one minute until pausing for four.

RBR#0006105revL

Sampling

Mode: Burst ]

Speed: 2Hz a

Duration: 512 (2]

Interval:  « 00:05:00 |
00:10:00
00:20:00
00:30:00
01:00:00

Gating 02:00:00
06:00:00

Mode:
24:00:00 a

Sampling

Mode: Burst [C]

Speed: Rate 32Hz

Duration: 512 o

Interval: | 00:10:00 | =

Sampling

Mode: Burst <
Speed: Rate 00:00:01
Duration: 60 2

Interval:  00:05:00 o

e
w
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8.4.3 Directional

When set to Directional, the instrument will collect data at specified rates depending on the direction it is travelling.
This sampling mode is intended for use when the instrument is integrated into a moving platform.

() Onlyinstruments with the |fast sampling feature (| fast8, | fast16, or | fast32) support Directional mode.

There are several parameters required to set up Directional mode: Threshold, Fast sampling direction, Fast sampling
speed, and Slow sampling speed.

Threshold is the distance from the previous minimum or maximum (in dbar) at which the instrument will switch to the
opposite sampling speed. This value should be greater than zero. The minimum precision is 0.1dBar.

To optimise deployment life without compromising data in the preferred direction, it is recommended to set the
Threshold value to 5-10% of expected profile distance.
Fast sampling direction indicates which direction the instrument should sample at the fast rate.

> Ascending indicates that the instrument should sample at the Fast sampling speed during ascents
> Descending indicates that the instrument should sample at the Fast sampling speed during descents

Sampling

Mode: Directional =
Threshold (dbar): | 10/0

Fast sampling direction; EVSLET: |
Fast sampling speed: Descending 5
-~

Slow sampling speed: Rate 00:00:05

Fast sampling speed has the same meaning as Speed in Continuous mode, but applies only when the instrument
detects that it is moving in the preferred direction.
This must be faster than the provided Slow sampling speed parameter.

Slow sampling speed has the same meaning as Speed in Continuous mode, but applies only when the instrument
detects that it is not moving in the preferred direction.
This must be slower than the provided Fast sampling speed parameter.

Sampling
Mode:  Directional Z

Threshold (dbar): 10.0

Fast sampling direction:  Ascending -
Fast sampling speed: Rate 00:00:01 :
Slow sampling speed: Rate 00:00:05 o

Refer to the graph below for different scenarios of directional logging. In this example, the Fast sampling direction is
set to Ascending.
First profile

The instrument must record one complete profile to obtain the first minimum and maximum, which will serve as initial
points for the threshold. Due to this requirement, it will sample the entire first profile using the Fast sampling speed
(black dots). Once this has been completed, it will perform the desired sampling functionality.
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Time »

First profile

<« Absolute pressure

Downcast 1

The instrument passes over its first maximum and reaches the threshold value. At this point, it switches to slow
sampling (red dots).

& Thefirst slow sample is recorded at the fast speed because it had already been scheduled by the time the
instrument detected the threshold. The same will apply when the instrument switches back to the fast speed.

Slow sampling then continues until the threshold value (with respect to the first minimum) is detected. The instrument
switches to slow sampling and soon begins to ascend.

Downcast 2

The instrument passes over its second maximum and reaches the threshold value. It again switches to slow sampling
(red dots).

Slow sampling then continues until the threshold value (with respect to the second minimum) is detected. The
instrument switches to slow sampling, but this downcast turns out to be longer than the previous one and it descends
much deeper before starting the next ascent.

Downcast 3

The instrument passes over its second maximum and reaches the threshold value. It again switches to slow sampling
(red dots).

Slow sampling then continues, but this time, the previous minimum was deeper, and the instrument the instrument
begins to ascend before reaching the threshold value and thus, still sampling at the slow speed.

However, the instrument detects an upcast from pressure readings when the pressure drop of 3dbar is recorded. At this
point, it switches to the fast sampling mode.

Downcast 4

The instrument passes over its third maximum and reaches the threshold value. It again switches to slow sampling (red
dots).

Slow sampling continues until the minimum threshold estimated from the detected upcast value is reached.
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8.4.4 Tide

Tide sampling mode is similar to Average, as the instrument will also collect data at a certain rate, and then average
those samples to produce a single value to store on the instrument. However, when set to Tide, the instrument uses
averaging to remove wave noise data from pressure measurements.

() Bothinstruments with the | tide16 and | wavel6 features support Tide sampling mode.
In addition to Speed and Rate, there are two more parameters required for Tide mode: Duration and Interval.
Duration specifies the time range over which to average. It must always be longer than Speed .

Interval is the repetition period for performing the averaging. It must always be longer than Duration .

There are two versions of sampling controls for Tide sampling mode: simple and advanced. Make your selections in
Preferences > General.

Simple sampling controls Sampling

When using the simple version, select Speed, Duration, and Interval Mode: = Tide 2]

from pre-defined options in three dropdown menus.
Speed: 16Hz &

Duration: 00:00:01 &
In the example shown, the sampling rate selected is 16Hz (16 samples

per second). The instrument will be logging for a duration of one second, Interval:

then pause and average the sixteen samples collected. After an interval

of five minutes, it will start logging again, repeating the same cycle. 00:20:00
00:30:00
01:00:00
02:00:00
06:00:00
24:00:00

Advanced sampling controls Sampling

When using the advanced version, select two or all three parameters Mode: Tide B

manually. Speed: @) Rate 16Hz @

Duration: 00:00:01
All parameters are the same as in the previous example.

> (£

Interval: | 00:05:00

() Atevery Interval, the instrument records only one sample, averaged over all samples collected during the
period of Duration. The rest of the samples are discarded after averaging is performed.
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8.4.5 Wave

Wave sampling mode is similar to Burst, as the instrument will also collect a specified number of samples at a specified
rate, and repeat this operation at a specified interval. When in Wave mode, the instrument takes multiple pressure
readings in a burst and reconstructs the surface wave time series. This mode records both tide and wave information.

() Onlyinstruments with the | wavel6 feature support Wave sampling mode.

Speed or Rate are parameters defining individual pressure readings.

+ The highest possible frequency visible in the data is limited to 2 the sampling rate. However, this mathematical
limit cannot be achieved because of wave attenuation, and real data are actually lower.

» The sampling rate defines the resolution of the frequency spectrum which can be calculated from the wave
data.

» The sampling rate, together with the burst duration, defines the lowest frequency which can be assessed in a
wave burst.

In addition to Speed and Rate, there are two more parameters required for Wave mode: Duration and Interval.
Duration specifies the number of samples to record.

Interval is the repetition period for performing the burst. It must always be longer than the time it takes to obtain
the number of samples indicated in Duration.

& Consider unique aspects of deployment environment when setting up Wave sampling mode.
For example, while a 30-minute interval tends to work in most cases, shorter intervals may suit better when
encountering ocean swells which have longer wavelengths than noise but shorter than tide.

Furthermore, you may enter Instrument altitude and Mean depth of water to estimate possible wave periods for your
deployment. These parameters are not mandatory for the instrument to work, but allow you to get an idea of what to
expect.

Instrument altitude is the actual height of the instrument in metres above the seabed. This is defined by
deployment requirements, and the instrument must be physically affixed at this height during the installation.

° This parameter is stored on the instrument and used to compute wave statistics for pre-deployment
analysis.

Mean depth of water is an estimate of the average water depth in metres, used for the initial prediction of wave
frequency. It must always be greater than Instrument altitude.

o This parameter is not stored in the logger and only used to compute wave statistics. It is adjusted post-
deployment through the RSK file.

° Ruskin will calculate the actual mean depth of water from the instrument altitude and its depth
measured during the deployment.
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There are two versions of sampling controls for Wave sampling mode: simple and advanced. Make your selections in
Preferences > General.

Simple sampling controls

When using the simple version, select Speed, Duration, and Interval from pre-defined options in three dropdown

menus.

A common configuration is 4Hz sampling for 4096 samples every 30 minutes.

Sampling

Mode:

Duration:

Interval:

16Hz
8Hz

2Hz

00:00:01
00:00:02
00:00:05
00:00:10
00:00:30
00:01:00
00:10:00
00:30:00
01:00:00

Sampling

Mode: ! Rita

Speed. ‘ . E
SDEEH I

I Duration E¥a:{al=:1 |

8192
16384
32768

| Interval;

Sampling
Mode: Wave
Speed: 00:05:00 |
. 00:10:00
Duration: 00:20:00
WS 00:30:00 |
01:00:00
02:00:00
06:00:00
24:00:00

Enter Instrument altitude and Mean depth of water manually. Estimates for wave statistics will be immediately
displayed: maximum wave frequency and minimum wave period (essentially, they reflect the same concept because
period = 1/frequency). These values can be adjusted post-deployment through the RSK file.
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Sampling

Mode: Wave

Speed: 4Hz

Duration: 4096

ool

Interval: 00:30:00

Minimum wave period 4.44 secs

1.0 Instrument altitude (m)
| ‘Ihﬂ | Mean depth of water (m)

Maximum wave frequency 0.2252 Hz
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Advanced sampling controls
When using the advanced version, enter all or some parameters manually.

This option allows more flexibility with your values. For example, with a rate of 4Hz and a duration of 4096 samples, the
instrument will be sampling 17 minutes 4 seconds. You can set up near continuous sampling by setting the interval to
17:05. Logging will be on every second except the one remaining second of the interval, and then start again.

Sampling

<»

Mode: Wave

<>

Speed: v Rate 4Hz 0.5 Instrument altitude (m)

10.0 Mean depth of water (m)

<>

Duration: 4096

~ Maximum wave frequency 0.2183 Hz
Interval:  00:17:06 «
Minimum wave period 4.58 secs

@ Thetimestamp of the burst for both Tide and Wave datasets is the beginning of the burst.

Deployment depth of | wavel6 instruments

@ Thebasicruleis to place the instrument as close to the surface as possible without it emerging from the water
due to large waves or low tides.

Attach your | wavel6 instrument to a suitable support below the surface of the water, such as a dock or other rigid
mooring, to completely immobilise it.

Enter the expected mean depth of water and the known instrument altitude (height above the seabed). From these
values, Ruskin will estimate wave frequencies and wave periods that your instrument could measure (period =1/
frequency). On data retrieval, Ruskin will calculate the actual mean depth of water from the instrument altitude entered
and its depth measured using the pressure transducer, and then use this actual depth for computing all wave statistics
during deployment.

The physics of what a pressure transducer can measure depends on the height of water above as well as the depth of
water below it. High frequencies attenuate very quickly with depth. The depth of the deployment is critical in
determining frequencies/periods of the wave data the instrument will be able to capture. It is the depth, not orientation
of the pressure transducer that affects these measurements.
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Instrument fixed to a dock below the water surface

Depth (m)
0 5 10 15 20 25 30 35 40

1.000
= 0.100 — 30 sec
'E 20 sec
= —10 sec
g —hsec
ﬁ —2.5sec

0.010 —1sec

0.00M

Wave attenuation as a function of depth for various wave periods

8.5 Gating

The Gating section allows you to enable your deployment using a method other than time-based. From the dropdown
menu, select Twist activation to start your deployment by twisting the end-cap or Marine wet switch to enable the
instrument based on contact with water. Otherwise, set it to None to use the specific Start time from the Schedule

section.

Gating N
one

Mode: E¥E U EETHTE]] |

Marine wet switch
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& The Marine wet switch option is only available for instruments with a conductivity sensor.

Twist activation

When you select Twist activation, the instrument starts to sample based on the twist on/off position of its end-cap
rather than a schedule.

To start sampling, first click Enable. This button is at the bottom of the Configuration tab.

| Memory used: <1% | | Download...

Enable Revert settings Use auto-deploy settings

The button will then become a Stop button. The status will become "Logging paused".

Cunﬂguratiur; : -___Infunnatinn. Calihratinn' Parameters |

Schedule
Status: Logging paused

Clock: 2022-05-17 15:00:26-04:00
Start: Mot available with twist activation
Power

Battery:

External:

b Sample power details

| Memory used: <1% Download...

Stop
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Turn the battery end-cap to the RUN position.
The instrument will vibrate with one long pulse and start
sampling.

To pause it, turn the battery end-cap to the PAUSE
position. The instrument will vibrate with three short
pulses to indicate it has stopped logging.

& Twisting the end-cap to the RUN or PAUSE position will activate the Wi-Fi. However, twisting to PAUSE will
also pause the instrument. Twisting to RUN will resume sampling.

Marine wet switch

When you select Marine wet switch, the instrument starts to sample as soon as it enters the water. This method is
based on the conductivity sensor measurement.
To start sampling, first click Enable. The status will become "Logging paused". After that, the instrument will be

checking the value on the conductivity sensor every 15 seconds. If it exceeds 1mS/cm?, the instrument will start logging
and continue so until the conductivity values decrease below this threshold. Ruskin always updates with the correct
state.

& Thethreshold value for Marine wet switch may not be suitable for freshwater applications as many
freshwater sources would not exceed 1mS/cm?.
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8.6 Options

The Options section offers additional settings for deploying your instrument.

Options
Realtime:  None a Format: Standard resolution ﬁ
Serial: 115200 [ Mode:  RS232

Storage:  Desktop a Wi-Fi: off a

Realtime

Specify your external streaming connection. Select one of the three options:

+ None to disable streaming to any external connection
« Serial to fetch or stream your data over an external underwater connection (RS-232 or RS-485).
« USB to fetch or stream your data over an external USB connection

Options
None
Serial: Sl

Storage: ~ Desktop

If you select None, you disable steaming and enable fetching, provided you are still connected to the instrument via

your internal USB port. Click the Fetch button UF in the Plot view toolbar. The samples fetched from the instrument
will be displayed on a live plot at the default speed of about one second. This collection rate is independent of the
sampling speed configured in the instrument.

If you set Realtime to Serial, proceed to the Mode dropdown menu (see below) and select RS-232 or RS-485.

If you are interfacing to an external system that requires a control signal input, such as a modem with a DTR input,
configure the parameters for the auxiliary output control signal from the instrument.

Serial

Select the baudrate of the external serial connection. Factory baudrate is 9600.

Options
Realtime:  Serial &
Serial: v 115200 |
- 19200 '
t 2
orage 9600
4800
2400
1200
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Storage

Select your deployment mode, which will determine the RSK file format. By default, new deployments started from a
laptop or desktop computer are set to the Desktop storage format. However, if you enable Wi-Fi on your instrument or
start your deployment from your mobile device, this option defaults to the Mobile storage format.

Storage: | VAL (o] ] |

Mobile

Format

Select the output format for the realtime data from five dropdown options.

Mode

Standard resolution

All values are shown to four decimal places, with no units displayed.

Standard resolution (units)

All values are shown to four decimal places, with units displayed (after the number, separated by a space).
Highest resolution (RBRquartz)

All values are shown with enough significant digits ensuring no loss of resolution.

Engineering

All values are shown in engineering notation (same as scientific notation, but the exponent must be a multiple of
three), with enough significant digits ensuring no loss of resolution.

Standard resolution (checksum)

All values are shown to four decimal places, with no units displayed. The output has the leading characters
"RBR" and the serial number of the instrument, and a checksum (CRC) at the end, which can be used to validate
that the transmission was successful.

[Hntidl v Standard resolution |

Mode: Standard resolution (units)
ode:

Highest resolution (RBRquartz)
Wi-Fi: Engineering

Standard resolution (checksum)

Select from available external serial connections communication protocols: RS-232, RS-485 FD, UART - (OEM), and
UART Idle low (OEM).

a

Mode: [ATPED) |

RS485 FD
UART - (OEM)
UART - Idle low (OEM)

Wi-Fi:

UART - (OEM), and UART Idle low (OEM) are for OEM customers only. Contact RBR if you have any questions.
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Wi-Fi

Select "on" to allow your instrument to use the Wi-Fi module.

off

& This selection will not turn the Wi-Fi on or off. It is the instrument that controls the state of Wi-Fi.

8.7 Voltage sensors

The Voltage sensors section includes three fields: Channel, Latency, and Current. Ruskin uses these parameters to
estimate deployment time (battery use) and to determine minimal sampling intervals.

The Channel field displays the sensor index on the instrument, for example, 4. If there is more than one voltage sensor,
select them from the dropdown list.

Use up and down arrows to change Latency. It specifies the wait time it takes the sensor to settle after powering up
before it can take a reading. The units of measurement are milliseconds. Use up and down arrows to change this
parameter.

Enter the Current value manually in the field provided. This is the sampling current required for the sensor to operate
at a voltage of 12V. The units of measurement are milliamperes.

Voltage sensors

L

Channel: 4

{3

Latency (ms): 300

Current (mA @12v): 0.0

& You must enter these parameters for sensors not supplied by RBR.
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8.8 Ranging sensors
The Ranging sensors section has two dropdown menus, Sensor and Range.
The former displays the name and index of the channel, and the latter specifies the gain level used for the deployment.

This parameter can be set to an auto-ranging setting or to a fixed gain setting. The fixed gain setting is specified by
selecting one of the ranges specified.

Ranging sensors

ULl o Chlorophyll (4) |

CDOM (5) |
Backscatter (8)
Turbidity (7)

Range:

The former displays the name and index of the channel. Possible ranging sensors may be turbidity and fluorescence
(chlorophyll or chlorophyll a, cDOM, backscatter).

The latter specifies the gain level used for the deployment. The units of measurement are NTU (Nephelometric Turbidity
Units) for turbidity sensors, pg/l for chlorophyll, and counts for cDOM and backscatter.

Ranging sensors Ranging sensors
Sensor:  Turbidity (5) 1) Sensor: Chlorophylia (4) [
2500 NTU 500 pgfl
500 NTU 50 ugfl
125 NTU 5 pafl
25 NTU

Set Range to Auto to enable the auto-ranging setting. Your instrument will change the gain setting on the front-end
amplifiers to the range most appropriate for its environment. To display the range change events, select Diagnostic

&T

from the dropdown under the Events button in the Plot window toolbar.

Range change events are displayed as "RANGE XX Units" where XX indicates the current range and units are the units of
measurement, for example: RANGE 500 NTU. For | fast sampling, where the change may be occurring over a number of
samples, the label will read, "RANGE CHG", followed by the final range change event.

Alternatively, select a fixed gain setting to maintain the same setting throughout your deployment.
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8.9 Valve control
The Valve control section supports the RBRquartz> BPR | zero, which is the only RBR instrument with a switching valve.
Properly setting the valve parameters improves deployment times.

The Status field displays the current valve position: marine or atmospheric. Toggle manually between these option
using the Set position radio buttons.

Valve control Valve control Valve control
Status: In atmospheric position Status: Moving to atmospheric position Status: In marine position
Set position: @ atmospheric marine Set position: Set position: atmospheric '® marine
Schedule movement Schedule movement Schedule movement
Type: Type: Type:
Duration (HH:mm): Duration (HH:mm): Duration (HH:mm):
Interval (DD HH:mm): Interval (DD HH:mm): Interval (DD HH:mm):

Select the Schedule movement checkbox to set the move to the atmospheric position for the deployment. Toggle the
movement Type between Uniform and Segmented.

Uniform movement will activate controls for: Valve control

« Duration, the time to spend in the atmospheric
position

+ Interval the time between valve movements to
the atmospheric position

« Skip first atmospheric duration option Type: © Uniform ' Segmented

Skip first atmospheric duration

Status: In marine position
Set position: atmospheric € marine
Schedule movement (00 00:01:00)

Duration (HH:mm): 00:01

~
w

Interval (DD HH:mm): 0 2 01:00 &
Segmented movement will activate controls for: Valve control
« Segment, with entry fields for Selection and Status:  In marine position
Count o . .
Set position: atmospheric € marine

+ Delay, the time to hold off before moving the the
atmospheric position
+ Duration, the time to spend in the atmospheric Type:  Uniform © Segmented

Schedule movement (00 00:01:00)

position Segment: Selection: 1 o Count: 1 o
« Interval, the time between valve movements to

. L Delay (DD HH:mm): 0 Z o000 D
the atmospheric position 4 !

w

Duration (HH:mm):  00:01 o

~

Interval (DD HH:mm): 0O 2 onoo o

& An external power source, such as RBRfermata or RBRfermette®, is required for valve operation.
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8.10 Download

The Download... button is located next to the Memory used bar, at the bottom of the Configuration tab.

|. Memory used: <=1% | | Download...

Enable Revert settings Use auto-deploy settings

You can download data from your instrument at any time. However, it is especially important to do so when you stop a
schedule. All the data on the instrument will be erased as soon as you enable a new deployment.

Steps

1. Click the Download... button.
A dialog box will appear.

209681_20220531_1106.rsk

here: [ Downloads B8 -

Ruskin RSK (*.rsk) &

2. Enter a name for the data file in the Save As field, or accept the default name.
By default, the RSK file name uses the Ruskin file naming convention (see RSK files).
3. Select the download location from the Where dropdown menu, or accept the default location.

& RBRrecommends storing your data on a local drive rather than a network storage drive. Cloud storage
options such as GoogleDrive and Dropbox may extend download times.
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4. The new dataset will appear automatically in Navigator window under Datasets.

4=F Mavigator - d
i i Instruments

O RBRconcerto? 209681

O simRBRconcerto® 905195

O simRBRquartz? 907084

OsimRBRconcerto® 909471
OsimRBRconcerto? 907504
O simRBRmaestro® 901261
i MLM
£ Datasets

|zip 209681...1106

The Properties view will change to the new dataset, with the following tabs: Analysis, Overview, Channels, and
File info.

Tl 209681_20220531_1106.rsk &3

Analysis . Overview | Channels | File info |

Sample 1
Time 2022-05-17 15:39:27.000-04:00

Display statistics

Mumber of samples

Channel Value Unit
Conductivity -0.0009467 mS/cm
Temperature 22.3548785 o e

Pressure 9.9532427  dbar

Sea pressure -0.1792573 dbar
yepth 0.17 ..-_'_: E m

Salinity 0.0112881 PSU

Speed of sound 1489.3725497 mys

Specific conductivity -0.9969474 uS/cm

Nancitv 3

RBR#0006105revL 73



All the data stored on the instrument at the time of the download will be automatically plotted in the Plot
window.

il RBRconcerto® 209681 [ﬁ 203672_20220517_1240.rsk [ﬁ 209681_20220414_1600.rsk 5 209631_20220531_1106.rsk]
= § = GRA- e @ @@ e B-EHo e

= Od

-0.700 149363 1 o 4.000E-3
0.016 9,958
0507 Lasaes 01947 o126 il I
s 9,956
o 149363 —o.17s 23.680 .. 2.000E-3
@ . 9,954 = L
& L493E3 0.014 £ 7} c
E - o "I 905 8 23,670 | LOPOES3 i | ‘
2 LAS3E3 E 0.013 = 12 pasz 3 sy E 0 “ F |
E u = 5 =
3 L4033 {2 = g 5 m.660 {5 | .
2 z s i FCEE 2 1 oooe—3 | HLHHCRI ‘ .—
149363 | E a {8 = = ‘
& £ sonle O DIBETT g g | B 23.65015 |
o1e3 | [} B @ Y -2.0006-3 I
T L493E3(F -0.188 E E
~ 0.010 « & 9944 ﬂzam € _3.00003 |
Y 149363 & -0100 = s
v 9.0006-3 e hed
149363 <noe 0.178 o 23.630]  -4.0006-3
-L150 01821 o
1.493E3 B.ODOE-3 - - -3
ey LRTTY [N 5.000E-3
1.493E3 7.000E-3 0.174 -0.196
19:58:30 19:59:00 19:59:30 20:00:00
Time

5. When you download data again while on the same schedule, the RSK fil.e will pick the same data and append it
with any new data stored since the last download.

O [ ] Append Download

There is an existing RSK with the same deployment:
209681_20220531_1106.rsk

Do you want to append to the existing file?

Nao Yes

6. Go to the Overview tab to add a comment for the download. Enter your message and click Save comment.

Analysis | Overview Channels} File info}

File location

JUsersfichapman/Downloads/209681_20220531_1106.rsk
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Logger Deployment Continuous
Model: RBRconcerto® Time offset: UTC-4:00 Period: 2 Hz
Serial: 209681 Time drift: -1867ms
Firmware: 1.141 Deployment start time:  2022-05-17 15:39:00
Markers First sample time: 2022-05-17 15:39:27
Errors: 0 Last sample time: 2022-05-17 15:39:29 Gate

. First event time: 2022-05-17 15:39:27 Gate: none

Warnings: 1
Information: 2

Diagnostics: t_}

Comment

Download 2

Save comment

Last event time:

Samples:

2022-05-17 15:39:31
6
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8.11 Use auto-deploy settings

When working with a large number of similar instruments, Ruskin offers various automatic tasks, which can be set up
from the Instruments menu on the top toolbar.

This feature may be convenient when you need to deploy several instruments with the same sampling capabilities.
Select an instrument to use as the model and configure it. This will be your model schedule. Verify that these settings
meet your requirements and all values are entered correctly.

@ To confirm which auto-deploy parameters are set on Ruskin, go to Instruments > View auto-deploy
settings... . The Auto-deploy settings box will open, with saved parameters outlined.

When you connect to an instrument with same sampling capabilities as the model instrument, Ruskin will configure it
to match the the model schedule.

If your were connected to an instrument before setting up your model schedule, you can click Use auto-deploy
settings to apply them to that previously connected instrument.

|. Memaory used: =1% | Download...

Enable Revert settings Use auto-deploy settings

Click Revert settings when you wish to return to a previously configured schedule.

A You cannot use Revert settings after clicking Enable. To change a schedule already enabled, stop the
instrument, restore old values manually, and click Enable again.

Enable each instrument individually to start deployments.
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8.12 Enable /Stop

Ensure that your instrument is ready to be deployed before enabling a schedule. See Deploy your instrument.

To allow the instrument to start logging, click Enable. This button is at the bottom left of the Configuration tab.

Memory used: <1% Download...

Enable Revert settings Use auto-deploy settings

The Enable button will now read Stop. The status will become "Logging paused", "Schedule enabled", or "Logging",
depending on the configuration.

, — =
Configuration “E_Hlnfunnatiun] Calihratinn| P‘arameters]

Schedule

Clock: 2022-09-02 14:42:15-04:00
Start:

b

Power
Battery:

External:

b Sample power details

| Memaory used: <1% | Download...

Stop
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Logging will start when one of the following occurs:

» The Now button is checked
+ The Start time arrives
+ The Gating condition for starting is met

If you click Enable, and the instrument memory is not empty, you will see a warning.

&) Warning

The contents of memory will be erased!

Before proceeding, download the data from your instrument (see Download). If you are sure that the information is
saved or not needed, click Erase and enable logging.

A Alleditable fields become greyed out after you enable a schedule.
To change any deployment parameters, stop your instrument, adjust the settings, and start a new
deployment.

To manually stop the instrument, click Stop.

Memory used: <1% Download...

Stop

Logging will stop on its own when one of the following occurs:

+ The End logging time is reached

+ The Gating condition for stopping is met
« The power source is removed or depleted
« The memory is filled

RBR#0006105revL
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9 Information

Use the Information tab to view general information for each of your instruments, such as as model, generation, serial

number, firmware version, power source, and the channels.

Configuration ilnfcfmation--" . Calibration | Parameters |
il Mkl wehiy - | |
Instrument details Channels
Model: RBRconcerto® #  Parameter Units  Sensor Ranging
Generation: Late 2017 2  Temperature °c Marine None
Serial: 904326 3 Pressure dbar RER None
Frmware:  1.744 4  Dissolved O, saturation % nylguard None
: 5 Sea pressure dbar derived None
Link: USB :
(3] Depth m derived None
Power 7 Salinity PSU derived None
8  Specific conductivity uSj/em  derived None
Source: USB 9  Speed of sound mfs derived None
Internal:  12.00V =,
External: 0.00V Most recent RER calibration certificates =~ Download

In the Instrument details section, find the model, generation, and serial number for your instrument, as well as the
firmware version installed and link used.

Refer to the Power section for the power source, power type (internal or external), and voltage.

The voltage value indicated for the internal source indicates the power remaining in your batteries.

Please note that the power drop in lithium batteries is very sharp, so it may not be a good idea to rely on this indicator
to predict battery life. However, it is quite reliable for alkaline batteries.

Under Channels, confirm measured and derived parameters for your instrument.
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10 Calibration

The Calibration tab displays calibration coefficients for each parameter, and the date and time of the last calibration.

Select a sensor from the Parameter dropdown menu to display its calibrations.

Calibratiy

K-facta

Label
co
Lo §
CZ(EK)

CEEWEE o 1: Conductivity

Configuration | Information Calibration

2: Temperature

3: Pressure

4: Sea pressure
5: Depth

6: Salinity

7: Speed of sound
8

: Specific conductivity

Parameters

abel
.0
l
2
i3
x4
X5
X6

Value
304.
-12.
600.

0.
0.
14.
10.

/]

2324200 E=6
7362800 E-6
Q000000 E-9
aoooaoo
aoooaoo
9704920
aoooo00

Check calibration expiry

Request calibration quote

RBR calibration certificates contain calibration equations, coefficients, and residuals for each sensor.

The date of the latest calibration is always displayed. As an extra reminder, you can select the Check calibration expiry
checkmark. A warning sign will appear when your calibration certificate is out of date.

Parameter

Label
co
C1
c2
C3

1: Temperature [

Calibration date: 2022-10-05 14:50:482Z

Value
3.5013640 E-3
-251.9944600 E-6
2.5963480 E-6
-95.8226000 E-9

Configuration | Information | [, Calibration ~ Parameters |

/]

Check calibration expiry

Request calibration quote

RBR recommends calibrating your instrument before any critical deployment, periodically once a year, or if you suspect
the readings to be out of specifications.

Discuss your calibration requirements with RBR. In some cases, the instrument may need to be returned to RBR to have
it checked and re-calibrated.

To contact RBR for our current calibration fees, click Request calibration quote. A Request for quote dialog box will

appear.
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mailto:support@rbr-global.com

@ @ Request for quote

Request for quote

€ All contact details must be specified.

Contact details

MName: Address:

Email address:
Phone:

Organization:

Sensor list: Other information:

Conductivity Enter a longer description here.
Temperature
Pressure

Request preview:
Request for calibration quote: RBRconcerto® 209681

Requested sensor calibrations:
Conductivity

Cancel

Verify that all information is correct and click Submit.

Simple calibration controls

When using the simple version, you will be able to view and edit only the main calibration coefficients, displayed as "C"
values: C0, C1,C2, C3.

RBR#0006105revL

Configuration | Information | Calibration Parameters |

Parameter  3: Pressure 8

Sensor serial number: N122080
Calibration date: 2022-02-03 19:17:572Z

Label Value

co -38.4045200
Cl 2.3795940 E3
cz 27.9242860
C3 -27.382B380

Check calibration expiry

Request calibration quote
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Advanced calibration controls

When advanced calibration controls are enabled in Preferences > General, you will be able to view and edit both main
and dependent coefficients. Dependent coefficients are displayed as "X" values: X0, X1, X2, etc.

Configuration | Information | Calibration Parameters

Parameter  3: Pressure e

Sensor serial number: N122080
Calibration date: 2022-02-03 19:17:672Z

Label Value Label Value

co -36.4045200 X0 10.19%1000

cl 2.3795940 E3 X1 74.3307120 E-3

cz2 27.9242860 X2 25.4226000 E-6

c3 -27.3828380 X3 =-2.1752340 E-6
X4 -71.7971840 E-6
X5 20.1043360

Check calibration expiry Reqguest calibration quote

You can edit the coefficients. As soon as you make a change and move to another cell, a new calibration date will be
displayed. Also, Store calibration and Revert calibration buttons will become active.

Configuration | Information | Calibration Parameters

Parameter  3: Pressure e

Sensor serial number: N122080

Label Value Label Value
X0 10.1991000
cl 2.3795940 E3 X1 74.3307120 E-3
cz2 27.9242860 X2 25.4226000 E-6
c3 -27.3828380 X3 =-2.1752340 E-6
X4 =71.7971840 E-6
X5 20.1043360
Store calibration Revert calibration Check calibration expiry Request calibration quote

Use Store calibration to save the new values.

A Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost
once your session is closed.

Use Revert calibration to recover to the original coefficients if you have not already saved your changes to the
instrument.

& You cannot use Revert calibration after clicking Store calibration. Once the coefficients are saved to the
instrument, you will need to restore old values manually and save them again.
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11 Parameters

The Parameters tab displays all the parameters the RBR instrument may need for calculating derived channels.

If your instrument can measure a parameter, it will use the measured value. Otherwise, you can enter the necessary
values manually, and they will take effect immediately.

For example, you always need atmospheric pressure and water density for derivation of depth. Default values in Ruskin
correspond to sea level and sea water. Therefore, it is especially important to adjust these parameters when working at
high altitudes in fresh water.

Enter atmospheric pressure (in dbar) and water density (in g/cm3) manually in the table under the Parameter tab. If not
entered, default values of 10.1325dbar and 1.0281g/cm3 will be used.

Configuration Information Calibration | Parameters

Temperature (*C) 15.0
Pressure (dbar) 10,1325
Atmospheric pressure (dbar) Q_??D_-:}_
Density {(g/cm?) 1.0000
Specific conductivity coefficient 0.0191

Average sound speed (m/s) 1550.744
Salinity (PSU) 35.0

*Parameters take effect immediately
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12 Preferences

On your Mac, access Preferences from the Ruskin dropdown menu in the top toolbar.

|l

@ Ruskin File Instruments Help
.. About Ruskin

-&? I I IEIH ences... “ N
™ Services »
581
g Hide Ruskin
i Hide Others
Show All

Quit Ruskin

On your Windows PC, use the Options dropdown menu to set up your preferences.

File Instrurments Opticns  Help

& Navigator Preferences... = 8

Factory-set global defaults require no changes in most situations. However, as you learn more about what Ruskin can
do, you may want to change some of these settings to better suit your requirements. The global preferences include:

« Derived channels (applies to some legacy instruments)

« Facility (authorised users only, requires login)

+ General (download locations and options, sampling and calibration controls, export options)
« Plotting (channel visibility and channel colours)

12.1 Derived channels

& The Derived channels settings are intended for XR(X),1060, 2050, and 1050 RBR legacy data loggers. They do
not apply to newer generations. They do not apply to any RBRcoda or RBRcoda® instruments.
Newer generations calculate all possible derived channels for that specific instrument.
Use the Parameters tab in the instrument Properties window to set up initial parameters for calculating
derived channels.
For downloaded files, use the Parameters tab in the dataset Properties window.

The Derived Channels section of the Preferences dialog box has four tabs: Depth, Conductivity - Salinity, Dissolved
02, and No sensor values, where you can choose additional channels derived from measured channels.

Derived channels calculated by the instrument as well as those calculated by Ruskin are automatically added to the
default channel list in both the live Plot view and the static dataset.
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Depth

If your instrument has a pressure channel, you can use its measurements to derive a depth channel. The data calculated
for this derived channel appear along with measured channels in the Plot view and in datasets.

® & Preferences

Derived Channels L]

Derived Channels Enable and configure derived channels

000

Facilityl This feature intended for XR(X),1060, 2050, and 1050 RER data loggers. It does not apply to newer generations.
Genera
Plotting Depth Conductivity - Salinity Dissolved 02 Mo sensor values

Enable Depth Channel
Any logger with a pressure channel
Atmospheric Pressure (dbar) 10.1325
© simplified derivation: depth[m]=(pres-atmos)[dbar]/(density*0.980665)
Density (g/em®) 1.0281
Seawater derivation: UNESCO Tech Paper in Marine Science No. 44

Latitude (degrees) 0.0

Restore Defaults Apply

Cancel Apply and Close

1. Select the Enable Depth Channel checkbox.

& Fornewer generation instruments, all derived channels are calculated regardless of the checkbox
status.

2. Inthe Atmospheric Pressure box, type the value in dbar or use the default value. This value corrects the
pressure measurements during the depth calculation.

& The default Atmospheric Pressure value is 10.1325. Adjust this value manually to represent a different
altitude.

3. Select either the Simplified calculation or Seawater calculation.

& Ruskin can calculate depth based on the simplified calculation or the UNESCO seawater calculation.
The instrument always calculates depth using the simplified calculation.
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a. Touse the simplified calculation, type the actual water density, or use the default value. Note that for
freshwater, the density should be set to 1.0.

b. To use the UNESCO seawater calculation, specify the latitude of the data collection in degrees and
minutes.

Conductivity - Salinity

If your instrument has a conductivity channel, you can use its measurements to derive salinity, density anomaly,
specific conductivity, and speed of sound.

Derived Channels o

000

Derived Channels Enable and configure derived channels

Facilityl This feature intended for XR(X),1060, 2050, and 1050 RER data loggers. It does not apply to newer generations.
Genera
Plotting Depth  Conductivity - Salinity = Dissolved 02 Mo sensor values

Conductivity Correction

Use conductivity correction for derivation

Hydrostatic pressure {dbar) used when no pressure sensor is present 0.0

Any logger centaining a conductivity channel
Density Anomaly
+ Derive density anomaly (kg/m?)
Specific Conductivity
v Derive specific conductivity corrected at 25°C
Salinity
« Derive salinity using a practical salinity scale
Speed of Sound

+ Derive speed of sound

UNESCO e

Restore Defaults Apply

Cancel Apply and Close

1. Select the Use conductivity correction for derivation checkbox.

& Fornewer generation instruments, all derived channels are calculated regardless of the checkbox
status.

2. Inthe Hydrostatic pressure box, type the value in dbar or use the default value.
Select derived channels to include in your calculations.
4. Forthe speed of sound, select between UNESCO, Del Grosso, and Wilson equations.

w
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Dissolved 02

You can derive a dissolved oxygen channel that measures oxygen saturation as a percentage.

Facility
General
Plotting

Preferences
Derived Channels L]

Enable and configure derived channels
This feature intended for XR(X),1060, 2050, and 1050 RER data loggers. It does not apply to newer generations.

Depth  Conductivity - Salinity = Dissolved 02 Mo sensor values
Enable Dissolved Oxygen Channel
Any logger using an Oxyguard DO sensor
Derive concentration using the Weiss equation

Use the following unit = ma/L

Any logger using an Optode DO sensor
Derive concentration using the Weiss equation
Use the following unit = majL B

Derive saturation using the Garcia and Gordon equation (if sensor reports concentration)

Any logger using a Rinko DO sensor
Derive concentration using the Weiss equation

Use the following unit = ma/L &

Restore Defaults Apply

Cancel Apply and Close

000

1. Click the Dissolved O, tab and select the Enable Dissolved Oxygen Channel checkbox.

& Fornewer generation instruments, all derived channels are calculated regardless of the checkbox

status.

2. Ifyour instruments use the Oxyguard DO or RINKO DO sensor, select the Derive concentration using the Weiss
equation checkbox and the output unit: uMol/L, mg/L, or mL/L.

A The Weiss equation requires values for temperature and salinity. If your instrument does not measure

them, you can specify standard values on the No sensor values tab.

3. If yourinstruments use the Aanderaa Optode DO sensor to measure oxygen saturation, select the Derive

concentration using the Weiss equation checkbox and the output unit: mg/L or mL/L.
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4. If any of your instruments use the Aanderaa Optode DO sensor to measure oxygen concentration, select the

Calculate saturation using the Garcia and Gordon equation checkbox.

& The Garcia and Gordon equation requires values for temperature and salinity. If your instrument does
not measure them, you can specify standard values on the No sensor values tab.

No sensor values

Enter salinity, pressure, and temperature values used to calculate the derived channels when a sensor is not available.

Derived Channels

Derived Channels Enable and configure derived channels

Derivations of Dissolved Oxygen and Density

Salinity (PSU) to be used when no conductivity sensor is present

Derivations of Salinity and Conductivity Correction

Hydrostatic pressure (dbar) to be used when no pressure sensor is present

Derivations of Dissolved Oxygen

Temperature (°C) to be used when no temperature sensor is present

35.0

0.0

0.0

Restore Defaults

Cancel

Famlltyl This feature intended for XR(X),1060, 2050, and 1050 RER data loggers. It does not apply to newer generations.
Genera
Plotting Depth Conductivity - Salinity Dissolved 02 No sensor values

Apply

Apply and Close

ooo

A Ifyou suspect that the derived channel value is incorrect, check to make sure that the No sensor values

entries match the deployment environment.

For example, if a dissolved oxygen saturation measurement is made in a lake at 8°C but the No sensor values

salinity is 35 and the temperature is 15°C, concentration reported will be incorrect.

Adjust the No sensor values entries and recompute.
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12.2 General

Use the General preference page to set up file locations, language, download options, sampling and calibration
controls, and export options.

o ] Preferences
General s g

Derived Channels

Facility
File location

Plotting Directory for RSK downloads fUsersfjchapman/Downloads Browse...
Directory for realtime RSK files  Usersfichapman Browse...
Directory for log files [Usersfichapman Browse...

*Takes effect on the next file stored
Language selection

English e {restart required)

Download options

Enable download schedule Ul
Automatically open RSK files produced using the auto download feature

Automatically append new downloads to existing RSK file with matching deployment

Sampling control

Enable advanced sampling controls

Calibration control

Enable advanced calibration controls

Export options

Enable raw data export

Restore Defaults Apply

Cancel Apply and Close

@ Youcan click Apply to save your changes without closing the dialogue box.

File location
You can control where RSK files, realtime RSK file, and log files are stored by default.

Specify these locations before downloading any data by typing in a directory name or by browsing.

File location

Directory for RSK downloads JUsersfichapman/Downloads Browse...
Directory for realtime RSK files  [Usersfjchapman Browse...
Directory for log files [Usersfichapman Browse...
*Takes aeffect on the next file stored
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RSK files are the datasets obtained from your instrument.

Realtime RSK files are generated when a connected instrument is streaming or when you enable fetching mode on the
instrument.

Log files are generated by Ruskin and help when diagnosing issues. These files are automatically attached to issues
generated using the Comment on Ruskin feature.

& RBRrecommends storing your datasets on a local drive rather than a network storage drive. Cloud storage
options such as GoogleDrive and Dropbox may extend download times.

You can change where future files are stored by default at any time. When done, click Apply or Apply and close. The
changes will take effect immediately.

Language selection

Ruskin is available in six languages: English, French, Spanish, Simplified Chinese, Korean, and Japanese.

Language selection

l {restart required)

Frargais
Ezpafiol
e schedule Ui
FH=e) N .
n RSK files produced using the auto download feature
B8

_Jend new downloads to existing RSK file with matching deployment

Select your language from the dropdown menu and click Apply or Apply and close. Ruskin will need to restart for the
changes to take effect.

Download options

Select the appropriate checkboxes to change your download preferences.

Download options
+ Enable download schedule Ul
Automatically open RSK files produced using the auto download feature

~ Automatically append new downloads to existing RSK file with matching deployment

& The Enable download schedule Ul checkbox is only for legacy instruments.

When done, click Apply or Apply and close. The changes will take effectimmediately.
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Sampling control

Select the checkbox to enable advanced controls when setting up your sampling options.

Sampling control

Enable advanced sampling controls

With simple controls, you will select Speed, Duration, and Interval from pre-defined options in three dropdown
menus. When advanced controls are enabled, you will be able to enter these parameters manually and achieve a more
precise setting.

When done, click Apply or Apply and close. The changes will take effectimmediately.

Calibration control

Select the checkbox to enable advanced controls when setting up your calibration options.

Calibration control

Enable advanced calibration controls

With simple controls, you will be able to view and edit only the main coefficients (C). When advanced controls are
enabled, you will be able to view and edit all main and dependent calibration coefficients (C, X) for any channel.

When done, click Apply or Apply and close. The changes will take effect immediately.

Export options

Select the checkbox to enable raw data export. Use this option for downloading your RSK file when storage space is
limited or expensive. The dataset will be exported in the most compact raw binary format.

Export options

Enable raw data export

When done, click Apply or Apply and close. The changes will take effectimmediately.
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12.3 Plotting

Adjust default settings for the graphical display in the Plot view. Manage selections in Channel visibility and Channel

colours, and apply them globally.

@ You can click Apply to save your changes without closing the dialogue box.

Channel visibility

The Channel visibility tab displays many options to hide or show specific information.

Derived Channels
Facility
General

Preferences
Plotting

Manage default plotting behavior

Channel visibility

Channel colours

By default, hide any measured channel underlying a simple derived channel

Use single axis for similar channels
Show dataset events by default
Show dataset errors by default

Automatically save live data to a file (Legacy instruments)

By default, hide all measured channels

Hide conductivity channels
Hide temperature channels
Hide pressure channels
Hide dissolved 02 channels
Hide distance channels
Hide fluorometery channels
Hide pH channels

Hide PAR channels

By default, hide all derived channels

Hide salinity channels

Hide depth channels

Hide pressure channels

Hide specific conductivity channels
Hide speed of sound channels
Hide density anomaly channels

Hide ORP channels
Hide transmittance channels
Hide turbidity channels
Hide voltage channels
Hide RBRguartz® period channels

Hide distance channels

Hide dissolved 02 channels

Hide RBRquartz® pressure channels
Hide RBRquartz® temperature channels

Restore Defaults Apply

Cancel Apply and Close

Opt for displaying errors and events for a more informative graph, or hide them for a cleaner view.

Select the By default, hide all measured channels checkbox to display only derived channels.

Select the By default, hide all derived channels checkbox to display only measured channels.

Otherwise, pick and choose channels to display or hide.
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When done, click Apply or Apply and close. The changes will take effectimmediately.

& You canoverride visibility preferences in the Plot view for any particular graphical display.

Channel colours

The Channel colours tab allows you to choose a different colour for each channel that is shown for information

currently running in Plot view, or from an opened dataset. Select from the list of pre-defined options or create your own

colour.

Derived Channels
Facility

General

Plotting

Preferences
Plotting

Manage default plotting behavior
Channel visibility

CHANNEL_1
CHANNEL_2
CHANNEL_3
CHANNEL_4

CHANNEL_GB
CHANNEL_7
CHANNEL_8

C JNEL_12
CHANNEL_13
CHANNEL_14
CHANNEL_15
CHANNEL_16

Channel colours can be previewed on the active plot.

Channel colours

@ Colors
i - l.!

Restore Defaults

Cancel

Apply

Apply and Close

000

When done, click Apply or Apply and close. The changes will take effectimmediately.
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13 RSKfiles

The RSK file is a single file database based on SQLite that allows us to have large files with high-speed access to any part
of the dataset. RSK files have different types and versions, which reflect historical changes to the underlying dataset
structure. To upgrade the version of an older RSK file, go to File info tab.

RBR provides open-source RSKtools toolboxes for both Matlab (RSKtools) and Python (pyRSKtools) to read, post-
process, visualise, and export RSK files.

RSK files can be exported to Excel, OceanDataView®, or text files.

RSK files contain raw measurement data, firmware and software versions, dates and times, sampling settings, power
settings, measured and derived parameters, errors and events, other diagnostic information.

« Datasets in the Desktop storage format allow changes to calibration coefficients. GPS mapping for full RSK files
relies on manually added location points. This file format is available for RBR standard and compact
instruments.

+ Datasets in the Mobile storage format support charting and GPS tracking. They do not allow changes to
calibration coefficients.

This file format is only available for RBR standard instruments.

« For datasets obtained via streaming or fetching, the RSK format is Realtime. Their names contain the "realtime"
label. This file format is available for RBR standard instruments and RBRcoda® when in streaming mode, and for
all instruments when fetching.

To identify the type of the RSK file, go to the File info tab. Additionally, you can identify a mobile RSK file by the
absence of the Calibration option in the Analysis tab.

File naming convention for datasets obtained during deployments

By default, RSK file names are composed of the following information:

+ Theinstrument serial number: six digits
+ The date of the download (YYYY-MM-DD): eight digits
+ The time of the download (HH-MM in the 24-hour format): four digits

For example, the file named 209681_20220531_1306.rsk contains the dataset for an instrument with a serial number of
209681; the data was downloaded on May 31, 2022 at 13:06 (01:06pm), local time.

The RSK files obtained during a deployment are saved on your instrument. Download them to your computer before
starting a new deployment. Go to Preferences > General to change your default location for RSK downloads.

File naming convention for realtime datasets

By default, realtime dataset names are composed of the following information:

+ Theinstrument serial number: six digits

+ The date of the download (YYYY-MM-DD): eight digits

+ The time of the download (HH-MM in the 24-hour format): four digits

+ The "realtime" label, indicating the data were streamed or fetched from the instrument

For example, the file named 209682_20220531_1408_realtime.rsk contains the dataset for a streaming instrument with
a serial number of 209682; the data were saved on May 31, 2022 at 14:08 (02:08pm), local time.

The data streamed or fetched from your instrument are automatically saved to your computer. Go to Preferences >
General to change your default location for realtime RSK files.

& Thefile extension is .rsk; it indicates the Ruskin file format and must not be edited. If you change it, your new
file extension will become part of the dataset name, and the .rsk extension will be appended.
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14 Realtime data format

Realtime data can either be streamed or fetched from the instrument.

The output can be in a limited number of formats as described below. Each format is listed alongside an example
output for an RBRconcerto® C.T.D:

Output format option  Instrument setting Example data

Standard resolution caltext0l 2018-12-10 13:06:38.000, 0.0005,
22.9536, 10.1149

Standard resolution caltext02 2018-12-10 13:06:38.000, 0.0005 mS/cm,

(units) 22.9536 C, 10.1149 dbar

Highest resolution caltext03 2018-12-10 13:06:38.000, 0.000525642944,

(RBRquartz) 22.939636, 10.1149120

Engineering caltext04 2018-12-10 13:06:38.000,

525.642944e-006, 22.9396360e+000,
10.1149120e+000

Standard resolution caltext07 RBR 209681, 2018-12-10 13:06:38.000,
(checksum) 0.0005, 22.9536, 10.1149, Ox59CB

The output format can be changed in Ruskin from the instrument's Configuration tab. There is a drop down menu item
called format in the Options section.

Options

Realtime: = Mone k3 Format: | Standard resolution [ ]

+ Standard resolution
All values are shown to four decimal places, with no units displayed.
« Standard resolution (units)
All values are shown to four decimal places, with units displayed (after the number, separated by a space).
+ Highest resolution (RBRquartz)
All values are shown with enough significant digits ensuring no loss of resolution.
« Engineering
All values are shown in engineering notation (same as scientific notation, but the exponent must be a multiple of
three), with enough significant digits ensuring no loss of resolution.
« Standard resolution (checksum)
All values are shown to four decimal places, with no units displayed. The output has the leading characters
"RBR" and the serial number of the instrument. After the last data point, there is another filed separator
(command and space), followed by a checksum: two-byte CRC value which can be used to validate that the
transmission was successful.

The values following the timestamp are all the enabled channels.
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15 Datasets

Datasets are RSK files generated by Ruskin and have an .rsk extension. After downloading your datasets, you can view
and analyse your data using the options below.

Go to the File dropdown menu to open or close a dataset, export your data, and see the list of available datasets.

® Ruskin File Instruments Help
B
0@ Open dataset %0
-ﬁ- Navigator . Chainis = b
| E
v g Instrumen Export >
CRBRconcel
i MLM 1: 209681_20220414_1600.rsk
£ Datasets

The Datasets context menu in the Navigator windows duplicates some of these options for convenience.

t-l.?,'r Navigatar.' . =

v i Instruments
RBRconcerto® 209681
men MLM
A 5 Datasets
|zip 203672...1240
|z 209681...1600
|75 209681...1106 Export >

Hacaol

Close dataset

Explore the contents of your datasets in the Properties window.

When a dataset on the list is selected, the Properties window displays four tabs with information related to this
dataset.

Analysis __Cluerviewl Channels] File infn]

Use these tabs to analyse your data, check the calibration certificates, and verify your parameters.
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15.1 Open dataset

Open any stored dataset from the File menu in the top toolbar or from the Datasets menu in the Navigator view.

Steps
1. Click File > Open dataset.

# Ruskin File Instruments Help
}- -
0@ Open dataset %0
E3 Navigatur.\\ll SiEss Oslate, = d
hd i Instrumen Export b
RBRconcel
i MLIM 1: 209681_20220414_1600.rsk
£ Datasets

Alternatively, right-click Datasets in the Navigator view and select Open dataset.

-!ﬁi-Navigatar-' . = H

% i Instruments
RBRconcerto?® 209681
e MLM

~ Datasets

[ 209681...1106

2. Abrowsing window will appear. Double-click the .rsk file you want to view, or select the file and click Open.

Favorites = = £ Desktop B Q

%3 Dropbox...

& General = Name Size Kind Date Added

@ Recents 203762_20220622_1114_realtime.rsk 242 KB Document Jul 22, 2022 at 9:4

2 Applicati... B 203672_20220517 1240.rsk Document Jun 13, 2022 at 1:4!
| 209681_20220531_1106.rsk 319 KB Document Jun 13, 2022 at 1:4

B jchapman

= Desktop

™ Documents
@) Downloads
al Pictures
iCloud

¢ iCloud Dri...

£? Shared
All supported files

Locations

[ storag.. & New Folder Options Cancel m
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3. The name of the dataset appears and is highlighted automatically in the Navigator view. The Properties view
changes to the dataset, with four tabs: Analysis, Overview, Channels, and File info.

Channel Value Unit
Pressure 9.9299650  dbar
Sea pressure -0.2025347 dbar
Depth -0.2008831 m
Temperature 21.9603271 w0
4. The data in the file will automatically appear in the Plot view.
il RBRconcerto® 209681 | il 203672_20220517_1240.rsk 53 . jill 209681_20220414_1600.rsk | i 209681_20220531_1106.rsk =0

@ Toclose adataset, go to File > Close dataset. Alternatively, right-click the dataset name in the Navigator view

<&+ Navigator

b i Instruments
ORBRconcerto?
o MLM

b 5 Datasets

B 203672...1240 i

[5209681...1600
&1 209681...1106

209681

= O || @ 203672_20220517_1240.rsk 32

Analysis' i Overview Channels.i File info |

Sample 1
Time 2022-05-17 16:40:23.0002

Display statistics

Number of samples

e - - s NA- | eed @ e B B o

. 1T 020
-0.210
23.000 ) 00201 o0
-0.200
0.130
s2500]  _o1e0 | 10.000
= =
o 8 MO ganp
= il -0.180 {O =
w =
L E @ 0D sam
5 = s =
o a o OIS g
g 215001 & 0160 @ n
E ° 0.150 2 S8 s
21000{ - o
u
= i o0 9.950
-0.140
20.500 Wity 9.940
-0.130 ney
: 9.930
200001 0120
¥
17:00 18:00 10:00 20:00 21:00 22:00 23:00 00:00 0100 02:00
Time
P

W I

and select Close dataset.
Alternatively, simply close its Plot tab by clicking the X. The dataset will disappear from the list.
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15.2 Export

Use the Export option to share your data with others or analyse your data using other software. Datasets can be read
directly in Matlab with our toolkit RSKtools, or exported to Excel, OceanDataView?®, or text files.

Steps
1. File menu > Export, then hover to open a set of submenus.

Ruskin ~ Instruments  Help

Open dataset
Close dataset

Annotations

[ Microsoft Excel (*xlIsx)

(;9 netCDF ("nc)

§ netCDF profiles (%nc)

2| Text (*zip)

|4 OceanDataView spreadsheet (%.odv)
Raw binary (*bin)

1: 209718_20220616_1210.rsk

2: 209718_20220616_1209_realtime.rsk
3:203672_20220517_1240.rsk

4: 209681_20220531_1106.rsk

5: 209681_20220414_1600.rsk

6: AUTO_209681_20220613_1311.rsk

I Full Profiles
ﬁ Downcasts
@ Upcasts

£ -

or right-click the dataset in the Navigator window, then hover to open a set of submenus.

e = )
4 Navigator =] [EI 203672_20220517_1280.rsk 3
N e
T = - i
glnstruments Analysis Overview] Channels} File infol
MLM by
v gDatasets
Cursor
| B 203672...124
[ 200681...16¢ Close dataset : -
[ 209681...11¢  Export » | Annotations >| @ comment regions

[ 200718..tim¢  Reset chart view [ Microsoft Excel (*.xlsx)

B Full Profiles
[ 209718...121w

'@ ois © netCOF (*nc) [@ Downcasts
Rkl g, netCDF profiles (%nc) @ Uocasts
B Text (~.zip)
| @ OceanDataView spreadsheet (“odv) Avg Std Unit
Pr Bl Raw binary (*bin) 706 0.0013409  dbar
L — s 1 0.0013409  dbar
Depth -0.1987538 -0.1875052 0.0013300 m

2. Select the appropriate export format (Microsoft Excel, netCDF/netCDF profiles, Text, OceanDataView
spreadsheet, or Raw binary).

& For mobile or realtime RSK files, the Raw binary export format is not available.

w

If exporting annotations, select the category: Full profiles, Downcasts, or Upcasts.
Specify a location and a name for the data file.
Click Save.

e
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15.3 Analysis

Select a dataset in the Navigator view. The Properties view will change to dataset properties, with four tabs: Analysis,

Overview, Channels, and File Info.

For datasets in the Mobile storage format, the Analysis tab will only have the Cursor option.

Sample
Time

Display statistics

Mumber of samples

Channel

Conductivity
Temperature
Pressure

Sea pressure

Depth

Salinity

Speed of sound
Specific conductivity

Analysis _Overview | Channels File info

Cursor

63
2022-04-14 19:58:51.000Z

Value Unit
-0.0008081 mSfcm
23.6380513 C

9.9474698  dbar
-0.1850302 dbar
-0.1835213 m
0.0117910 [z=10]
1493.0025973 m/s
-0.8296216 pS/cm

For datasets in the Desktop storage format, it will also include Calibration.

Analysis . Overview Channels File info

Sample
Time

Display statistics

Mumber of samples

Channel

Conductivity
Temperature
Pressure

Sea pressure

Depth

Salinity

Speed of sound
Specific conductivity

Density anomaly

Cursor

63
2022-04-14 19:58:51.000Z

Value Unit
-0.0008081 mSfem
23.6380513 C

9.9474698  dbar
-0.1850302 dbar
0 1§ 2 i'_' m
0.0117910 PSU
1493.0025973 myfs
-0.8296216 uS/em

kg/m?

Calibration
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The Cursor view contains statistical information about deployment, as well as information about the dataset channels
and their values.

The colour-coding of the channel table matches that of the traces in the Plot window. To change the colour settings for
your chart, go to Preferences > Plotting > Channel colours.

Move the black cursor ("double lollipop") in the Plot window to display parameter values for each sample selected.

Every time you move the black cursor, going form sample to sample, the table above the plot will display the
information for this particular sample.

Analysis ~._Overview | Channels | File info |

Cursor

Sample 1833209
Time 2022-05-17 19:51:25.625Z

Display statistics

Mumber of samples

Channeal Valuo Unit
Pressure 59.9480430 dbar
Sea pressure -0.1864567  dbar
Depth -0.1849362 m
Temparatura 22.73181156 G

1|jill 203672_20220617_1240.rsk 12 jii 209718_20220616_1209_realtime.r 1

Locatlon (2] [¥ & :: | v irg e odp G é{, 3{, gy el e Ele sy

8.943 1

€« Cursor

0.937 -

134
195
13

0036
wr

Press ure (dbar)
o

200

201

202

203

19:51:00 19:52:00 19:52:30

Time
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Select Display statistics checkbox to determine the average value and standard deviation over a range of samples.

Change the number of samples to average using the up and down arrows.

The table will display the averaging data. The averaging interval will be highlighted in the plot.

Analysis . Overview | Channels File info |

Sample

Display statistics

~

Number of samples 100 w

Channel Value Ay
Pressure 9.9460430 9.9459233
Sea pressure -0.1864567 -0.1B65764
Depth -0.1849362 -0,18506549
Temperature 22.7318116 22.7318048

Time 2022-05-17 19:51:19.438Z - 2022-05-17 18:51:25.625Z

j 203672_20220617_1240.rsk 3 “ 209718_20220616_1 259_!'33"&”‘!&.!’5'{%
Locatten (2) (v @ 48 2 ;) 2 o | o' 5 A e sdr i m S e

Cursor

183210 - 183309

Std Unit
0.0014285  dbar
00014285  dbar
0.0074168 m
0.0004149 '

2.959 1

2.937 4

s d-fl il |

9,030 1 {

(R R

L H H . H
19:50:40 19:50:50 19:55:00 19:5L:10 1%
Time

< Cursor

o— v v T v +
0 19:51:30 19:51:40 19:51:50 19:52:00 19:52:10 19:52:20

7
Averaging interval

When the Calibration view is available, you can recalculate your coefficients for some channels. See User calibration.
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15.4 Overview

Use the Overview tab to view general information for each dataset, such as instrument details and deployment events.

To make a note about this dataset, enter your comment in the field provided and click Save comment.

Analysis Overview - _Channels.

File location

File info |

JUsers/jchapman/Downloads/209681_20220531_1106.rsk

Logger
Model: RBERconcerto?
Serial: 209681

Firmware: 1.141

Markers
Errors: 0
Warnings: 1

Information: 2

Diagnostics: 0

Comment

Deployment

Time offset:

Time drift:

UTC-4:00
-1867ms

Deployment start time: 2022-05-17 15:38:00

First sample time:

Last sample time:

First event time:
Last event time:

Samples:

2022-05-17 156139127
2022-05-17 15:39:29
2022-05-17 15:39:27
2022-05-17 15:39:31
6

Continuous

Period: 2 Hz

Gate

Gate: none

15.5 Channels

For datasets in Desktop storage format, the Channels tab will have three options: Information, Calibration,

and Parameters.

RBR#0006105revL

Analysis  Overview | Channels

Measured channels

# Parameter

1 Conductivity (mSfcm)
2 Temperature (°C)

3  Pressure (dbar)

Derived channels

Parameter

Sea pressure (dbar)
Depth (m)

Salinity (PSU)

Specific conductivity

== 0 = o 3

Speed of sound (m/s)

File info |

Information Calibration

Parameters

Sensor Range

Marine CT nfa

Marine CT nfa

REBR nfa
Notes
Removes atmospheric pressure
Simplified, using density parameter
pPSsS-78
UNESCO algorithm

(uSfem)

1 Density anomaly (kg/m?)
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For datasets in Mobile storage format, the Channels tab will have only two options: Information and Parameters.

Analysis | Overview | Channels File info |

Information Parameters

Measured channels

## Parameter Sensor Range
1 Pressure (dbar) RBR nfa
4 Temperature (°C) Pressure correction nja

Derived channels

# Parameter Motes
2 Sea pressure (dbar) Removes atmospheric pressure
3 Depth (m) Simplified, using density parameter

Information
The Information page displays two tables: Measured channels and Derived channels.

Measured channels include measured parameters with their units of measurement, the sensor manufacturer, and the
range setting (if applicable).

Measured channels

# Parameter Sensor Range
1 Conductivity (mSfcm) Marine CT  nfa
2 Temperature (°C) Marine CT nja
3  Pressure (dbar) REBR nfa

& The RBRconcerto® Tx will have multiple (12 or 24) temperature sensors listed in the Measured channels table,
and their numbering will start from the end of the string.
For example, for a 12-node thermistor string, Channel 12 will be the node closest to the connector.

RBR#0006105revL 103



Derived channels include all available derived parameters with their units of measurement and the methodology used
to calculate them.

Derived channels

it Parameter MNotes

4  Sea pressure (dbar) Removes atmospheric pressure

5 Depth (m) Simplified, using density parameter
6  Salinity (PSU) P55-78

7 Speed of sound (m/s) UNESCO algorithm

8 Specific conductivity (uS/cm)

11 Density anomaly (kg/m?)

Calibration

The Calibration page displays the calibration coefficients and correction coefficients (as applicable) for each channel,
as well as the date and time of the last calibration. Select a sensor from the Parameter dropdown menu to display its
calibrations.

A Only datasets in Desktop storage format have this option.

Analysis | Overview Channels _File info |

Information Calibration Parameters

Parameter E¥4% B

Calibratit 2: Temperature
3: Pressure
K-facto 4: Sea pressure
5: Depth
Label e abel Value
6: Salinity
[ o] 0 304.2324000 E-6
c1 7: Speed of sound i1 -12.7362800 E-6
C2(K) 8: Specific conductivity i2 5000000000 B3
) 13 0.0000000
11: Density anomaly " 0.0000000
X5 14.9704920
X6 10.0000000

The main calibration coefficients are displayed as "C" values: C0, C1, C2(K). Dependent coefficients are displayed as "X"
values: X0, X1, X2, etc.
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You can edit any of the coefficients in your dataset, regardless of the advanced calibration controls settings in

Preferences.

As soon as you make a change and move to another cell, a new calibration date will be displayed. Also, all three buttons
at the bottom of the page will become active.

Analysis | Overview Channels File infa

Calibration Parameters

Information
Parameter 1: Ccnductivity a
K-factor:  Unity [1.0] (2000-04-01) (%]
Label Value Label Value
co 14.5586770 E-3 X0 304.
cl 157.4760000 X1 -12.
C2(K) 1.0000000 X2 600.
X3 0
x4 0
X5 14
®6 10
Store and recompute data Revert calibration

2324000 E-6
7362800 E-6
goo0o000 E-9

.ao00000
.aoooooo
9704920
.aoooooo

Use deployment calibrations

Use Store and recompute data to recalculate the dataset. Use Revert calibration to recover the previous coefficients
and data if you have not already selected Store and recompute data.

To revert calibration and recalculation after it was stored, check the Use deployment calibrations checkbox. Click

Store and recompute data to save the reverted coefficients.
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Parameters

The Parameters tab displays parameters necessary to calculate derived channels and the method used for calculation.

You can edit these parameters to change the derived channel calculation. As soon as you make a change, the

two buttons at the bottom of the page will become active.

© Simplified depth derivation
Seawater depth derivation

Atmospheric pressure (dbar)
Density (g/cm?)

Latitude (degrees)

Speed of sound type

Specific conductivity coefficient
Oxygen concentration units
Salinity

Absolute pressure (dbar)
Temperature (*C)

Average sound speed (m/s)

Update and recompute

Analysis | Overview | Channels File info

Information

[e7 700

1.0000
0.0
UNESCO ke

0.0121

ma/L &
35.0

10.1325

0.0

1560.744

Revert settings

Calibration

Parameters

Click Update and recompute to recalculate the data and display new values.

Use Revert settings to recover the previous coefficients and data if you have not already selected Update and

recompute.

& For Mobile RSKfiles, you cannot recalculate the data. Clicking Update and recompute will not save the

changes.

For Realtime RSK files, the fields are not editable.
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15.6 Fileinfo

The File info page displays the dataset name and download location, Ruskin version used when it was obtained, file
structure, and size.

The Structure label reflects the RSK file format, which can be Desktop, Mobile, or Realtime.

Ruskin checks the dataset for compatibility with the newest version of Ruskin software. If the file requires updating, a
warning message and an Update button will be displayed.

Analysis | Overview | Channels |File info

About

File name: [Usersfamoore/Downloads/Example Ruskin File.rsk
Version: 1.12.2

Structure: Desktop

Size: 675 KB

Update

A new version of the RSK file format is available
The anticipated update duration is: 00:02

Update

Click Update. It may take several minutes for it to complete. RBR strongly recommends that all datasets are updated
and meet compatibility requirements.

Update

A new version of the RSK file format is available
The anticipated update duration is: 00:02

Update time remaining: 00:00:03
. ]

Cancel

© Failing to update your dataset may result in odd graphical displays and incorrect reporting of the sample
values.
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16 Plot window

Use the Plot window to view graphical displays of your datasets or live data. When viewing live data, the instrument
must be attached.

Each channel appears as a different colour in the plot. These colours are specified under Preferences > Plotting and can
be changed only there.

Bl 66015 North_Atlantic.rsk 52 profie (7 [¥ I RA e @ @D o BE 8

Move the black "double lollipop" cursor from one sample to the next to display parameter values for each sample
selected. Drag it with your mouse, or use the arrow keys on your keyboard as follows:

« To move by one data sample, press right or left arrow

« To move by a hundred of samples, press Shift + right arrow or Shift + left arrow

« To move by ten thousand of samples, press Alt + right arrow or Alt + left arrow

« To move by millions of samples, press Shift + Alt + right arrow or Shift + Alt + left arrow

For the datasets, these values will appear in the Properties window above (see Analysis). For live data, they will be on
the side of the plot.

The graphical display for each dataset or instrument will be in its own tab. The dataset file name or the instrument
model and serial number will appear at the top of the tab. Simulated instruments will have "sim" in front of their name.

J RBRconcerto® 209681 | j 203672_20220517_1240.rsk 52 - i simRERduet® 905077 | j§ simRBRcoda® 306843

Atoolbar at the top right of the Plot window contains various buttons to help you customise, explore, and export the
graphical display. The buttons selection changes depending on what is displayed in the tab. Hover over a button to
display its name and function.

- | - FrNA e Qe B-Hoe HE-0»
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A downsampled representation of the dataset appears in the thumbnail view, along with an indicator of the current
plotted time range.

e

Position the indicator by clicking on the thumbnail view and dragging the indicator. Resize the indicator by dragging the
edges left and right. It will zoom the main plot along the time domain to match the new indicator size. See Zoom
controls for more scaling options.

Time

~20.000 20000
123300 123330 123400 123430 123500 123530 123600 123630 123700 123730 123800 123830 123900 123930 12:40:00 12:40:30
Time
|

==

& Thethumbnail view always shows the plot-by-time data, even if the plot is switched to the plot-by-depth
mode.

When you close and re-open a dataset, it will retain your latest settings (channel visibility, zoom, plot style (plot-by-time
or plot-by-depth), annotation selection, and display style (lines or markers).

Double-click anywhere on the main plot to return to the full-chart view.

@ Goto Appearance controls to change your selection of lines and markers.
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17 Dataset plot toolbar

Use the plot toolbar to adjust the display of an open dataset.

Cast
detection Appearance
l Zoom controls controls

e

¢ wlind Av O (= ;J_ :_'é ";d' _:g - gv E:r =

Annotation | T T
controls Event Export GPS
visibility plot map

17.1 Annotation controls

Annotations are information messages added either by users or by the instrument.

Create annotation

Filter Index l
profiie (557)  [v||l4@ €]z | 557 | B <~

N

Navigation buttons

17.1.1 Select annotation type

Annotation types are divided in two categories: profiling (Profile, Downcast, or Upcast) or non-profiling (Comment,
Exclusion, Location, or Calibration). Use annotation controls to manage this information and to navigate the plot.

Type Function

Profile, Downcast, Upcast Identify profiling

Comment Add a note to your data

Exclusion Remove a non-representative interval from analysis

Location Add in latitude/longitude coordinates for RSK files to track locations of
data logging

Calibration Calibrate the ODO sensor (available only for RBR standard instruments

using the RBRcoda® T.0DO as an integrated sensor)

RBR#0006105revL

110



Open the Filter dropdown menu to select the annotation type to display. The number of annotations for each type will
be indicated.

Location (1) v

Protile [557)

Downcast (557)
1

Select an annotation type. The plot will centre on the first item in the selected category. For example, when you select
Profile, the plot will move to the first profile.

If you switch the filter to another annotation type within the same category (for example, Profile to Upcast), the plot
will not change. If you switch to a type from another category (for example, from Profile to Comment), the plot will
move to the first annotation in the new category (for example, to the first comment).

17.1.2 Navigate between annotations

= €@ 552 | 557 B B

Use the Navigation buttons to navigate between items within the selected category.

& The navigation buttons will be activated if there is more than one item in the selected annotation type.
Otherwise, the plot will centre on the only item available.

Navigation controls

+ Move from one annotation to another by clicking the left and right arrows.

« Jump all the way to the beginning or end of the list by using the end-left and end-right arrows.
« Alternatively, manually enter the number in the Index field to go to that particular annotation.
« Double-click an annotation to centre and zoom in the plot at that particular area.

Bl 203672_20220517_1240.rsk 3 = O | | 208672_20220517_1240.1sk 5% =8

comment (2) [v] [4a 48 2z 4 2 G-MA @@ dadh &B-H-ao9 Gomment (2) [v] [ 4@ 2 / 2 G- A qad &G & B-EHoa e

L
COMMENT 2 48 T OoxX H |
Tho Conriz 4 H”
il
Detais i |r

s iranasa  zezosiravzs (RO

WN ”IIWHJ‘IW'H'U‘IJ1lm'-"' 1

2100 2140 2220 2300 2340 0020 oL’00 o140 020 2130 2140 2150 22700 22710 22720 22730 2240 2250 2300
Time Time

2220517212621 20220617 23:0125

Temperature (°C)

A

@ Double-click anywhere on the main plot to return to the full-chart view.
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17.1.3 Create new annotation

Click the Create annotation button "] and follow the steps below.

Steps

Select the type of annotation to create, for example, Comment.

Location

Profile

Exclusion

The cursor in the Plot window will become a two-way arrow

1. Click on the main plot to identify a single point to comment, or click and drag the cursor left or right to select an
interval. When you release the click, an editable tooltip will open.

Comment {1) |* 1T/ 1 g

COMMENT 1 & T SXK
Titie Comment 1|

Datails

2016-12-15 22:04:13 2016-12-15 22:04:13

The tooltip controls include Left and Right arrows i , Delete EI , Export region |:| , Save ,

and Close .

The Profile tooltip also features Up and Down arrows EI for adding upcast and downcast profiles.
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2. Enter the necessary information into the fields and save by pressing Enter on your keyboard or by clicking

Save on the tooltip. Your new comment will appear in the dropdown list.

Comment {1) & 1 L=fEe)

Protile (1)
Downcast (1)

Clicking Close E or pressing Esc on the keyboard will close the tooltip without saving.

& Edit at least one detail in the tooltip before saving. Otherwise, the annotation will be deleted when
deselected. Moving or resizing the annotation counts as editing and saving.

3. Click the arrows

]

on the tooltip to move to the next annotation within the same category.

4. Double-click on the annotation bar to zoom in to the range of the annotation.

5. Click and drag on the annotation bar to move the annotation.

6. Click Delete Ij on the tooltip to delete the annotation.
A warning message will appear.

Ruskin

i Are you sure you want to delete this annotation?

Click Delete to proceed. This action cannot be undone.

RBR#0006105revL
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17.1.4 Add profiles

Use the Annotation function to manually add profiles to your dataset.

Steps

1. Click the Create annotation button "| and select Profile from the dropdown menu.

- == CF vﬁ&v ".EE:
Comment

Location

Exclusion

2. Click and drag the cursor to select a region.

H+

—

As soon as you let go, an editable tooltip will open and a band of a darker colour will appear above the selection,
indicating that a new profile has been added.

3. Place the cursor on the edge of this new profile and move it left or right to adjust the size.

Frofile (1) [¥

PROFILE 1 Ya & TAX
Title

Datails

2016-12-15 17:17:58 2016-12-16 01:45:01

N

4. Add aname and click Save on the tooltip.

profile (1) [ 1/ 1 AN AR

PROFILE 1 YA & T AOSX
Tite 10X
Details

2016-12-16 02:26:09  2016-12-16 03:56:19
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5. Use the Up and Down arrows EI on the tooltip to identify upcast and downcast regions.

The upcasts and downcasts you added will be displayed in the dropdown menu and highlighted on the plot

under the parent profile.

& Only the Profile tooltips have the Up and Down arrows.

6. Place the cursor at the edge of the added region and adjust its size.

Downcast (1) | & 14 1 (w
Comment {1)
Frofile (1)
/1 G v N A @y g
|
F
| |

7. Click on a profile/upcast/downcast to open its tooltip.

i 041422_20161216_1100T.rsk 52 peast) [v

o8 LT

§

-0.905

2016-12-16 082558 2016-12-16 09:15:19

o

(.

Time

17:00 18:00 19:00 20:00 21:00 22:00 23:00 00:00 01:00 0z2:00 03:00

06:00

07:00 08:00

09:00

8. Name each region and save the settings.

9. If desired, export your profile to a separate RSK file. To do that, click Export region I:I on the Profile tooltip

and follow the steps.

A The Export region option is not available on Upcast and Downcast tooltips. To generate an RSK file for

an upcast or downcast section only, use the Comment annotation to clip the dataset before exporting.
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17.1.5 Exportregion

& The Export region option is only available for Comment and Profile annotations.

Follow the steps below to clip your dataset and export a subset of your data. This function may be useful when you

need to exclude certain regions. For example, a dataset may contain several deployments if sampling was not paused/
stopped before the new deployment was started.

Steps

1. Click the Create annotation button

14 1 G v N AN @

Location

Profile

Exclusion

2. Click and drag the cursor to select a subset.

" | and select Comment from the dropdown menu.

Comment (1) ¥ 141

| AT S S Ry

COMMENT 1 °r T AYX
7 I N
| e S Detais

KKT 7 B S
3. Enter a name in the Title field on the tooltip and click Save .
Comment (1) | ¥ 141 G
COMMENT 1 & T OsSX
Title Clip
Details
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4. Select Export region I:I on the tooltip.
A dialogue box will open.

| 3976_20230123_1018P clipped.rsk |

= Downloads

Ruskin RSK (*.rsk)

Cancel

o
¥

5. Adjust the name and location for the new dataset file and click Save.

An Export region message will appear.

Export Region

Do you want to strip out the original downloaded image to reduce file size?

No

Yes

6. Select No to maintain the full binary values and retain the option of recalibration in the future.
The clipped dataset will openin a new tab in the Plot window.
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17.2 Cast detection

Ruskin automatically enables profile detection on instruments when a deployment is enabled. There are several criteria
for enabling this feature.

+ Theinstrument must support the castdetection setting

« Theinstrument must have a pressure sensor

+ The deployment must be configured for | fast sampling (2Hz and up)

+ The deployment mode must be configured as either continuous or directional

It is possible to recalculate the casts in a dataset using the cast detection feature in the Plot view.

Click the Cast detection button LA to run a cast detection algorithm based on depth and conductivity to
automatically generate profiles and casts. A warning message will appear.

@ Cast Detection - Are you sure?

Warning!

The cast detection operation will replace all instrument-generated profiles/casts, even those that have
been edited, and may take a long time to run.

Are you sure you want to proceed?

concel (TN

If you proceed, Ruskin will find peaks, collect events, and overwrite profiles recorded by the instrument.

@ Double-click anywhere on the main plot to return to the full-chart view.

17.3 Eventvisibility

Click the Event visibility button to turn on and off the visibility of the various levels of events: Error, Warning,
Information, and Diagnostic. Its colour will reflect the highest level of event severity reported.

A @ d adad A @@ @ Q- o A @ G Q Qi
“ | + [ Warning (1)
+ /N Information (2) + /% Information (1)
« £\ Diagnostic (23) M Diagnostic (2228) i
b 1 rim———— " s sy i
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17.4 Zoom controls

Default scaling of the plot is based on the minimum and maximum values sampled for each channel. Use zoom controls
to adjust it as needed.

Zoom out
g Reset zoom
) horizontally )
Zoom in to maximum
horizontally bounds

! !
A 1

Zoom in Toggle

vertically auto-ranging
Zoom out

vertically

@ Double-click anywhere on the main plot to return to the full-chart view.

17.4.1 Horizontal zoom

Horizontal scale options may be helpful to increase or decrease the the time range displayed. It is convenient when the
dataset is long and thus losing resolution when displayed in the Plot window in its entirety, like in this example.

3 iy A @ d Gk e P . s = |
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£ & £ 22600
Q14000 {¥ —4p00{E
g -16.000 & _g.o0p | 22400
-18.000 sooo{ 22200
-20.000{ -10.000{  22.000
TRRO0D LRO0DY gy ey (T T T Lo =
-24.000{  -14.000 A
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There are three ways to apply changes to the horizontal scale. The first two will auto-range your chart, ensuring the
entire vertical domain is visible. The third approach will retain the latest vertical scaling of the original interval.

4.i 3 A=y
1. Usethe Zoom in horizontally = and Zoom out horizontally = buttons.
OR
2. Click on the thumbnail view and resize the indicator.
The vertical scale will automatically adjust to fit the new range.
Wi 095719_20170323_1121.rsk 53 — e Fridy @@ @@ & 3-E =g

0.460
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10:48 10:52 10:56 11:00 11:04 11:08 11:10

3. Hover your mouse over the X-axis, then hold Shift + left click.

The cursor will change to a two-way arrow
without changing the data resolution.

. Dragit right to zoom in or left to zoom out the time domain,

il 095719_20170323_1121.rsk 52
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Click Reset zoom to maximum bounds

appearance.
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17.4.2 Vertical zoom

Vertical scale options may be helpful when there are erroneously high or low values that make the real data appear
incorrect, or when there is significant difference in scale between the displayed parameters.

o . = ] WE G & @ | 1 5=y =3 =
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! a -14000{® 4000 E 2500
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.
Entire chart

Depending on the zooming method, you may change the scale only vertically, or both vertically and horizontally.

s

1. Use the Zoom in vertically
of the data displayed.
The resulting display will retain the same horizontal scale.

and Zoom out vertically

a

'Ei

buttons to increase or decrease the resolution
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2. Hover the cursor and scroll your mouse wheel up and down to change the scale.
In this case, the horizontal scale will also change (as seen from the thumbnail indicator). The plot will centre where

the mouse cursor initially was.
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There are two ways to apply changes to the vertical scale of one channel only, which yield the same results.

1. Hover the cursor over the Y-axis for this channel and scroll your mouse wheel up and down.

OR

2. Shift + click the Y-axis for this channel and move your mouse up and down.

This particular channel will zoom in and out (in the example below, temperature). Double-click on the same vertical

axis to reset this parameter.
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17.4.3 Navigation options

After you change the scale, some parts of your chart may end up outside the Plot window. There are several options

available to navigate it.

1. To pan the entire chart horizontally, hold Ctrl + left click and move your mouse left and right.
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8 020013 s00m|Z $ o1 ,0lE
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This action is only possible after already applying some horizontal zoom to the chart.

2. To pan the entire chart vertically, hold Ctrl + left click and move your mouse up and down.
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3. To pan one of the channels vertically, click a value on the vertical axis for that parameter (in the example below,
sea pressure) and move your mouse up and down.
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Double-click on the same vertical axis to reset this parameter.

4. To freely select any part of the chart, hold Shift + left click and draw the rectangle. The chart will zoom in on the

selected area, both horizontally and vertically.
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5. To keep all your data within the viewing window, click the Toggle auto-ranging button
profiles within the selected time section maintain their optimal vertical zoom.

. Wheniitison, all
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Click again to disable. Disabling the auto-ranging of the axis can be useful for looking at trends in data.
Zooming in or out of an individual channel will disable auto-ranging for that channel.

6. Tozoom in to the range of an annotation, double-click on the annotation bar.

© =

Click Reset zoom to maximum bounds
appearance.

or double-click anywhere on the chart to restore the original
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17.4.4 Advanced axis controls

Some RBR instruments have multiple parameters of the same type. For example, your RSK file from the RBRconcerto
Tx could have 12 or 24 temperature channels and from the RBRquadrante, up to four irradiance channels.

3

By default, Ruskin will use a single axis to display similar channels. To display each similar channel on its own axis, g o

to Preferences > Plotting > Channel visibility. Deselect the Use single axis for similar channels checkbox.

(<) [ ] Preferences

(] | Plotting

Derived channels
Facility

General Channel visibility Channel colours
Plotting

Manage default plotting behavior

By default, hide any measured channel underlying a simple derived channel
Use single axis for similar channels
meﬁﬂ_l
Show dataset errors by default

Automatically save live data to a file (Legacy instruments)
By default, hide all measured channels

Hide conductivity channels Hide ORP channels

Hide temperature channels Hide transmittance channels
Hide pressure channels Hide turbidity channels

Hide dissolved O2 channels Hide voltage channels

Hide distance channels Hide RBRquartz® period channels

Hide fluorometry channels
Hide pH channels
Hide PAR channels

By default, hide all derived channels

Hide salinity channels Hide distance channels
Hide depth channels Hide dissolved 02 channels
Hide pressure channels Hide RBRquartz® pressure channels

Hide specific conductivity channels Hide RBRquartz® temperature channels
Hide speed of sound channels
Hide density anomaly channels

Restore Defaults Apply

Cancel Apply and Close

Click Apply and close. These changes will automatically apply to every new dataset. To apply your changes to an active

dataset, close it and then re-open.

Both views have their advantages. Below, compare the two displays of the same dataset obtained using an

RBRquadrante.
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Default settings: single axis

The chart displays four irradiance channels and one irradiance axis. The axis is grey, while the traces related to this
single axis remain colour-coded.

With the axis panel collapsed, you have a broad view of the chart.

All four channels have the same scale, which in the example below is 0-5.500uW/cm?/nm. Vertical zoom controls, if
used, are applied to all these traces as a group.
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Customised settings: multiple axes

The chart has four irradiance channels and four axes, each identified with the same colour as the trace. The
corresponding wavelength and FWHM will also be displayed; in this example: 560/10, 488/10, 445/10, and 413/10.

Each channel has its optimal vertical scale. In the example below, the scale for the 560/10 is 0-9.000uW/cm?/nm, while
for the 413/10 it is 0-0.100pW/cm?/nm.

To adjust the vertical scale for each channel individually, hover the cursor over an axis and scroll your mouse wheel up
and down. See Vertical zoom for other ways to adjust the scale.
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Regardless of the view (single axis or multiple axes), the channel table in the Analysis tab retains individual colours for
all channels, matching the colour-coding of the traces in the Plot window.

9 Irradiance 4

7 Irradiance 413/10nm
8 Irradiance 44510nm
88/10n

10 Irradiance 5§60/10nm

4.9941950
11.2594115
18.3235068

w

16.9567764

uW/em?nm
pWleminm

uWicm®*fnm

puWfem?nm

@ Tochange the colour-coding settings for your chart, go to Preferences > Plotting > Channel colours.

17.5 Export plot

n

&

Click the Export plot button

and select file name and location to save the current view of the main plot to a PDF

or PNG file. The exported file will contain the graph only and retain all the changes to display active at the moment of
export: zoom, lines and markers, visible events and annotations, and plotting by depth or time.

b & Br-Ero
we As: | 381_20220613_1311 with markers.pc |
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13:11:10 13:11:15 13:11:20 13:11:25

17.6 Appearance controls

Select your data rendering type from the Change line type dropdown menu : Lines, Markers, or Lines and

markers.

MAr @dr @ &G &) B
+ Lines

Markers

Lines and markers

b A e @ G el B

Ny e ar @@ Gy ) B

Lines

Lines

Lines and markers

01:37:15 01:37:16 01:37:17 01:37:18 01:37:

01:37:15 01:37:16 01:37:17 01:37:18 01:37:

Markers

01:37:1% 0L:37:16 01:37:17 01:37:18 0137
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@ fnodata appears in the Plot view, try changing the rendering to Markers. Time spans that are larger than
expected will cause breaks between data points and lines will not be drawn connecting those points, whereas

markers draw at each individual point.

==

Use the Toggle channel visibility button

re=
== 7

to open the dropdown menu with the list of available channels and

options. Check and uncheck channels to display as desired, or select groups to show and hide.

- NA @edaaa e B, H
—¢ ¥ 1. Temperature E |
v 2: Pressure
« 4: Sea pressure o]
+ 5: Depth
Show all channels | Show >
Show measured channels
Hide >
Show derived channels
Show only > Show raw channels
2: Pressure
4: Sea pressure
5: Depth
00:38 00:40 09:42 00:44 00:46 09:48 00:50 09:52 00:54

Select Show raw channels to display measured data with no calibration equations applied.

-=
0.025 0.380 1.500E-3
0.024 0.389 1.000E-3
Qi e 0.500€-3
Lo/
Y o022 = G = o
H =t
n D 03ss Y
v IEE =1 ¥
Q 0.01 18 s |2 D.500E-3
0.385
B 0.020 E © -1.000E-3
= = a3 {Y
2 0.019 2 -1.500E-3
o 0.383 {3
0018 {8 % oo0e-3
0.382
0.017 -2.5006-3
4 0.381
0.016 -3.000E-3
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By default, the data are plotted by time. Use the Toggle depth plot button to switch to the plot-by-depth mode.

Proie 557 [v] a4 3 1 567 B G NAY @w @ Q@l 8 BEHo9

The thumbnail view will continue to display the plot-by-time data.

() Ifthereis nodepth channel, the plot will use the next pressure or pressure-derived channel starting from the
bottom of the channel list.

17.7 GPSmap

L]
The Show GPS map button Z| opens a pop-up window with the GPS map for the plot. Click on the map to display all
the GPS location annotations recorded in the dataset.

[ JON ) 203672_20220517_1240.rsk GPS Locations

GPS mapping for Desktop RSK files relies on manually added location points (see Annotation controls). All location
points you added using the Annotations feature are stored in the dataset file and can be displayed in Ruskin via the
mapping functionality.

() Charting and continuous GPS tracking are only available on the Ruskin Mobile app, for datasets in the Mobile
storage format.
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18 Live data plot toolbar

You can use the Plot window to view a live graphical display of your instrument sampling. All options described in the
Dataset plot toolbar section apply to live data display. Additionally, three live data buttons appear at the right end of
the toolbar: Side data panel, Live plot time range, and Fetch.

Cast
detection Appearance Live data
l Zoom controls controls controls
i Jlralee s ool g ol A »
Annotation controls T T T
Event Export GPS
visibility plot map

=

==

Click the Side data panel button to toggle on and off the data panel to the right of the plot. It shows the file
location that will be used to capture samples, the number of samples collected, the values of the last received sample,
and the currently selected sample.

‘- Frinhr @ @ a @b & B-Eae BHH- o ! - FriihAy wad Q-G B-Eor S0
Capturing to /Users/jchapman/209681_20220620_1418|
Sample #: 26 (141 captured)
Time: 2022-06-20 14:19:15.000-04:00
# Value Last  Unit
1 -0.0005000 -0.0005000 mSfcm
2 22.3110000 22.3376000 °C
3 10.1087000 10.1118000 dbar
4 0.3387000 0.3418000 dbar
0.3454000 0.3485000 m
6 0.0000000 0.0000000 PSU
7 1489.2417000 1489.3186000 m/s
8 -0.5230000 -0.5605000 pS/cm
14:19:10 14:10:15 14:18:55 14:18:00 14:18:05 14:19:10 14:10:15

Click the Live plot time range button to open a dropdown list of time span options.
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For example, select 2 minutes to display the data in the thumbnail view and on the side panel by two-minute time
periods.

By Elvra e IG5y 0w =2 SoiAeed @ e Hor @R
4 i T Capturing to /Usersfjchapman/209681_20220620_1418]
han/i  All data '0_1418, Sample #: 26 (423 captured)
A Time: 2022-06-20 14:19:15.000-04:00
dj % # Value Last  Unit
TRl ¥ 2 minutes 1 -0.0005000  -0.0006000 mS/em
X 2 22.3110000  22.4030000 °C
5 minutes 3 101087000 10.1157000 dbar
. Fl 0.3387000 0.3457000 dbar
_o.¢ 10 minutes : 0.3454000 0.3526000 m
30 mi 6 0.0000000 0.0000000 PSU
22.4 minutes 7 1489.2417000 1489.5068000 m/s
0.1 e 8 -0.5230000  -0.6035000 uSfcm
q
0.3 2 hours
0.3
0 c 1 2 hnurs (1840 14:18:45 14:18:50 14:18:55 14:19:00 14:19:05 14:19:10 14 I 115
% Time
89 8 24 hours
-0.€ 48 hours

You can also choose to display all of the data collected.

Fetching

Live data can come from one of two sources: streaming or fetching.

Fetching is the action of asking the instrument to take a reading and report it.

Fetching can be used on an instrument that is either not enabled or enabled without a streaming option. To disable the
streaming option, go to Options under the Configurations tab and set Realtime to None.

Click the Fetch button to start fetching data. The button will change to Pause u . Click the Pause button n

to stop fetching.

a If streaming is selected (Realtime is set to Serial or USB), clicking the Fetch button will have no effect
on the plot.
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If the instrument is fetching data, but you want to start streaming, go to Options under the Configurations tab and set
Realtime to Serial or USB, then click Enable. A warning message will appear.

& Warning

The contents of memory will be erased!

crase and enabl logaing

To save the fetched data, click Cancel and download the dataset file. Otherwise, click Erase and enable logging.
Ruskin will disable fetching, close the current dataset used for the fetched data, and create a new file for the streamed

data. A new streaming plot will appear. Click the Pause button n to freeze the view of live data.

— - FriiA- e @ Q@R e B-E-o e [HH-[D
Capturing to [Usersfjchapman/902860_20220620_1458_realtime.rsk

40.000

35.000 Sample # -- (746 captured)

Time:
30.000

# Value Last  Unit
1 - 29.2556039 °C

25.000

20.000

15.000

Temperature (°C)

10.000

5.000

-5.000

15:04:05 15:04:10 15:04:15 15:04:20 15:04:25 15:04:30 15:04:35 15:04:40 15:04:45 15:04:50
Time

15:04:55 15:05:00

A
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19 Firmware updates

Ruskin automatically checks if your instrument firmware is up-to-date. Updates may be critical, routine, or customised.

19.1 Critical firmware updates

If a newer version is available and this update is critical, the Update firmware button and a warning message will

appear at the top of the Configuration tab.

Steps

Configuration Information | Calibration | Parameters

Firmware Update

Update firmware

1. Click Update firmware.

The Update logger firmware window will appear. It will contain Release notes, outlining the new version

number, its release date, improvements, and bug fixes associated with this release, and two standard buttons at
the bottom of the window: Close and Proceed.

RBR#0006105revL

Update logger firmware

Use this utility to update your logger.

Release notes

Attention: if your instrument currently has firmware version 1.138 or later, you are strongly advised to proceed with
this upgrade. It improves support for a variety of memory device types, ensuring that the full data capacity is
available for reliable data storage.

Version 1.141 - 05 May 2022
Requires Ruskin 2.18.0
Improvements
= Internal support for multiple memory device types (L3-932)
Bug fixes

+ Fixed parameter checking for Direction-Dependent sampling mode to prevent use of invalid periods (L3-
926)

Close Proceed
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2. Click Proceed to initialise the update.

The instrument will disappear from the Navigator window during the upgrade. Watch the progress bar at the

bottom of the window for the status.

© Do notdisconnect the instrument until a confirmation message is displayed. Disconnecting during the

update process may render the instrument inoperable.

If the upgrade does not complete successfully, go to the Instruments menu and launch the update dialogue.

@ Ruskin File

Instruments  Help

“=- Navigator

v i Instruments
' RBRconcerta®
uzn MLM
g Datasets

Simulate an instrument...

Disconnect from instrument

Automatic tasks

Utilities

The Update logger firmware window will appear. Click Proceed again to retry.

If the instrument does not reappear in the Navigator window after a firmware update, disconnect your instrument from
the USB port and then reconnect to establish communication.

19.2 Routine firmware updates

If the latest update is not critical, Ruskin will not display any warning message. However, you can always check
manually if a newer firmware warning is available.

Go to Instruments > Update instrument firmware.

The Update logger firmware dialog box will appear. In addition to the new version number, its release date,

improvements, and bug fixes, there will be two additional sections: Select the instrument to update and Select the

firmware image.

RBR#0006105revL
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Steps

Update logger firmware

(D Your instrument has the latest firmware available: 1.141

Select the instrument to upgrade

Instrument RBRconcerto® 209681 -

Select the firmware image

Standard Logger (104) v1.141 e Import...

Release notes

Attention: if your instrument currently has firmware version 1.138 or later, you are strongly advised to proceed with
this upgrade. It improves support for a variety of memory device types, ensuring that the full data capacity is
available for reliable data storage.

Version 1.141 - 05 May 2022
Requires Ruskin 2.18.0
Improvements
« Internal support for multiple memory device types (L3-932)
Bug fixes

+ Fixed parameter checking for Direction-Dependent sampling mode to prevent use of invalid periods (L3-
926)

Close Proceed

1. From the Instrument dropdown, select the instrument you wish to upgrade.

RBR#0006105revL
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RERsolo® 209609
Instrumen!  pARcoda®2096 68 '
+* RERconcerto® 209681

Select the ir

select the T
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2. From the next dropdown, select the latest firmware image.

Select the firmware image

+ Standard Logger (104) v1.141 | Import...

Standard Logger (104) v1.140
Standard Logger (104) v1.138
Standard Logger (104) v1.137
Standard Logger (104) v1.135 s firmware version

Standard Logger (104) v1.134 ariety of memory de
Standard Logger (104) v1.133
Standard Logger (104) v1.128 022

3. Click Proceed to initialise the update.
The instrument will disappear from the Navigator window during the upgrade. Watch the progress bar at the
bottom of the window for the status.

© Do notdisconnect the instrument until a confirmation message is displayed.
Disconnecting during the update process may render the instrument inoperable.

If the upgrade does not complete successfully, click Proceed again to retry.

If the instrument does not reappear in the Navigator window after a firmware update, disconnect your instrument from
the USB port and then reconnect to re-establish communication.

19.3 Manual firmware updates

In certain cases, RBR may supply a customised firmware version, which will not be on the dropdown list.

Go to the Instruments menu and launch the update dialogue.

@ Ruskin File Instruments Help

| NN Simulate an instrument...
lﬁ Navigatcnr""- Disconnect from instrument — = |
Bemmst  Update instrument firmware... —
v i Instruments
CRBReoncerto? Automatic tasks »
i MLM
£ Datasets Utilities ?

The Update logger firmware dialog box will appear. Follow the steps below to import the firmware image provided by
RBR and update your firmware.
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Steps
1. Inthe Update logger firmware dialog box, click Import.

Select the firmware image

Standard Logger (104) v1.141 = Import...

2. Browse to the location of the firmware update file. The file will have the extension .rbrfw.

3. Select thefile and click Open.
The file will appear on the dropdown list.

Select the firmware image

L3-1X142-5118.rbrfw %] Import...

Release notes

Version 1X142 - 02 June 2022
Requires Ruskin 2.16.0

MNew Features

Bug Fixes

4. Click Proceed to initialise the update.
The instrument will disappear from the Navigator window during the upgrade. Watch the progress bar at the
bottom of the window for the status.

© Do notdisconnect the instrument until a confirmation message is displayed. Disconnecting during the
update process may render the instrument inoperable.
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20 Automatic tasks

When working with a large number of similar instruments, Ruskin offers various automatic tasks.

When using this feature, you will configure your schedule once and then automatically apply the settings to multiple
instruments.

& Automatic tasks do not work with wi-fi connected instruments.

Access these options from the Instruments menu on the top toolbar.

kin File

nis  Help

|

'. Y Simulate an instrument...

— o Disconnect Trom instrument 7
- =5 Tl ;
#* Nawgil Update instrument firmware... [ = Caniectior
————————Jit"
TRBFR += I Auto-download 1

@sim Wit 3 Auto-stop

e ilities

Osim _ Auto-deploy L
gl 905934 = View auto-deploy settings ;
wam MLM EE

v E Datasets || [devitty

IESE TaTa¥-1-11 LI Na¥-]

Alternatively, right-click Instruments in the Navigator window.

45k Navigator - 0
ST—— ) E—
ORBRconcerta® imulate an instrument...
min ML + Auto-download
g Datasets
Auto-stop
Auto-deploy

View auto-deploy settings...
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When you enable a task, it will show a checkmark next to it, and the corresponding icon will be displayed in the
Navigator window.

Auto-stop  Auto-deploy

v @ Instruments @ ‘Rgo

N
Auto-download

Since these tasks can change the state of your instrument, their settings default to "off" each time Ruskin is run.

When an automatic task is on, Ruskin will execute it as soon as you plug an instrument into your computer.

Auto-download

When Ruskin detects an instrument, it will automatically start a download process. The downloaded dataset will be
named following the standard naming convention, and saved in the default directory. Other than possibly creating
unwanted files, this option is safe since it does not alter the state of the instrument.

Auto-stop

When Ruskin detects a previously enabled instrument, it will automatically stop the deployment. If auto-download is
not selected, it will also display a warning about downloading the instrument data.

Use this feature when Gating is set to None.

& Allthe data on the instrument will be erased as soon as you enable a new deployment. RBR recommends
enabling the Auto-download feature whenever you enable Auto-stop.

Auto-deploy

When Ruskin detects an instrument, it will stop the deployment and then reprogram your instrument with the last
known configuration settings. Use this feature when you have several instruments with the same capabilities.

& Allthe data on the instrument will be erased as soon as you enable a new deployment. RBR recommends
enabling the Auto-download feature whenever you enable Auto-deploy.

To use this feature, follow these steps:

1. Connectto aninstrument that will act as the model.
2. Configure this instrument with the desired settings.
3. Enable Auto-deploy as shown above.
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Now, when you connect to an instrument with same capabilities as the model instrument, Ruskin will configure it to

match the the model schedule.

& Auto-deploy implies Auto-stop.

Ruskin must stop your instrument to change deployment parameters, so it will stop even when there is no

checkmark next to the Auto-stop task.

View auto-deploy settings

To view the currently active auto-deploy parameters, go to Instruments > View auto-deploy settings... . The Auto-

deploy settings box will open, with saved parameters outlined.

Auto-deploy settings

Configuration of auto-deploy

Schedules

Clock sync: NONE

Start date: 2022-05-17 15:39:00
End date: 2099-12-30 19:00:00
Mode: CONTINUOUS

Sampling period: 2Hz

Parameters

Setting

ALTITUDE

ATMOSPHERE
AVERAGE_SPEED_OF_SOUND
CAST_DETECTION
CONDUCTIVITY

DENSITY
SIMPLIFIED_DEPTH_CALCULATION_TYPE
DISSOLVED_O2_GENERIC_UNIT
DISSOLVED_O2_OPTODE_UNIT
DISSOLVED_O2_OXYGUARD_UNIT
DISSOLVED_O2_RINKO_UNIT

Reguirements

FASTCONTINUOUS

Auto-deploy settings

Value
0.0000
9.7700000
15650.7440
on

42.914
1.0000000
on

mg/L
uMol/L
mafL

mafL

Dismiss

RBR#0006105revL

140



21 Utilities

& The Utilities option is a support tool. Contact RBR before using it.

From the Instruments menu, click Utilities. A dropdown menu will open.

Instruments  Help

Simulate an instrument...

= a |i = Connections 5 .
Update instrument firmware... =

Automatic tasks >

Diart
Litilities " Stop instrument upon detection npodem141101
Connect to networked device...

View connected GPS...
IT

Stop instrument upon detection

This is an emergency utility which provides a solution to a rare issue with some legacy instruments. Do not use unless

instructed by RBR.

RBR#0006105revL

This utility is intended to be used as a recovery mechanism

L

Symptom:
Instruments which have cast detection enabled and which lose
power during a deployment may end up in an unusable state.

Action:

Enable this feature only if you experience a instrument which
is not communicating to Ruskin. Remove the batteries of the
logger and let it sit for 2 minutes on the bench then connect it
via USB to this computer

Notes:
This utility is only applied to the next instrument connected. It
will need to be re-enabled for subsequent connections
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Connect to networked device...

This utility allows a device with serial output to connect to your network via Ethernet. This feature supports remote

management and monitoring of your instruments from anywhere in the world.

1. Select your network device from the dropdown list.

[ [ Connect to network device

Connect to network device

Please specify IP and port to connect to

+' Instrument |

Microsalinometer
MMEA GPS

IP Port: 1234

2. Specify the IP address and port.

& & Connect to network device

Connect to network device

Please specify IP and port to connect to

Instrument ]
IP Address: 127.0.01
IP Port: 1234

(@ Forthe microsalinometer, the port number must be 23.

RBR#0006105revL
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3. Click Connect.

The Connections tab will display instruments and salinometers connected via Ethernet, alongside with the

instruments physically plugged in to your computer. Their IP address and port will appear in the Port column. If

an attempt to connect was unsuccessful, Ruskin will report an error in the Status column.

El Connections 23

Part Status
127.0.0.1:2 Unable to connect to host
192.168.4.063:23 Connected to M5-310
M /dev/tty.usbmodem14123101 Connected to RERduet® 206199
192.168.5.023:1234 Connected to NMEA GPS

RF latency (s)
0

0
0
0

Device
Logger
Logger
Logger

GPS

To view connected GPS devices, go to the next utility.

View connected GPS...

This feature allows you to track your instruments during towed deployments. Attach a NMEA GPS to your computer and

connect to it as described above. Alternatively, connect to one of the boat tracking devices if it has an IP address.

Typically, only one GPS is necessary to track your deployment. Using more than one GPS may bring confusion into your
data. Click View connected GPS... to see all listening ports. Click the Port button to disconnect.

RBR#0006105revL

Connected GPS devices

View listening ports. Disconnect devices

Disconneact

Port: 1234

Dismiss

143



22 User calibration

Factory calibration coefficients are calculated for each sensor, and the coefficients are stored on the instrument.

RBR calibration certificates contain calibration equations, coefficients, and residuals for each sensor. Hard copies are
provided with each shipment. RBR can replace lost or misplaced calibration certificates upon request.

RBR recommends calibrating your instrument before any critical deployment, periodically once a year, or if you suspect
the readings to be out of specifications.

Discuss your calibration requirements with RBR. In some cases, the instrument will need to be returned to RBR to have
it checked and re-calibrated.

Please contact RBR for our current calibration fees.
View current calibration coefficients for your sensors under the Calibration tab in the Properties window.
Sensors such as dissolved oxygen, turbidity, pH, and fluorescence can be field-calibrated. Update the calibration

coefficients for these channels periodically. On occasion, you may need to manually enter new coefficients, although
this is not recommended for factory-calibrated sensors (for example C, T, or D) unless instructed by RBR.

© Useonly datasets in the Desktop storage format to calibrate the sensors. The Calibration tab is not available
for RSK files in the Mobile storage format.

To calibrate a sensor, you need to let it sample in a known environment and then compare the result to the established
value. The difference will be used to generate calibration coefficients. With the N-point method, the known
environment is changed N times. The higher the N, the more accurate are calibration coefficients.

Use the Calibration button under the Analysis tab to calibrate turbidity, pH, fluorescence, and Oxyguard DO sensors.

Use the Plot window to calibrate the RBRcoda® T.0DO integrated sensors.

22.1 Dissolved oxygen sensor calibration

© Useonly datasets in Desktop storage format to calibrate the sensors. The Calibration tab is not available
in Mobile mode.

Dissolved oxygen sensors manufactured by RBR are available as the RBRcoda® T.ODO and can be integrated in any RBR
standard instrument. Additionally, RBR standard instruments support several third-party dissolved oxygen sensors
(OxyGuard, Rinko, and Aanderaa).

For dissolved oxygen sensors, RBR recommends user calibration using the N-point method, with N =2, which will

include a zero reference point and a non-zero reference point. It is, however, acceptable to perform a one-point
calibration.
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22.1.1 Dissolved oxygen data collection

Follow the steps below to obtain the calibration dataset for your dissolved oxygen sensor.

Equipment and materials

« Awide-mouth, black-walled container with a cover
« Asmall container or beaker

« Air pump (for example, an aquarium air pump with a stone bubbler)

« Magnetic stirrer
+ Sodium sulphite Na,SO;

« Distilled water

Ruskin configuration
1. Goto Configuration.

. Select UTC or Local, depending on your preferences, to synchronise the instrument clock with your computer.

2
3. Setthe sampling rate at 1s (1Hz).
4. Enable your schedule.

A Theinstrument must be logging throughout the calibration procedure.

Non-zero reference point

Dissolved
oxygen
sensor

Fill the black-walled container with distilled water.
Install the magnetic stirrer.
Install the air pump.

Ll N S
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Switch on both the air pump and the magnetic stirrer.
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Leave them on overnight, or for at least 3-4 hours, to achieve saturation.

Submerge the dissolved oxygen sensor in the solution, going in at an angle and stirring to avoid bubble buildup
on the sensor window.

Leave some space between the sensor and the beaker walls.

Position the sensor near the stirrer but not directly in the bubbles.

The bubbler should be shallower than the sensor.

Record the data for at least 30 minutes.

This is the 100% oxygen concentration calibration point.

Zero reference point

a

Omit this step when performing the one-point calibration.

If you calibrate your dissolved oxygen sensor using the one-point calibration method at 100% oxygen
concentration only, calibration should be performed at the expected temperature and salinity of the
deployment environment.

. Inasmall container or beaker, prepare a 0.1% solution of sodium sulphite (0.25g of Na,SO3 for 250mL tap
water).
Mix the solution thoroughly with a magnetic stirrer. The solution will be oxygen-free after 15 minutes.

Submerge the dissolved oxygen sensor in the solution, going in at an angle and stirring to avoid bubble buildup
on the sensor window.
Leave some space between the sensor and the beaker walls.

Dissolved Na,SO;
oxXygen > T >
sensor &

Magnetic
I < e

4, Record the data for at least 30 minutes.

This is the 0% oxygen concentration calibration point.

& This Na,S03 solution has a limited lifespan and should not be used for more than a day.
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22.1.2 DO calibration in Analysis tab

For DO sensors, RBR recommends a two-point user calibration, which includes a zero reference point and a non-zero
reference point. It is, however, acceptable to use a one-point calibration.

Two-point calibration steps on Ruskin
1. Stop the deployment.

2. Download the dataset.

3. Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab

displayed.

b4 ‘ Instruments

MM
£ Datasets
71 207701...-Cal

CRBRconeerto? 2098681

Analysis Overview | Channels | File info

Sample
Time

Display statistics

Number of samples

Channel

Temperature

Temperature

Dissolved O; concentration
OxidationfReduction Potential
pH

Transmittance

Turbidity

Cursor

1160
2021-08-27 16:25:00.000-04:00

Value Unit
24.7980633 *C
24.9370000 *C

200.7831154  pmolfl
0.4742427 v

10.0108701 pH_u...
0.5000222 trans..
978.7631864 NTU

Calibration

4. Click Calibration.

5. Select Dissolved O, saturation from the dropdown list.

By default, the Number of samples is set to 100, which means Ruskin will average the calibration coefficients
over a hundred sample points. Typically, this value should be in the range from 50 to 100 samples.

The Raw channel box is unchecked, and thus the true DO values will be displayed in the plot below. To see the

raw voltage values, check this box.

Current coefficients

564.0000000 E-3

Dissolved Q; saturation

Mumber of samples 100

Avg

Analysis _Overview Channels | File info

1.0721800

e
linear =
Std Real Avg

Cursor

Residual

Calibration
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A downsampled representation of the dataset will appear in the thumbnail view, with two distinct plateaus
corresponding to 100% and 0%. Irregular readings in-between mark the times when you changed from distilled

water to sodium sulphite solution and reassembled the setup.

nl\

6. Click on astable pointin the Plot view corresponding to 100% oxygen.

100.000

90,000

80,000

000

60,000

50,000

0,000

Dissolved 0, saturation (%)

10,000

0933 09735 09737 0939 0941 0945 0547

Time

09349

09’51 0953 0955

The interval of 100 samples will be highlighted. The average value (Avg) and standard error (Std) for this interval

will appear in the table above.

7. Under Real Avg in the first row, enter 100.

Analysis . Owverview | Channels | File info
Cursor  Calibration

Dissolved O; saturation &
Number of samples 100 o  linear

Current coefficients

-2.4827037 1.0752212
Mg Std Real Avg Residual

v 99.746015 0.0525042 100.000000

8. Repeat the same steps for the second plateau, entering 0 under Real Avg.

9. Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated coefficients.
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10.

11.

12.

13.

14.

15.

Analysis Overview | Channels | File info
Cursor  Calibration

Dissolved O; saturation &

Number of samples 100 o  linear &

Current coefficients

-2.4827037 1.0752212
Mg Std Real Avg Residual
99.746015 0.0525042 100.000000 -98.7840262
0.142015 0.0219689 0.000000 3.2184301

Mew calibration coefficients have been calculated

Calculated coefficients

-2.6351535 1.0794960 oy

Click Copy to save the new calibration coefficients to the clipboard, or write them down.
In the Navigator view, find your instrument.

Click Calibration and select Dissolved O, saturation from the dropdown list.

Click €O to select the entry field and type in the new value (in this example, -2.6351535 ).
Click C1 to select the entry field and type in the new value (in this example, 1.0794960 ).

Click Store calibration to save the new coefficients.

Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost
once your session is closed.
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One-point calibration steps on Ruskin

a

10.

11.

12.

13.

14.

If you calibrate your dissolved oxygen sensor using the single-point calibration method at 100% oxygen
concentration only, calibration should be performed at the expected temperature and salinity of the
deployment environment.

Stop the deployment.
Download the dataset.

Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab
displayed.

Click Calibration.

Select Dissolved O, saturation from the dropdown list.

Check the 1 point calibration box.

Click on a stable point in the Plot view corresponding to 100% oxygen.

The interval of 100 samples will be highlighted. The average value (Avg) and standard error (Std) for this interval
will appear in the table above.

Click the RealAvg column and select 100 from the dropdown.

Click Copy to save the new calibration coefficients to the clipboard, or write them down.
In the Navigator view, find your instrument.

Click Calibration and select Dissolved O, saturation from the dropdown list.

Click €O to select the entry field and type in the new value.

Click C1 to select the entry field and type in the new value.

Click Store calibration to save the new coefficients.

Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost
once your session is closed.
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22.1.3 ODO calibration in Plot window

& Optical dissolved oxygen sensors manufactured by RBR are calibrated using the Plot window. Clicking the

Calibration button under the Analysis tab will result in an error message.

Plot calibration steps on Ruskin

Use the Plot window on Ruskin to calibrate an integrated RBRcoda® T.0DO. You can choose a one-point (100% O,) ora
two-point (100% and 0% O,) method.

1. Create a new calibration region.

RBR#0006105revL

= Obtain the calibration dataset as described above and open it in Ruskin.

» Click Create annotation L~

Comment
Location

Profile

Calibr: :ﬂ”':ﬁ |

/\ Exclusion
M,

SN T

The cursor in the Plot window will become a two-way arrow

= Click and drag left or right to select the calibration region.
The interval will be highlighted and a tooltip will open.

= Enter the title for the region and select Dissolved 0, saturation from the dropdown menu.

and select Calibration from the dropdown menu.
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= Press Enter on your keyboard or click Save on the tooltip to save the calibration region.

A section for this calibration region will open under Cursor.

Cursor  Calibration

Calibration region 1

Channel  2: Dissolved O, concentration T samples

Reference

* Manual Automatic pmol/l <
Plateau Raw Rawg Calibrated (pmelfl) Reference [} Residual (pmoljl)

= To delete a calibration region, click Delete Ijon the tooltip.
A warning message will appear.

[ Ruskin

1 Are you sure you want to delete this annotation?

Cance

2. Create plateaus.

RBR#0006105revL

.

= Click Detect plateaus on the tooltip to launch the automatic selection process.

If there are existing plateaus, a warning message will appear.

® Ruskin

Y Are you sure you want to automatically detect plateaus?
Doing so will remove existing plateau annotations.

Cancel

* Click Proceed to continue.

All detected plateaus will be visible as grey markers under the calibration region marker.

Callbration (1) [ 1 4 1 RN A RO

[ T
[ 1
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= To create a plateau manually, click Create plateaus A on the tooltip.
A new plateau will appear as a grey marker at the start of the calibration region marker. Each new
click will add another plateau to the right of the existing one.

Calloratien (2) ¥ 12 p B F-RA @@ @0 e T E

L T i I ]

= Click a plateau to open its tooltip. You can now edit the title and add reference values.

Plateau (2) [v| = €@ 2z | 2 v e ap e &

N

PLATEAU 1:2 4 7 x
Title Plateau 2
Datails

Referenca 0.0

2021-07-15 15:12:44 2021-07-15 15:14:20
|

= To delete a plateau, click Delete |j on the tooltip.
A warning message will appear.

[ Ruskin

1 Are you sure you want to delete this annotation?

3. Enter reference data.
= By default, Reference is set to Manual entry mode, with in units of % or pm ol/L available in the
dropdown menu.

Reference
© Manual Automatic |
%
Plateau Raw Raw g Calibrated (pmelfl) Reference (WMol reamwar qpeclf1)
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Enter the reference value for each plateau manually in the Plateau table under Cursor:

Plateau Raw Raw o Calibrated (umolfl) Reference (umeclfl}] Residual (umolfl)
Plateau 1 0.287594 0.0005081 220.000000 X -0.0000000
Plateau 2 0.286890 0.0005006 0.000000

or in the Plateau tooltip:

PLATEAU 1:1 & T x
Title Filateau 1

Details
Reference X30.0

H21-07-15 15:06:08  2021-07-15 15:07:45

I 1 I A |

= Alternatively, enter reference values from the CSV file.

The CSV file for the automatic data entry must have two columns: time (in ISO 8601 format) and
data (in float/double format). For example:

2020-04-02T08:39:26.667-4:00, 220.0

2020-04-02T708:58:16.333-4:00, 0.0

Once the file has been selected, a dialogue box will appear asking for you to define which column
contains the time and which contains the reference values.

'8 ® Column selection

| Select the columns which contain the time and value data

| Time Value
| ©2020-04-02T08:39:26.667-4:00 1 2020-04-02T08:39:26.667-4:00
220.0 © 2200

i

& Thetimein the CSV file will need to be a value that falls within the region of the plateau.
However, the CSV file can hold additional rows with times that are outside of the plateau
region.
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4, Save the coefficients.

= Verify that the calibration was successful.

If the residuals are within an acceptable range, they will be highlighted in green, and the Save
button will appear in the Calculated coefficients section.

Plateau Raw Raw o Calibrated (umelfl] Reference (umelfl] Residual {pmolfl)
Plateau 1 0.287577 0.0004475 220.000000
Plateau 2 0.286890 0.0005006 -0.000000 0.000000 0.0000000

Calculated coefficients

C0: -91.8666377E3
C1: 320.215203E3
C2: 32E-6

Save

= Click Save to write the coefficients to the instrument. The instrument must be connected to
Ruskin.

If successful, a success message will appear.

Calculated coefficients

C0: -11.2267917E0 Save Writing to instrument...Complete
C1: 791.938838E0 Processing data...Complete
C2: 32E-6

If not, a warning message will appear instead.

Calculated coefficients

CO: -11.2604861E0 Save Writing to instrument...

C1: 792.457953E0 Warning: Unable to find instrument RBRconcerto 0656:
C2: 32E-6 Writing to database...Complete
Processing data...Complete

& Calibration coefficients are stored on the instrument and not the sensor. Recalibrate your sensor if you move
it to a different instrument.
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22.2 Turbidity sensor calibration

© Useonly datasets in Desktop storage format to calibrate the sensors. The Calibration tab is not available
in Mobile mode.

RBR standard instruments support turbidity sensors from third-party manufacturers. User calibration is available for
Seapoint® and Turner® sensors.

RBR factory-calibrates the turbidity sensors using the N-point method, with N = 7. For user calibration, we recommend
using the two-point method (N = 2) under fluorescent lighting, which will include a zero reference point and a non-
zero reference point.

Alternatively, you can perform a one-point calibration using a single zero reference point in distilled water. Calibration
will only correct the coefficients for an offset.

() When performing the one-point method, use only a zero reference point.
With a single non-zero reference point, calibration will recompute the slope coefficient. Go this route only if
you are confident in your non-zero standard.

22.2.1 Tudata collection

Follow the steps below to obtain the calibration dataset for your Tu sensor.

Equipment and materials

« Awide-mouth, black-walled container (large enough to hold the instrument)

+ Secure black lid for the container with an orifice for the instrument

« Small black lid or any light-blocking material to cover the orifice during calibration
+ 400FTU Formazin standard

« Distilled water

« Large magnetic stirrer

+ Rubbing alcohol

+ Soft cloth

Ruskin configuration

1. Go to Configuration.

Use Local on Ruskin to synchronise the instrument clock with your computer.
Set the sampling rate to 1s (1Hz).

Under Ranging sensors, set Range to Auto.

Enable your schedule.

ol wn

A Theinstrument must be logging throughout the calibration procedure.
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Sensor preparation

1. Wash the sensor and container with distilled water and dry them with a soft cloth.
2. Check the turbidity window for stains and scratches.

& Do not proceed with calibration if there are serious scratches.

3. Wipe the turbidity window with alcohol to remove all stains.

Zero reference point

Small
L 1 H
L black lid
Black
< lid
20cm

Tu

sensor

H,0
Magnetic
r/ \ € stirrer

Fill the black-walled container with distilled water.

Turn on the magnetic stirrer and adjust the RPM to ensure no vortex appears.

Place the black lid on the container and avoid direct light on the container.

Submerge the sensor though the orifice in the lid, vertically along the wall, with the turbidity window facing the
larger water volume.

el

& Thedistance from the turbidity window to the container wall must be at least 20cm.

5. Cover the orifice with the smaller black lid or light-blocking material, like a thick plastic bag.
6. Record the data in distilled water for at least 15min, up to an hour.
This is the zero-turbidity calibration point.

Non-zero reference point
Repeat the steps for the zero reference point, replacing distilled water with 400FTU Formazin standard.

This is the 400NTU calibration point.

As each reference point takes 15 minutes to an hour, the entire procedure may take up to two hours.

After completing the procedure for both reference points (or for a single reference point, if using the one-point method),
proceed to calibration on Ruskin.
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22.2.2 Tucalibration in Analysis tab

For turbidity calibration, we recommend using the two-point method, which includes a zero reference point and a

non-zero reference point.

Alternatively, you can perform a one-point calibration using a single zero reference point.

Two-point calibration steps on Ruskin
1. Stop the deployment.

2. Download the dataset.

3. Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab

displayed.

CRBRconeerto? 2098681
wia MLM
- & Datasets
7 207701...-Cal

~ ‘ Instruments Analysis

Sample
Time

Display statistics

Number of samples

Channel

Temperature

Temperature

Dissolved O; concentration
OxidationfReduction Potential
pH

Transmittance

Turbidity

Overview | Channels | File infa

Cursor

1160

2021-08-27 16:25:00.000-04:00

Value
24.7980633
24.9370000

200.7831154

0.4742427

10.0108701
0.5000222
978.7631864

Unit
°C

*C
pmolfl
v

pH_u...
trans...
NTU

Calibration

4. Click Calibration.

5. Select Turbidity from the dropdown list.

By default, the Number of samples is set to 100, which means Ruskin will average the calibration coefficients
over a hundred sample points. Typically, this value should be in the range from 50 to 100 samples.

The Raw channel box is unchecked, and thus the true turbidity values will be displayed in the plot below. To see

the raw voltage values, check this box.

-
e

Number of samples 100

Current coefficients

Byg

Turbidity & Raw channel

Analysis . Overview Channels File info

linear (2]

3.0639380 E3 -4.1818820 E3

Std Real Avg

1 point Calibration

Residual

Cursor

Calibration
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A downsampled representation of the dataset will appear in the thumbnail view, with two distinct plateaus

corresponding to zero NTU and 400NTU. Irregular readings in-between mark the times when you changed from
water to formazin and reassembled the setup.

6. Check the box next to the first row in the calibration table.

7. Click on astable point in the Plot view corresponding to zero NTU.

550.000

500.000

450.000

400.000

350.000

300.000

250.000

200.000

Turbidity (NTU)

150.000

100.000

50.000

)

-50.000

13:38 13:40 13:42 13:44 13:46

1348

13:50

13:52 13:54

The interval of 100 samples will be highlighted. The average value (Avg) and standard error (Std) for this interval
will appear in the table above.

8. Under Real Avg in the first row, enter 0 and press enter.

RBR#0006105revL

Anal\,rsis' Overview Channels | File info

Turbidity & Raw channel

Number of samples 100 o  linear
Current coefficients
3.0639380 E3 -4.1818820 E3

Avg Std
0.005194 0.0091773

1 point Calibration

Real Avg
0.000000

Residual

Cursor

Calibration
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9. Repeat the same steps for the second plateau, entering 400 under Real Avg.

10. Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated coefficients.

Analysis Overview | Channels | File info

Cursor  Calibration

Turbidity (5] Raw channel 1 point Calibration

Mumber of samples 100 o  linear @
Current coefficients

3.0639380E3  -4.1818820E3

Ayg Std Real Avg Residual
0.002736 0.0021226 0.000000 0.0000000
v 350.899191 1.1599181 400.000000 0.0000000

New calibration coefficients have been calculated

Calculated coefficients

3.4926945E3  -4.7670838 E3 Copy

& When atwo-point calibration is performed correctly, residuals will be 0.

11. Click Copy to save the new calibration coefficients to the clipboard, or write them down.
12. Inthe Navigator view, find your instrument.

13. Click Calibration and select Turbidity from the dropdown list.

14. Click €0 to select the entry field and type in the new value (in this example, 3492.6945 ).
15. Click €1 to select the entry field and type in the new value (in this example, -4767.0838).

16. Click Store calibration to save the new coefficients.

& Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will
be lost once your session is closed.
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One-point calibration steps on Ruskin

1. Stop the deployment.

2. Download the dataset.

3. Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab
displayed.

4. Click Calibration.

5. Select Turbidity from the dropdown list.

6. Check the 1 point calibration box.

7. Click on a stable pointin the Plot view corresponding to zero NSU.

The interval of 100 samples will be highlighted. The average value (Avg) and standard error (Std) for this interval

will appear in the table above.
8. Click the RealAvg column and select 0 from the dropdown.

Analysis Overview | Channels | File info

Cursor  Calibration

Turbidity & Raw channel + 1 point Calibration

Mumber of samples 100 o
Current coefficients
3.2494240 E3 -4,4350240 E3

Avg Std Real Avg Residual
v 1.148650 0.0147817 0 ¥ 0.0000000

100 l

New calibration coefficients have been calculated

Calculated coefficients

32860202 E3  -4.4865589 E3 tpy

9. Click Copy to save the new calibration coefficients to the clipboard, or write them down.
10. Inthe Navigator view, find your instrument.
11. Click Calibration and select Turbidity from the dropdown list.
12. Click €O to select the entry field and type in the new value.
13. Click C1 to select the entry field and type in the new value.
14. Click Store calibration to save the new coefficients.

& Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost
once your session is closed.
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22.3 pHsensor calibration

© Useonly datasets in Desktop storage format to calibrate the sensors. The Calibration tab is not available
in Mobile mode.

RBR standard instruments support the Idronaut® pH sensors.

For pH sensors, RBR recommends user calibration using the N-point method, with N = 3. Calibrate the pH sensors
before each deployment, using three buffer fluids for optimum accuracy. For best results, perform in a temperature-
controlled bath at 25°C, with a marine thermistor in the bath.

() Usethe three-point calibration method:
« To check the zero point, use a pH 7 buffer fluid.
« To set the slope, use an acidic and a basic buffer. RBR uses pH 4 and pH 10 buffer fluids to set the slope.

22.3.1 pH data collection

Follow the steps below to obtain the calibration dataset for your pH sensor.

Equipment and materials

» Wide-mouth beaker or any container (large enough to maintain adequate distance from the sensor face to the
wall)

« Narrow-mouth beaker which can fit both the pH and reference sensors

» Submersible magnetic stirrer (optional)

+ Submersible magnetic stirrer pad (optional)

+ Clean tap water

» pH4,pH7,and pH 10 buffer fluids

« Marine thermistor (on your instrument)

Ruskin configuration

1. Goto Configuration.

2. Use Local on Ruskin to synchronise the instrument clock with your computer.
3. Setthe sampling rate to the fastest rate possible for the instrument.

4. Enable your schedule.

& Theinstrument must be logging throughout the calibration procedure.
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Temperature bath preparation

1. Fill the larger beaker with warm tap water (at 25°C).

2. Submerge the marine thermistor in the bath.

3. Optionally, place the magnetic stirrer at the bottom. Use the submersible magnetic stirrer pad to adjust the
stirrer height.

Buffer bath procedure

& The buffer bath steps are repeated three times, each time with a new buffer fluid: pH 4, pH 7, and pH 10. Buffer
fluids are colour-coded, so it is easy to keep track of the steps.

Fill the smaller beaker with pH 4 buffer fluid.

Rinse both the pH sensor and reference sensors with clean water, then with pH 4.

Warm up the beaker in your hand or in warm water.

Submerge both the pH and reference sensors in the same pH 4 buffer solution.

If using the magnetic stirrer, position your sensors near it, as that is in the best-mixed area of the bath.
5. Stir for 30 minutes or until the pH and temperature signals have stabilised.

Call

Marine [
thermistor
(on logger)
25° H,0
pH sensor < Reference
sensor
Magnetic
<€ ?tirrgr )
Stirrer pad ’ optional
(optional) l / — | [T

Repeat with pH 7.

Repeat with pH 10.

As each buffer fluid procedure takes at least 30 minutes, the entire procedure takes about two hours.

After collecting the measurements for each buffer fluid, proceed to calibration on Ruskin.
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22.3.2 pH calibration in Analysis tab

For pH calibration, we recommend using the three-point method. The dataset will have three distinct plateaus.

Calibration steps on Ruskin
1. Stop the deployment.

2. Download the dataset.

3. Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab

Cursor  Calibration

1160

displayed.
@ Instruments Analysis “._ Owerview | Channels | File info
CRBRconeerto? 2098681
wia MLM
- & Datasets
aw 207701...-Cal Sample
Time

Display statistics

Number of samples

Channel

Temperature

Temperature

Dissolved O; concentration
OxidationfReduction Potential
pH

Transmittance

Turbidity

2021-08-27 16:25:00.000-04:00

Value Unit
24.7980633 *C
24.9370000 *C

200.7831154 pmolfl
0.4742427 v
10.0108701 pH_u...
0.5000222 trans...
979.7631864 NTU

4. Click Calibration.

5. Select pH from the dropdown list.

By default, the Number of samples is set to 100, which means Ruskin will average the data points for the

calibration over a hundred sample points.

Use the up and down arrows to adjust this value. Typically, it should be in the range from 20 to 100 samples,

depending on the sampling rate. For 16Hz, select 100. For 2Hz, select 20.
The Raw channel box is unchecked, and thus the true pH values will be displayed in the plot below. To see the

raw voltage values, check this box.

pH <

Mumber of samples 100
Current coefficients

-37.0898170

Avg

Analysis Overview | Channels | File info

Raw channel

~  linear
b

86.8785310

Std

Real Avg

Cursor  Calibration

<>

Residual

RBR#0006105revL

164



A downsampled representation of the dataset will appear in the thumbnail view, with three distinct plateaus
corresponding to pH 4, pH 7, and pH 10. Irregular readings in-between mark the times when you changed the
buffer fluid and reassembled the setup.

ol [0 m&

6. Check the box next to the first row in the calibration table.

7. Inspect the plateau for possible trends and irregularities.

8. Click on a stable pointin the Plot view corresponding to pH 4. Ensure the selected region is stable (within
0.005pH).

pH

vl

L
1447 14:52 1457
Time

The interval of samples will be highlighted. The average value (Avg) and standard error (Std) for this interval will
appear in the table above the plot.

9. Under Real Avg in the first row, enter 4 and press enter.

Analysis . Overview | Channels | File info |

Cursor  Calibration

pH * Raw channel

L]

Number of samples 100 o  linear
Current coefficients
-37.0898170 B86.8795310

Avg Std Real Avg Residual
v 4.002556 0.0006078 4.000000
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10. Repeat the same steps for the second plateau, entering 7 under Real Avg.

11. Repeat the same steps for the third plateau, entering 10 under Real Avg.

12. Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated coefficients.

Analysis Overview Channels | File info

Mew calibration coefficients have been calculated

Calculated coefficients

-37.0902940  B6.8804900 -0y

Cursor
pH (2] Raw channel
Number of samples 100 o  linear 8
Current coefficients
-37.0888170 86.8795310
Avg Std Real Avg Residual
4.002556 0.0006078 4.000000 0.0048407
6.990347 0.0015574 7.000000 -0.0096349
10.002163 0.0006908 10.000000 0.0047943

Calibration

13. Click Copy to save the new calibration coefficients to the clipboard, or write them down.

14. In the Navigator view, find your instrument.

15. Click Calibration and select pH from the dropdown list.

16. Click €O to select the entry field and type in the new value (in this example, -37.0902940).

17. Click C1 to select the entry field and type in the new value (in this example, 86.8804900).

18. Click Store calibration to save the new coefficients.

A Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost

once your session is closed.
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22.4 Fluorometer calibration

© Useonly datasets in Desktop storage format to calibrate the sensors. The Calibration tab is not available
in Mobile mode.

RBR standard instruments support third-party fluorescence sensors. Fluorometers are factory-calibrated using the
N-point calibration method; typically, with N = 3. User calibration is available only for fluorescence sensors
manufactured by Turner®,

You can perform a one-point calibration (N = 1) and establish a new zero reference point to account for drift or damage
to the face of the sensor (offset correction). If the readings are too far from the expected value, contact RBR for help.
You may have to return the instrument to RBR for a full calibration.

Alternatively, you can perform a two-point calibration (N =2) , which includes a zero reference point and a non-zero
reference point. This method can help you align a new fluorometer with your previous research standards.

22.4.1 Fluorescence data collection

Follow the steps below to obtain the calibration dataset for your fluorometer.

Equipment and materials

« Awide-mouth, black-walled container (large enough to maintain adequate distance from the sensor face to the
wall)

+ Black lid for the container

+ Distilled water

+ Rubbing alcohol

+ Soft cloth

Ruskin configuration

1. Go to Configuration.

Use Local on Ruskin to synchronise the instrument clock with your computer.
Set the sampling rate to the fastest rate possible for the instrument.

Under Ranging sensors, set Range to Auto.

Enable your schedule.

aorwDn

A Theinstrument must be logging throughout the calibration procedure.
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Sensor preparation
1. Wash the sensor and container with distilled water and dry them with a soft cloth.

2. Check the sensor window for discolouration and scratches.
& Do not proceed with calibration if there are serious scratches.

3. Wipe the sensor window with alcohol.

Zero reference point

1. Fill the black-walled container with distilled water.

2. Fully submerge the sensor.

& Thedistance from the sensor window to the container wall must be at least 20 cm.

Black
lid

H,0
Fluorescence

sensor

20cm

3. Record the data for five minutes.
This is the zero calibration point.

Non-zero reference point

To perform a two-point calibration, you will need your own standard non-zero point obtained using reference
fluorescence solutions such as rhodamine dye or fluorescein, or environmental samples with known chlorophyll
concentration.

Collect these data in a setting of your choosing.
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22.4.2 Chlorophyll a calibration in Analysis tab

Use a one-point method to calibrate your fluorometer for offset correction, establishing a new zero reference point.

Alternatively, you can perform a two-point calibration, which includes a zero reference point and a non-zero
reference point. This method can help you align a new fluorometer with your previous research standards.

One-point calibration steps on Ruskin

1. Stop the deployment.
2. Download the dataset.

3. Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab

displayed.

Analysis Overview | Channels | File info

Sample
Time

Display statistics

Mumber of samples

Channel
Conductivity
Temperature

Pressure
Chlorophyll a

PAR
Sea pressure
Depth

1

2021-06-22 11:44:33.000-04:00

Value
-0.0042477
21.6679790
10.0132230
0.0602301

2.68196365
-0.1192780
-0.1185451

Unit
mSfecm
i
dbar
o/l

HMol/...
dbar
m

Cursor

Calibration

4. Click calibration.
5. Select Chlorophyll a from the dropdown list.

By default, the Number of samples is set to 100, which means Ruskin will average the calibration coefficients

over a hundred sample points.

Use the up and down arrows to adjust this value. Typically, it should be in the range from 20 to 100 samples,
depending on the sampling rate. For 16Hz, select 100. For 2Hz, select 20.
The Raw channel box is unchecked, and thus the true chlorophyll a values will be displayed in the plot below.

To see the raw voltage values, check this box.
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Analysis Overview | Channels | File info |
Cursor  Calibration

Chlorophyll a s Raw channel 1 point Calibration

-

Number of samples 100 p linear -
Current coefficients

879.8011000 -1.2009254 E3

Avg Std Real Avg Residual

A downsampled representation of the dataset will appear in the thumbnail view, with a plateau at Oug/L.

L

6. Check the 1 point calibration box.
7. Click on astable point in the Plot view corresponding to Opg/L.

The interval of 100 samples will be highlighted. The average value (Avg) and standard error (Std) for this interval
will appear in the table above.

8. Click the RealAvg column and select 0 from the dropdown.

Analysis Overview | Channels | File info

Chlorophyll a s Raw channel 1 point Calibration

Number of samples 100 e

Current coefficients

B79.8011000 -1.2009254 E3
Avg Std Real Avg Residual
v 0.000817 0.0089728 [y M 0.0000000

Mew calibration coefficients have been calculated

Calculated coefficients

879.8074700 | -1.2009352 E3 Copy

The new calibration coefficients will be displayed under the table.
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10.
11.
12.
13.
14.
15.

Click Copy to save the new calibration coefficients to the clipboard, or write them down.
In the Navigator view, find your instrument.

Click Calibration and select Chlorophyll a from the dropdown list.

Click €O to select the entry field and type in the new value.

Click C1 to select the entry field and type in the new value.

Click Store calibration to save the new coefficients.

Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost
once your session is closed.

Two-point calibration steps on Ruskin

1.
2.
3.

Stop the deployment.

Download the dataset.

Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab
displayed.

Click Calibration.

Select Chlorophyll a from the dropdown list.

By default, the Number of samples is set to 100, which means Ruskin will average the calibration coefficients
over a hundred sample points.

Use the up and down arrows to adjust this value. Typically, it should be in the range from 20 to 100 samples,
depending on the sampling rate. For 16Hz, select 100. For 2Hz, select 20.

The Raw channel box is unchecked, and thus the true chlorophyll a values will be displayed in the plot below.

To see the raw voltage values, check this box.
A downsampled representation of the dataset will appear in the thumbnail view, with two distinct plateaus
corresponding to 0 and 100pug/L.

Check the box next to the first row in the calibration table.
Click on a stable point in the Plot view corresponding to Opg/L.

120.000

110.000

100.000

90.000

B0.000

70.000

£0.000

50.000

Chlorophyll a (ug/1)

40.000

30.000

20.000

10.000

o

11:30 11:35 11:40 35:45 11:50 11:55 12:00 12:05 12:10 12:15
Time

The interval of samples will be highlighted. The average value (Avg) and standard error (Std) for this interval will

appear in the table above.
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9. Under Real Avg in the first row, enter 0 and press enter.

10. Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated coefficients.

11.
12.
13.
14.
15.
16.

Analysis . Overview Channels | File info |

Cursor  Calibration

Chlorophyll a 8 Raw channel 1 point Calibration

i A
Number of samples 20 s linear
Current coefficients

586.6349000 -800.7088000

Ayg Std Real Avg Residual
v 0.000271 0.0045773 0.000000

Repeat the same steps for the second plateau, entering 100 under Real Avg.

Analysis . Overview | Channels | File info |

Cursor  Calibration

Chlorophylla [ Raw channel 1 point Calibration

Number of samples 20 2 linear &
Current coefficients

586.6349000 -800.7088000

Avg Std Real Avg Residual
0.000020 0.0056108 0.000000 0.0000000
v 105.252983 0.065624749 100.000000 0.0000000

New calibration coefficients have been calculated

Calculated coefficients

557.3571200  -760.7471400 Copy

& When atwo-point calibration is performed correctly, residuals will be 0.

Click Copy to save the new calibration coefficients to the clipboard, or write them down.
In the Navigator view, find your instrument.

Click Calibration and select Chlorophyll a from the dropdown list.

Click €O to select the entry field and type in the new value (in this example, 557.35712).
Click C1 to select the entry field and type in the new value (in this example, -760.74714).
Click Store calibration to save the new coefficients.

A Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will
be lost once your session is closed.
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23 Revision history

Revision No.

1.0-H
J

RBR#0006105revL

Release Date
2011-2020

31-August-2022

31-December-2022

31-March-2023

Notes

Various

Restructured the user guide to reflect Ruskin interface, added a
dedicated page for RSK files, edited existing instructions for
clarity, removed outdated sections and screenshots.

Added a section on the Search option under Support (for Mac
users). Updated the RSK files and File info sections to reflect
new file structure labels. Added a note in the Gating section.
Enhanced Plot window instructions. Updated the Power
section. Corrected typos in the User calibration section.

Added/updated screenshots in several sections (Ruskin interface,
Simulate an instrument, Configuration, and Appearance controls)
for clarity. Added information on synchonising the instrument
clock in the Schedule section. Added the Connections page.
Corrected a typo in the Tide section. Updated the Analysis,
Annotation controls, Zoom controls, and Automated tasks
sections. Added the Utilities page.
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